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Preface 

The curriculum and curricular materials have been developed and revised on a regular 
basis with the aim of making education objective-oriented, practical, relevant and job 
oriented. It is necessary to instill the feelings of nationalism, national integrity and 
democratic spirit in students and equip them with morality, discipline and self-reliance, 
creativity and thoughtfulness. It is essential to develop in them the linguistic and 
mathematical skills, knowledge of science, information and communication 
technology, environment, health and population and life skills. it is also necessary to 
bring in them the feeling of preserving and promoting arts and aesthetics, humanistic 
norms, values and ideals. It has become the need of the present time to make them 
aware of respect for ethnicity, gender, disabilities, languages, religions, cultures, 
regional diversity, human rights and social values so as to make them capable of 
playing the role of responsible citizens with applied technical and vocational 
knowledge and skills. This Learning Resource Material for Plant/Animal Science, 
Electrical/Civil Engineering has been developed in line with the Secondary Level 
Plant/Animal Science, Electrical/Civil Engineering Curriculum with an aim to facilitate 
the students in their study and learning on the subject by incorporating the 
recommendations and feedback obtained from various schools, workshops and 
seminars, interaction programs attended by teachers, students and parents. 

In bringing out the learning resource material in this form, the contribution of the 
Director General of CDC Dr. Lekhnath Poudel, Dr. Jagatkumar Shrestha, Dr. Kamal 
Thapa, Dr. Bharat Mandal, Purushotam Chapagai, Jagadishchandra Karki, Bimal 
Thapa, Shankar Kumar yadav, Nabin Maskey is highly acknowledged. The book is 
written by Bimal Thapa and the subject matter of the book was edited by Badrinath 
Timalsina and Khilanath Dhamala. CDC extends sincere thanks to all those who have 
contributed in developing this book in this form. 

This book is a supplimentary learning resource material for students and teachrs. In 
addition they have to make use of other relevnt materials to ensure all the learning 
outcomes set in the curriculum. The teachers, students and all other stakeholders 
are expected to make constructive comments and suggestions to make it a more 
useful learning resource material. 
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Unit: 1 
Introduction to Computer 

 
Learning Outcomes: 

After completion of this unit you will be able to  

 To explain/describe the concepts of computer. 

 To explain/describe history of computer. 

 To explain/describe computer system characteristics. 

 To explain/describe the types of computer. 

1.1. The Concept of Computer 

Today’s world is an information-rich world and it has become a necessity for 

everyone to know about computers. Computer is an advanced electronic device that 

takes raw data as an input from the user and processes it under the control of a set 

of instructions (called program), produces a result (output), and saves it for future 

use. This unit explains the foundational concepts of computer hardware, software, 

operating systems, peripherals, etc. along with how to get the most value and impact 

from computer technology. 

A computer is an electronic data processing device, which accepts and stores data 

input, processes the data input, and generates the output in a required format. 

Or 

A computer is an electronic machine that accepts the data and instructions from 

the user, processes the data according to the given set of instructions, stores and 

gives the information (result). 
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Functionalities of a Computer 

If we look at it in a very broad sense, any digital computer carries out the following 

five functions − 

Step 1 − Takes data as input. 

Step 2 − Stores the data/instructions in its memory and uses them as required. 

Step 3 − Processes the data and converts it into useful information. 

Step 4 − Generates the output. 

Step 5 − Controls all the above four steps. 
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1.2. History of Computers 

If we see the computer from the past to present, we can see that they don’t have 

similar technology, shape, size, functionality etc. So, the present computer that we 

use differs from the past computer. The origin of computer starts from counting. A 

short description about the development process of computer is described below: 

Mechanical Devices 

Abacus 

Many centuries ago when men started to count the numbers, they thought of a 

device which can trace the numbers and thus came the existence of ABACUS. It 

was the first counting device which was developed in China more than 3000 years 

ago. The name Abacus was obtained from Greek word Abax which means slab. 

This device basically consists of a rectangular wooden frame and beads. The frame 

is divided into two parts and beam separates these parts. The upper part is called 

heaven and the lower part is called earth. 

The frame contains horizontal rods and the beads which have holes are passed 

through the rods. Counting was done by moving the beads from one end of the 

frame to the other. 

 
Napier ’s bones 

It is a device which contains a set of rods made of bones. It was developed by John 

Napier in 1617, a Scottish Mathematician and hence the device was named as 

Napier’s bones. The device was mainly developed for performing multiplication 



4 Computer Application : Grade 9 

and division. In 1614, he also introduced logarithms. 

 
Slide Rule 

Slide Rule was an analog device invented by William Oughtred in 1620. The slide 

rule is used mainly for multiplication and division, and also for "scientific" 

functions such as roots, logarithms and trigonometry, but usually not for addition 

or subtraction. The slide rule is based on the work on logarithm. A simple slide rule 

consists of two movable marked scales in which one scale slips upon the other.  

 

Pascaline 

Pascaline is a calculating machine developed by Blaise Pascal in 1642, a French 

Mathematician. It was the first device with an ability to perform additions and 

subtractions on whole numbers. The device is made up of interlocked cog wheels 

which contains numbers 0 to 9 on its circumference. When one wheel completes its 

rotation the other wheel moves by one segment. Pascal patented this device in 1647 

and produced it on mass scale and earned a handful of money. 
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Stepped Reckoner: 

Stepped Reckoner  a calculating machine designed (1671) and built (1673) by the 

German mathematician-philosopher Gottfried Wilhelm von Leibniz. The Stepped 

Reckoner expanded on the French mathematician-philosopher Blaise Pascal’s ideas 

and did multiplication by repeated addition and shifting. It was the first calculator 

that could perform- addition, subtraction, multiplication and division. Even square 

roots could be calculated by series of stepped additions. 

  

Jacquard's Loom 

Jacquard's Loom was invented by Joseph Jacquard and first demonstrated in 1801. 

This device is an attachment for powered looms that uses a chain of punch cards to 

instruct the loom on how to make intricate textiles. For example, a loom could have 

hundreds of cards with holes in each of them that correspond to hooks that can be 

raised or lowered to make a textile brocade. Below is an illustration of the Jacquard 

Loom attachment on top of a textile loom. 
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Charles Babbage and his Engines 

Charles Babbage was born on December 26, 1791 in London, England. He 

designed the first mechanical computer, which he called the "Difference Engine" 

— a machine that could solve polynomial equations without using multiplication 

or division. He began developing the machine in 1822, and worked on it for over 

ten years, but its construction was never completed. 

 He also invented and developed his Analytical Engine in the late 1833. This 

was the first general purpose fully programmable mechanical machine. This 

device could perform complex calculations and store the result.  

 This analytical engine was based on input, process and output principle since 

the modern computers are based on Babbage's idea and principle. Therefore, 

Charles Babbage is also known as the father of modern computer science. 
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Lady Augusta Ada Lovelace 

Lady Augusta Ada Lovelace was an English writer as well daughter of famous 

English poet Lord Byron. She suggested Charsles Babbage to use binary number 

system for programs and data to be fed into the Analytical Engine. That was the 

first programming concept. So, she is regarded as the world's first computer 

programmer. In 1979, the US Department of Defense developed a programming 

language and named 'ADA' in her honor.  
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Tabulating Machine 

The Hollerith tabulating machine, also known as the tabulating machine, was an 

electrical counting machine invented by Herman Hollerith. It was first described in 

his doctoral thesis, which he presented at Columbia University in 1889. 

The machine was proof of his concept that data could be encoded by holes punched 

in a card and thereby counted and sorted electronically. It was successful, and 

Hollerith went on to found the Tabulating Machine Company, which later merged 

to become a company called IBM. 

 

Electromechanical Computer (Devices) 

Mark I 

Mark I was designed 

by a Harvard graduate 

student, Howard H. 

Aiken in 1937 to solve 

advanced 

mathematical physics 

problems encountered 

in his research.  

The IBM Automatic 

Sequence Controlled 

Calculator (ASCC), 
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called Mark I, uses 18000 vacuum tubes to store data in the memory. The machine 

weighed 35 tones, 500 miles of wire, 8 feet tall and 51 feet long etc. 

Atanasoff-Berry Computer 

Atanasoff-Berry Computer (the ABC) is considered as the first electronic digital 

computer and was the first machine to use vacuum tubes (over 300 vacuum tubes). 

Professor John Vincent Atanasoff and graduate student Cliff Berry developed the 

ABC in 1937 and continued development until 1942 at the Iowa State College (now 

Iowa State University). On October 19, 1973, Judge Earl R. Larson signed his 

conclusion that the ENIAC, patent by Eckert and Mauchly was invalid and named 

Atanasoff the inventor of the first electronic digital computer. 

 

Electronic Computers (Devices) 

ENIAC 

Electronic Numerical Integrator and Calculator, (the ENIAC) was the first 

electronic computer used for general purposes, such as solving numerical problems. 

It was invented by J. Presper Eckert and John Mauchly at the University of 

Pennsylvania to calculate artillery firing tables for the United States Army's 

Ballistic Research Laboratory. 

Its construction began in 1943 and was not completed until 1946. Although it was 
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not completed until the end of World War II, the ENIAC was created to help with 

the war effort against German forces. 

In 1956, the end of its operation, the (ENIAC) occupied about 1,800 square feet and 

consisted of almost 20,000 vacuum tubes, 1,500 relays, 10,000 capacitors, and 

70,000 resistors. It also used 200 kilowatts of electricity, weighed over 30 tons, and 

cost about $487,000. 

 

EDSAC 

Electronic Delay Storage Automatic Calculator (EDSAC) is an early British 

computer considered to be the first stored program electronic computer. It was 

created at the University of Cambridge in England, performed its first calculation 

on May 6, 1949, and was the computer that ran the first graphical computer game, 

nicknamed "Baby." In the picture to the right, is an example of the EDSAC 

computer. 

In the picture below, is an 

example of the EDSAC simulator 

that can be run on today's 

computers. The simulator 

simulates the EDSAC computer 

as it existed between 1949-1951. 
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UNIVAC I 

Universal Automatic Computer, the UNIVAC I was released in 1951 and 1952 

when first developed by J. Presper Eckert and John Mauchly. The UNIVAC is an 

electrical computer containing thousands of vacuum tubes that utilizes punch cards 

and switches for inputting data and punch cards for outputting and storing data. The 

UNIVAC was later released the UNIVAC II, and III with various models, such as 

the 418, 490, 491, 1100, 1101, 1102, 1103, 1104, 1105, 1106, 1107, and 1108. 

Many of these models were only owned by a few companies or government 

agencies. 

In the below picture is an example of the UNIVAC computer. As can be seen in the 

picture, this is a room-sized computer and often required multiple people to operate. 

 
History of computer in Nepal 
There is not a long history of computers in Nepal.Nepal hired some types of 

calculators and computers for it's census calculation.Following list shows it's 

history in Nepal.ꞏ In 2018 BS an electronic calculator called "Facit" was used for 

census.ꞏ In 2028 BS census IBM 1401 a second generation mainframe computer 

was used.ꞏ In 2031 BS a center for Electronic Data Processing, Later renamed to 

National Computer Center (NCC), was established for national data processing and 

computer training. In 2038 BS ICL 2950/10 a second generation mainframe 

computer was used for census. Now-a-days probably each and every institutions, 

business organizations, communication centers, ticket counters etc. are using 

computers. 
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After 2039 B.S., microcomputer s such as Sirus, Vector, IBM, Apple etc were 

imported by private companies and individuals in Nepal. Today there are thousands 

of computer training institutes, computer sales and repair centers in Nepal. Different 

universities are opening IT colleges in Nepal. Computer subject has been included 

in the curriculum of school education and universities. 

1.3. The Computer system characteristics 

High Speed 

 Computer is a very fast device. 

 It is capable of performing calculation of very large amount of data in a short 

time. 

 The computer has units of speed in microsecond, nanosecond, and even the 

picosecond. 

 It can perform millions of calculations in a few seconds as compared to man 

who will spend many months to perform the same task. 

Accuracy 

 In addition to being very fast, computers are very accurate. 

 The calculations are 100% error free. 

 Computers perform all jobs with 100% accuracy if the input is correct. 

Storage Capability 

 Memory is a very important characteristic of computers. 

 A computer has much more storage capacity than human beings. 

 It can store large amount of data. 

 It can store any type of data such as images, videos, text, audio, etc. 

Diligence 

 Unlike human beings, a computer is free from monotony, tiredness, and lack 

of concentration. 

 It can work continuously without any error and boredom. 

 It can perform repeated tasks with the same speed and accuracy. 

Versatility 
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 A computer is a very versatile machine. 

 It is very flexible in performing the jobs to be done. 

 This machine can be used to solve the problems related to various fields. 

 At one instance, it may be solving a complex scientific problem and the very 

next moment it may be playing a card game. 

Reliability 

 A computer is a reliable machine. 

 Modern electronic components have long lives. 

 Computers are designed to make maintenance easy. 

Automation 

 Computer is an automatic machine. 

 Automation is the ability to perform a given task automatically. Once the 

computer receives a program i.e., the program is stored in the computer 

memory, then the program and instruction can control the program execution 

without human interaction. 

Reduction in Paper Work and Cost 

 The use of computers for data processing in an organization leads to reduction 

in paper work and results in speeding up the process. 

 As data in electronic files can be retrieved as and when required, the problem 

of maintenance of large number of paper files gets reduced. 

 Though the initial investment for installing a computer is high, it substantially 

reduces the cost of each of its transaction. 

4. The Capabilities and limitation of computer: 

Computer - Applications 

The application of computers in various fields are given as below : 

Business 

A computer has high speed of calculation, diligence, accuracy, reliability, or 

versatility. It is an integrated part in all business organizations. It is used in business 

organizations for Payroll calculations, Budgeting, Sales analysis, Financial 
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forecasting, Managing employee database, Maintenance of stocks, etc. 

Banking 

Today, banking is almost totally dependent on computers. 

Banks provide the following facilities with the help of computers. 

 Online accounting facility, which includes checking current balance, making 

deposits and overdrafts, checking interest charges, shares, and trustee records. 

 ATM machines which are completely automated are making it even easier for 

customers to deal with banks. 

Insurance 

Insurance companies are keeping all records up-to-date with the help of computers. 

Insurance companies, finance houses, and stock broking firms are widely using 

computers for their concerns.Insurance companies are maintaining a database of all 

clients with information showing Procedure to continue with policies, Starting date 

of the policies, Next due installment of a policy, Maturity date, Interests due, 

Survival benefits, Bonus etc. 

Education 

The computer helps in providing a lot of facilities in the education system. 

 The computer provides a tool in the education system known as CBE 

(Computer Based Education). 

 CBE involves control, delivery, and evaluation of learning. 

 Computer education is rapidly increasing the graph of number of computer 

students. 

 There are a number of methods in which educational institutions can use a 

computer to educate the students. 

 It is used to prepare a database about the performance of a student and 

analysis is carried out on this basis. 

Marketing 

In marketing, uses of the computer are following – 
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 Advertising − With computers, advertising professionals create art and 

graphics, write and revise copy, and print and disseminate ads with the goal 

of selling more products. 

 Home Shopping − Home shopping has been made possible through the use 

of computerized catalogues that provide access to product information and 

permit direct entry of orders to be filled by the customers. 

Healthcare 

Computers have become an important part in hospitals, labs, and dispensaries. They 

are being used in hospitals to keep the record of patients and medicines. It is also 

used in scanning and diagnosing different diseases. ECG, EEG, ultrasounds and CT 

scans, etc. are also done by computerized machines. 

Following are some major fields of health care in which computers are used. 

(i) Diagnostic System, (ii) Lab-diagnostic System, (iii) Patient Monitoring System, 

and (iv) Pharma Information System, Surgery etc. 

Engineering Design 

Computers are widely used for Engineering purpose. One of the major areas is CAD 

(Computer Aided Design) that provides creation and modification of images. Some 

of the fields are Structural Engineering, Industrial Engineering, Architectural 

Engineering, etc. 

Military 

Computers are largely used in defense. Military also employs computerized control 

systems. Some military areas where a computer has been used are Missile Control, 

Military Communication, Military Operation and Planning, Smart Weapons etc. 

Communication 

Communication is to convey a message, an idea, a picture, or speech that is received 

and understood clearly and correctly by the person for whom it is meant. Some main 

areas in this category are E-mail, Chatting, Usenet, FTP, Telnet, Video-

conferencing, etc. 
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Government 

Computers play an important role in government services. Some major fields in this 

category are budgets, Sales tax department, Income tax department, Computation 

of male/female ratio, Computerization of voters lists, Computerization of PAN 

card, Weather forecasting etc. 

Disadvantages of Computers 

Following are certain disadvantages of computers. 

 A computer is a machine that has no intelligence to perform any task. 

 Each instruction has to be given to the computer. 

 A computer cannot take any decision on its own. 

 Computers have no feelings or emotions. 

4. The Types of Computer 

There are different types of computer having different features. Computers differ 

based on their data processing abilities. They are classified according to purpose, 

data handling and functionality. 

According to purpose, computers are either general purpose or specific purpose.  

a. Special Purpose Computers 

b. General Purpose Computers 

a. Special Purpose Computers 

A special purpose computer is designed only to meet the requirements of a 

particular task or application. The instructions needed to perform a particular task 

are permanently stored into the internal memory, so that it can perform the given 

task on a single command. It therefore doesn’t posses unnecessary options and is 

less expensive. 

b. General Purpose Computers 

A General Purpose computers are designed to meet the needs of many different 

applications. In these computers, the instructions needed to perform a particular 

task are wired permanently into the internal memory. When one job is over, 

instructions for another job can be loaded into the internal memory for processing. 
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This, a general purpose machine can be used to prepare pay-bills, manage 

inventories, print sales report and so on. 

Based on the operating principles, computers can be classified into the following 

types : 

a. Analog Computers 

b. Digital Computers 

c. Hybrid Computers 

a. Analog Computers 

An analog computer is a form of computer that uses the continuously changeable 

aspects of physical phenomena such as electrical, mechanical, or hydraulic 

quantities to model  problem being solved. In contrast, digital computers represent 

varying quantities symbolically, as their numerical values change. 

b. Digital Computers  

Operate essentially by counting. All quantities are expressed as discrete or numbers. 

Digital computers are useful for evaluating arithmetic expressions and 

manipulations of data (such as preparation of bills, ledgers, solution of simultaneous 

equations etc) 

C. Hybrid Computers 

Hybrid Computers are computers that exhibit features of analog 

computers and digital computers. The digital component normally serves as the 

controller and provides logical operations, while the analog component normally 

serves as a solver of differential equations. 

Classification of digital Computer based on size and Capability 

Based on size and capability, computers are broadly classified into 

a. Microcomputers (Personal Computer) 

A microcomputer is the smallest general purpose processing system. 

Microcomputer can be classified into 2 types: 
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1. Desktops 

2. Portables 

The difference is portables can be used while travelling whereas desktops 

computers cannot be carried around. 

The different portable computers are: - 

1) Laptop 

2) Notebooks 

3) Palmtop (hand held) 

4) Wearable computers 

b. Minicomputer 

A minicomputer is a medium-sized computer. That is more powerful than a 

microcomputer. These computers are usually designed to serve multiple users 

simultaneously (Parallel Processing). They are more expensive than 

microcomputers. 

Examples : Digital Alpha, Sun Ultra. 

c. Mainframe computers 

Computers with large storage capacities and very high speed of processing 

(compared to mini- or microcomputers) are known as mainframe computers. They 

support a large number of terminals for simultaneous use by a number of users like 

ATM transactions. They are also used as central host computers in distributed data 

processing system.   Examples: -     IBM 370, S/390. 

d. Supercomputer 

Supercomputers which have extremely large storage capacity and computing 

speeds are many times faster than other computers. A supercomputer is measured 

in terms of tens of millions instructions per second (mips), an operation is made up 

of numerous instructions. The supercomputer is mainly used for large scale 

numerical problems in scientific and engineering disciplines such as weather 

analysis. Examples: -  IBM Deep Blue 
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1.6. The Generations of computers and their features 

Computer generation is the classification of computers into different groups 

according to their manufacturing date, other hardware and software technology 

used inside those computers. 

There are five computer generations known till date. Each generation has been 

discussed in detail along with their time period and characteristics. In the following 

table, an approximate date against each generation has been mentioned, which are 

normally accepted. 

Following are the main five generations of computers. 

Computer - First Generation: 

The period of first generation was from 1945 to 1955. The computers of first 

generation used vacuum tubes as the basic components for memory and circuitry 

for CPU (Central Processing Unit). These tubes, like electric bulbs, produced a lot 

of heat and the installations used to fuse frequently. Therefore, they were very 

expensive and only large organizations were able to afford it.The computers in this 

generation used machine code as the programming language. 

The main features of the first generation are Vacuum tube technology, Unreliable, 

Supported machine language only, Very costly, Generated a lot of heat, Slow input 

and output devices, Huge size, Need of AC, Non-portable, Consumed a lot of 

electricity, etc. 

Some computers of this generation were ENIAC, EDVAC, UNIVAC, IBM-701, 

IBM-650, etc. 

Computer - Second Generation 

The period of second generation was from 1956 to 1964. In this generation, 

transistors were used that were cheaper, consumed less power, more compact in 

size, more reliable and faster than the first generation machines made of vacuum 

tubes. In this generation, magnetic cores were used as the primary memory and 

magnetic tape and magnetic disks as secondary storage devices.In this generation, 

assembly language and high-level programming languages like FORTRAN, 
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COBOL were used. The computers used batch processing and multiprogramming 

operating system. The main features of second generation are; use of transistors, 

reliable in comparison to first generation computers, smaller size as compared to 

first generation computers, generated less heat as compared to first generation 

computers, Consumed less electricity as compared to first generation computers, 

faster than first generation computers, still very costly, AC required, supported 

machine and assembly languages, etc. 

Some computers of this generation were IBM 1620, IBM 7094, CDC 1604, CDC 

3600, UNIVAC 1108 etc. 

Computer- Third Generation 

The period of third generation was from 1965 to 1971. The computers of third 

generation used Integrated Circuits (ICs) in place of transistors. A single IC has 

many transistors, resistors, and capacitors along with the associated circuitry. 

The IC was invented by Jack Kilby. This development made computers smaller in 

size, reliable, and efficient. In this generation remote processing, time-sharing, 

multiprogramming operating system were used. High-level languages (FORTRAN, 

COBOL, PASCAL, BASIC, etc.) were used during this generation. The main 

features of third generation are IC used, More reliable in comparison to previous 

two generations, smaller size, generated less heat, faster, lesser maintenance, 

supported high-level language etc. 

Some computers of this generation were IBM-360 series, Honeywell-6000 series, 

PDP (Personal Data Processor), IBM-370/168, TDC-316 etc. 

Computer - Fourth Generation 

The period of fourth generation was from 1972 to 1980. Computers of fourth 

generation used Very Large Scale Integrated (VLSI) circuits. VLSI circuits on a 

single chip made it possible to have microcomputers of fourth generation. 

Fourth generation computers became more powerful, compact, reliable, and 

affordable. As a result, it gave rise to Personal Computer (PC) revolution. In this 

generation, time sharing, real time networks, distributed operating system were 
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used. All the high-level languages like C, C++, DBASE etc., were used in this 

generation. The main features of fourth generation are VLSI technology used, very 

cheap, portable and reliable, use of PCs, very small size, pipeline processing, no 

AC required, concept of internet was introduced, great developments in the fields 

of networks, computers became easily available, etc. 

Some computers of this generation were DEC 10, STAR 1000, PDP 11, CRAY-1 

(Super Computer), CRAY-X-MP (Super Computer) etc. 

Computer - Fifth Generation 

The period of fifth generation is from 1980 onwards. In the fifth generation, VLSI 

technology became ULSI (Ultra Large Scale Integration) resulting in the production 

of microprocessor chips having ten million electronic components. 

This generation computer is based on parallel processing hardware and AI 

(Artificial Intelligence) software. AI is an emerging branch in computer science, 

which interprets the means and method of making computers think like human 

beings. All the high-level languages like C and C++, Java, .Net etc., are used in this 

generation. 

 

AI includes Robotics, neural networks, game playing, development of expert 

systems to make decisions in real-life situations, natural language understanding 

and generation etc. 
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The main features of fifth generation are ULSI technology, development of true 

artificial intelligence, development of natural language processing, advancement in 

parallel processing, advancement in superconductor technology, more user-friendly 

interfaces with multimedia features, availability of very powerful and compact 

computers at cheaper rates etc. 

Some computer types of this generation are Desktop, Laptop, NoteBook, 

UltraBook, Chrome Book etc 

1.7. The Types of PC/Es and their characteristics 

Computers can be broadly classified by their speed and computing power. 

Desktop Computer (Personal Computer) 

A PC (Personal Computer) can be defined as a small, relatively inexpensive 

computer designed for an individual user. PCs are based on the microprocessor 

technology that enables manufacturers to put an entire CPU on one chip. Personal 

computers are used in business sectors for word processing, accounting, desktop 

publishing, and for running spreadsheet and database management applications. At 

home, the most popular use for personal computers is playing games and surfing 

the Internet.The characteristics of desktop computer are 

 Computers used to be huge and would sometime take up the whole space of 

a room. 

 These computers were cheap and affordable for the public. 

 Desktop Computer normally have a separate monitor, keyboard, mouse, 

speakers etc. 

 Can be used as a standalone computer in your home for personal or work use. 

 Tends to be connected to own printer and internet connection. 

Laptop: 

Laptop computers, also known as notebooks, are portable computers that you can 

take with you where as you like and use in different environments. They include a 

screen, keyboard, and a trackpad or trackball, which serves as the mouse. Because 

laptops are meant to be used on the go, they have a battery which allows them to 
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operate without being plugged into a power outlet.  

Laptop computer consists of all the components (monitor, keyboard etc.) are 

together on a single device. The main advantages of a laptop computers area they 

are portable and they can connect wirelessly to network connections. 

 

Notebook: 

A notebook computer is a battery - or AC-powered personal computer generally 

smaller than a briefcase that can easily be transported and conveniently used in 

temporary spaces such as on airplanes, in libraries, temporary offices, and at 

meetings. A notebook computer, sometimes called a laptop computer, typically 

weighs less than 5 pounds and is 3 inches or less in thickness. Among the best-

known makers of notebook and laptop computers are IBM, Apple, Compaq, Dell, 

Toshiba, and Hewlett-Packard. 

A serial port also allows a regular mouse to be attached. The PC Card is insert able 

hardware for adding a modem or network interface card to a notebook. CD-

ROM and digital versatile disc drives may be built-in or attachable. 

Palmtop: 

A palmtop computer is a personal computer or other electronic device that has 

many of the same features as a computer and fits in the palm of your hand. A good 

example of an early palmtop computer is the PalmPilot. Because of their size, early 

palmtop computers did not have a keyboard or a mouse and often relied on a pen 

that used Graffiti or something similar. 

The term "palmtop computer" was an early term used when computers were big and 
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cumbersome and small cell phones and even smartphones were not yet invented. 

Today, this term is rarely used to describe a computer that fits in your hand because 

of the invention of the smartphone. 

Workstations 

Workstation is a computer used for engineering applications (CAD/CAM), desktop 

publishing, software development, and other such types of applications which 

require a moderate amount of computing power and relatively high quality graphics 

capabilities. 

Workstations generally come with a large, high-resolution graphics screen, large 

amount of RAM, inbuilt network support, and a graphical user interface. Most 

workstations also have mass storage device such as a disk drive, but a special type 

of workstation, called diskless workstation, comes without a disk drive. 

Common operating systems for workstations are UNIX and Windows NT. Like PC, 

workstations are also single-user computers but are typically linked together to form 

a local-area network although they can also be used as stand-alone systems. 

Summary 

 A computer is an electronic data processing device, which accepts and stores 

data input, processes the data input, and generates the output in a required 

format. 

 Abacus was the first counting device which was developed in China more 

than 3000 years ago. 

 Napier's bone is a device which contains a set of rods made of bones. It was 

developed by John Napier in 1617, a Scottish Mathematician  

 Slide Rule was an analog device invented by William Oughtred in 1620. The 

slide rule is used mainly for multiplication and division, and also for 

"scientific" functions such as roots, logarithms and trigonometry, but usually 

not for addition or subtraction. The slide rule is based on the work 

on logarithm. 

 Pascaline is a calculating machine developed by Blaise Pascal in 1642, a 

French Mathematician. It was the first device with an ability to perform 
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additions and subtractions on whole numbers. 

 Stepped Reckoner  a calculating machine designed in (1671) and built in 

(1673) by the German mathematician-philosopher Gottfried Wilhelm von 

Leibniz. 

 Jacquard Loom is an attachment for powered looms that uses a chain of punch 

cards to instruct the loom on how to make intricate textiles. It was invented 

by Joseph Jacquard and first demonstrated in 1801. 

 The analytical engine was based on input, process and output principle since 

the modern computers are based on Babbage's idea and principle. Therefore, 

Charles Babbage is also known as the father of modern computer science. 

 The Hollerith tabulating machine, also known as the tabulating machine, was 

an electrical counting machine invented by Herman Hollerith. 

 Mark I was designed (1937) by a Harvard graduate student, Howard H. Aiken 

to solve advanced mathematical physics problems encountered in his 

research. Aiken’s ambitious proposal envisioned the use of modified, 

commercially-available technologies coordinated by a central control system. 

 Atanasoff-Berry Computer, (ABC) is considered as the first electronic digital 

computer and was the first machine to use vacuum tubes (over 300 vacuum 

tubes). 

 Electronic Numerical Integrator and Calculator (ENIAC) was the first 

electronic computer used for general purposes, such as solving numerical 

problems. 

 Electronic Delay Storage Automatic Calculator (EDSAC) is an early British 

computer considered to be the first stored program electronic computer. 

 The UNIVAC is an electrical computer containing thousands of vacuum 

tubes, utilizes punch cards and switches for inputting data and punch cards 

for outputting and storing data. 

 Communication is a way to convey a message, an idea, a picture, or speech 

that is received and understood clearly and correctly by the person for whom 

it is meant. 

 A special purpose computer is designed only to meet the requirements of a 
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particular task or application. 

 A General Purpose computer are designed to meet the needs of many different 

applications. In these computers, the instructions needed to perform a 

particular task are wired permanently into the internal memory. 

 An analog computer is a form of computer that uses the continuously 

changeable aspects of physical phenomena such as electrical, mechanical, 

orhydraulic quantities to model the problem being solved. 

 Digital Computers operate essentially by counting. All quantities are 

expressed as discrete or numbers. 

 Hybrid Computers:- are computers that exhibit features of analog 

computers and digital computers. 

 A microcomputer is the smallest general purpose processing system. 

 A minicomputer is a medium-sized computer. That is more powerful than a 

microcomputer. 

 Computers with large storage capacities and very high speed of processing 

(compared to mini- or microcomputers) are known as mainframe computers. 

 Supercomputers have extremely large storage capacity and computing speeds 

which are many times faster than other computers. 

 Computer generation is the classification of computers into different groups 

according to their manufacturing date, other hardware and software 

technology used inside those computers. 

 The computers of first generation used vacuum tubes as the basic components 

for memory and circuitry for CPU (Central Processing Unit). 

 Computers of fourth generation used Very Large Scale Integrated (VLSI) 

circuits. 

 A PC(Personal Computer) can be defined as a small, relatively inexpensive 

computer designed for an individual user. 

 A notebook computer is a battery- or AC-powered personal computer 

generally smaller than a briefcase it can easily be transported and 

conveniently used in temporary spaces such as on airplanes, in libraries, 

temporary offices, and at meetings. 
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 A palmtop computer is a personal computer or other electronic device that 

has many of the same features as a computer and fits in the palm of your hand. 

 Workstation is a computer used for engineering applications (CAD/CAM), 

desktop publishing, software development, and other such types of 

applications which require a moderate amount of computing power and 

relatively high quality graphics capabilities. 

Self Evaluation 

1. Write very short answer of the following questions 

a. What is obtained after processing data? 

b. Computer is electronic or electrical device? 

c. Who is considered as the father of computer science? 

d. When was Abacus developed? 

e. Who was John Napier? 

f. Who is known as the first programmer? 

g. Which was the first computer brought in Nepal? 

h. What is the major component of second generation computer? 

i. What was the duration of first generation computer? 

j. Which generation computer supported GUI operating system? 

k. Write one example of fifth generation computer. 

l. What does the word "digital" means ? 

m. Which type of computers is in briefcase style? 

2. Write short answer of the following question. 

a. What is computer? How is it used in business and banking. 

b. Why is data processing done in computer? 

c. List any five features of computer. 

d. Why is computer called a versatile machine? 

e. Why is Charles Babbage known as father of computer science? 

f. Draw the figure of Abacus showing its parts. 

g. Write the feature of Mark-I. 

h. How are computer generations classified? 
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i. List any two advantages of second generation computer. 

j. Define the term artificial intelligence. 

k. Distinguish between analog and digital computer. 

l. List the type of digital computers. 

m. Write the application of super computer. 

n. Discuss one simple example of hybrid computer. 

3. Write long answer to the following question. 

a. Explain the working principle of computer with suitable diagram. 

b. Discuss any five features of computer. 

c. Explain the history of computing device of mechanical era. 

d. Compare and discuss between electromechanical and electrical era of 

computer. 

e. Describe the history of computer in Nepal in your own words. 

f. What is computer generation? Discuss different generation of computer 

with technologies used in each generation. 

g. Classify the types of digital computer with short description. 

h. Differentiate between general purpose and special purpose computer 

with suitable examples.  
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Unit: 2 

Computer System 
 

Learning Outcomes:- 

After completion of this unit you will be able to  

 explain the concepts of computer organization 

 explain computer hardware and memory 

 explain input and output devices 

 explain computer software 

2.1. Concept of Computer Organization 

The computer along with various hardware units and software that makes the 

computer function and perform the different tasks is collectively known as computer 

system. Computer system covers some categories some of which are given below : 

 Hardware 

 Software 

 Data or information 

 Procedure (data which the computer converts) 

 User 

 Communication 

1. Hardware 

Hardware refers to the part of computer. Hardware are observable and we can touch 

them. It refers to the physical devices of the computer. It consists of interconnected 

electronic equipment that controls everything the computer does. It includes input 

devices, input devices, output devices, processing devices and storage devices. 

Example of hardware are keyboard, monitor, CPU, hard disk and RAM. 

2. Software 

The software is the term used to describe the instruction that tells the hardware, 

what and how to perform a task. Without software, the hardware is useless. 

Examples of software are Window 7, MS office, Internet explorer, etc. 
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3. Data/Information 

The function of a computer system is to convert data into information. Data can be 

considered as the raw facts whether in a paper, electronic or the other form that is 

processed by the computer. In other words , data consist of the raw facts and figures 

that are processed to form information. Information is summarized or manipulated 

or processed data. 

4. People 

People constitute the most important parts of the computer system. People operate 

the computer hardware and create the computer software. They also follow a certain 

procedure when using the hardware and software. 

5. Procedure 
The procedure is a description of how things are done, step for accomplishing a 

result. Procedure for a computer system appears in documentation manual, also 

known as reference manual which contains instruction, rules, and guidelines to 

follow when using hardware and software. When you buy a microcomputer or 

software package, it comes with one or more documentation manuals. 

6. Communication 
When one computer system is set up to share data and information electronically 

with another computer system, communication becomes a system element. In other 

words, the manner on which the various individual system are connected by wires, 

cables, phone lines, microwave, Wi-Fi or satellite is an element of the total 

computer system. 

2.2. Types of Computer Hardware 
The computer is a device that is operated upon information or data. It is an 

electronic device which accepts inputs data, stores the data, carries out arithmetic, 

logic operations and provides the outputs in the desired format. The computer 

receives data, processes it, produces output and stores it for further references. So, 

a computer should have at least four major components to perform these tasks. A 

block diagram of the basic computer organization has the following functional 

units. 
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Fig: Block diagram of computer architecture 

Input Unit 

The input unit is formed by the input devices attached to the computer. Input 

devices are to to interact with a computer system or used enter data and instructions 

to the computer. These devices convert input data and instructions into a suitable 

binary form such as ASCII, which can be acceptable by the computer. In brief, an 

input unit performs the following functions: 

 It accepts data and instruction from the outside worlds. 

 It converts these data and instruction into computer understandable from a 

binary form. 

 It supplies the converted data and instructions to the computer system for 

further processing. 

 The examples of input devices are keyboard, mouse, scanner etc. 

Central Processing Unit (CPU) 

CPU is the component that actually responsible for interpreting and executing most 

of the commands from the computer hardware and software and also controling the 
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operation of all other components such as memory unit, input and output devices. 

It simply accepts binary data as input and processes data according to those 

instructions and provides the result as output. It is the logic machine. So, its main 

function is run the program by fetching instructions from the RAM, evaluating and 

executing them in sequence. In summary, the function of CPU are as follow: 

 Reading instruction from memory 

 Communicating with all peripherals using the system bus. 

 Controling the sequence of instructions. 

 Controling the flow of data from one component to another component. 

 Performing the computing task specified in the program. 

The CPU has three components responsible for different function, these 

components are Control units, arithmetic-logical unit (ALU) and Register. 

 
Fig: Components of CPU 

Control Unit 

The control unit provides the necessary timing and control signals to all the 

operations on the computer. It controls the flow of data between the CPU, memory 

and peripherals. It also controls the entire operation of a computer. It obtains the 

instructions from the program stored in the main memory, interprets the instructions 

and issues the signals which cause the other units of the system to execute them. 

So, it is considered as a central nervous system of a computer that provides status, 

control and timing signals necessary for the operation of other parts of CPU, 
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memory and I/O devices. The main functions of control units are given below: 

 It performs the data processing operations with the aid of program prepared 

by the user and sends control signals to various parts of the computer system. 

 It gives commands to transfer data from the input devices to the memory to 

an arithmetic logic unit. 

 It also transfers the results from ALU to the memory and then to the output 

devices. 

 It stores a program in the memory. 

 It fetches the required instruction from the main storage and decodes each 

instruction; and hence executes them in sequence. 

Arithmetic Logic Unit 

This is the area of CPU where various computing functions are performed on data. 

The ALU performs arithmetic operations such as addition, subtraction, 

multiplication and division and logical operation such as comparison AND, OR and 

Exclusive OR. The result of an operation is stored in Accumulator or in some 

register. The main functions of ALU are as follow: 

 It accepts operands from registers. 

 It performs arithmetic and logic operations. 

 It returns a result to register or a memory. 

The logical operations of ALU give the computer the decision-making ability. 

Registers 

Registers are the high-speed temporary storage locations in the CPU made from 

electronic devices such as transistors, flip-flops, etc. So, registers can be thought as 

CPU’s working memory. Register are primarily used to store data temporarily 

during the execution of a program and are accessible to the user through 

instructions. These are the part of Control unit and ALU rather than of memory 

Output Unit 

The output unit is formed by the output devices attached to the computer. Output 

devices are used to present result produced by the computer to the users. The output 
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from the computer is in the form electric signals, which is then converted into 

human understandable form into human readable form. 

The examples of output devices are the monitor, printer and speaker. 

The main functions of the output unit are as follow: 

 It accepts the result produced by the computer which is in electric binary 

signals. 

 It then converts the result into human readable form. 

 Finally, it supplies the converted results to the outside word. 

2.4. Memory and Storage Devices: 

Memory Unit: 

This unit is also called storage unit. The data and instructions which are entered 

through an input unit must be stored on the computer before the actual processing 

starts. The result produces by the computer after processing is also kept somewhere 

before passing to the output units. If intermediate results are produced during 

processing, it should be stored in somewhere in memory. The storage unit of a 

computer performs all these needs. In brief, the specific functions performed by the 

storage unit are as follow: 

 It stores data and instructions, which are entered through input devices. 

 It stores an intermediate result of processing. 

 It stores the final result of processing before these results are passed to an 

output device. 

The storage unit of computers consists of two types of memory or storage: primary 

and secondary storage: 

i. Primary Storage 

Memory storage that communicates directly with CPU is called main memory. It 

enables the computer to store, at least temporarily data and instruction. It is mainly 

used to hold data and instructions and as well as the intermediate result of 

processing which the computer system is currently working on. Primary memory is 

volatile, that is, it loses its content when power supply is off. There are two types 
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of primary memory. They are RAM and ROM. 

 

1. Random Access Memory (RAM) 

 It is also called as read write memory or the main memory or the primary 

memory. 

 The programs and data that the CPU requires during execution of a program 

are stored in this memory. 

 It is a volatile memory as the data loses when the power is turned off. 

 RAM is further classified into two types- SRAM (Static Random Access 

Memory) and DRAM (Dynamic Random Access Memory). 

DRAM SRAM 
1. Constructed of tiny capacitors that 

leak electricity. 
1. Constructred of circuits similar to 

D flip-flops. 
2. Required a recharge every few 

milliseconds to maintain its data. 
2. Holds its contents as long as 

power is available. 
3. Inexpensive. 3. Expensive. 
4. Slower than SRAM. 4. Faster than DRAM. 
5. Can store many bits per chip. 5. Can not store many bits per chip. 
6. Use less power. 6. Uses more power. 
7. Generates less heat. 7. Generates more heat. 
8. Used for main memory. 8. Used for cache. 

 

2. Read Only Memory (ROM) 
The functions of ROM are given below ; 

 Stores crucial information essential to operate the system, like the program 

essential to boot the computer. 
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 It is not volatile. 

 It is used in embedded systems or where the programming needs no change. 

 It is used in calculators and peripheral devices. 

 ROM is further classified into 4 types- ROM, PROM, EPROM, and 

EEPROM. 

Types of Read Only Memory (ROM) 

1. PROM (Programmable read-only memory) – It can be programmed by 

user. Once programmed, the data and instructions in it cannot be changed. 

2. EPROM (Erasable Programmable read only memory) – It can be 

reprogrammed. To erase data from it, expose it to ultra violet light. To 

reprogram it, erase all the previous data. 

3. EEPROM (Electrically erasable programmable read only memory) – 

The data can be erased by applying electric field, no need of ultra violet light. 

We can erase only portions of the chip 

Difference between RAM and ROM 

RAM ROM 
1. Temporary Storage 1. Permanent storage 
2. Store data in MBs. 2. Store data in GBs. 
3. Volatile. 3. Non-volatile. 
4. Used in normal operations. 4. Used for startup process of 

computer. 
5. Writing data is faster. 5. Writing data is slower. 

 

Cache Memory 

As CPU has to fetch instruction from main memory speed of CPU depending on 

fetching speed from main memory. Cache is cheaper so we can access cache. Cache 

memory is a very high speed memory that is placed between the CPU and main 

memory, to operate at the speed of the CPU.It is used to reduce the average time to 

access data from the main memory. The cache is a smaller and faster memory 

which stores copies of the data from frequently used main memory locations.  

ii. Secondary Storage 

Auxiliary storage is also known as secondary storage. It is the memory that 
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supplements the main memory. These are a non-volatile memory. It is mainly used 

to transfer data to program from one computer to another computer. There are high 

capacity storage devices used to store data and program permanently. These are 

also used as backup devices which allow to store the valuable information as backup 

on which you are working on. The examples of secondary memory are Magnetic 

Tape, Magnetic Disk, Optical disk, etc. 

Primary Vs Secondary data 

BASIS FOR 
COMPARISON

PRIMARY DATA SECONDARY DATA 

Meaning Primary data refers to the 
first hand data gathered by 
the researcher himself. 

Secondary data means data 
collected by someone else 
earlier. 

Data Real time data Past data 
Process Very involved Quick and easy 
Source Surveys, observations, 

experiments, questionnaire, 
personal interview, etc. 

Government publications, 
websites, books, journal 
articles, internal records etc. 

Cost 
effectiveness 

Expensive Economical 

Collection time Long Short 
Specific Always specific to the 

researcher's needs. 
May or may not be specific to 
the researcher's need. 

Available in Crude form Refined form 
Accuracy and 
Reliability 

More Relatively less 

 

Various Storage Devices 

Magnetic Tape 

Magnetic tape is a type of physical storage media for different kinds of data. It is 

considered an analog solution, in contrast to more recent types of storage media, 

such as solid state disk (SSD) drives. Magnetic tape has been a major vehicle for 

audio and binary data storage for several decades, and is still part of data storage 

for some systems. Magnetic tape was used in many of the larger and less complex 

mainframe computers that predated today’s personal computers (PC). 
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Magnetic Storage Devices 

Magnetic storage or magnetic recording is the storage of data on a magnetized 

medium. Magnetic storage uses different patterns of magnetisation in a 

magnetisable material to store data and is a form of non-volatile memory. The 

information is accessed using one or more read/write heads. 

Floppy Disks 

A floppy disk, also called a floppy, diskette, or just disk, is a type of disk 

storage composed of a disk of thin and flexible magnetic storage medium, sealed in 

a rectangular plastic enclosure lined with fabric that removes dust particles. Floppy 

disks are read and written by a floppy disk drive (FDD). 

 

Hard Disks 

A hard disk drive (HDD), hard disk, hard drive, or fixed disk is an 

electromechanical data storage device that uses magnetic storage to store and 

retrieve digital information using one or more rigid rapidly rotating disks (platters) 

coated with magnetic material. The platters are paired with magnetic heads, usually 

arranged on a moving actuator arm, which read and write data to the platter 

surfaces. Data is accessed in a random-access manner, meaning that 

individual blocks of data can be stored or retrieved in any order and not 

only sequentially. HDDs are a type of non-volatile storage, retaining stored data 

even when powered off. 

 



Computer Application : Grade 9 39 

Optical Disks 

An optical disc (OD) is a flat, usually circular disc which encodes binary data (bits) 

in the form of pits (binary value of 0 or off, due to lack of reflection when read) and 

lands (binary value of 1 or on, due to a reflection when read) on a special material 

(often aluminum) on one of its flat surfaces. The encoding material sits a top a 

thicker substrate (usually polycarbonate) which makes up the bulk of the disc and 

forms a dust defocusing layer. The encoding pattern follows a continuous, spiral 

path covering the entire disc surface and extending from the innermost track to the 

outermost track. The data is stored on the disc with a laser or stamping machine, 

and can be accessed when the data path is illuminated with a laser diode in 

an optical disc drive which spins the disc at speeds of about 200 to 4,000 RPM or 

more, depending on the drive type, disc format, and the distance of the read head 

from the center of the disc (inner tracks are read at a higher disc speed).There are 

four types of optical disks- 

1. CD-ROM- Compact Disk Read Only Memory 

2. WORM – Write Once Read Many 

3. Erasable Optical Disk 

4. DVD ROM. 

5. VCD 

 1. CD-ROM 

It is an optical ROM in which, pre-recorded data can be read out. The manufacturer 

writes data on CD-ROMs. The disk is made up of a resin such as polycarbonate. It 

is coated with a material which will change when a high intensity laser beam is 

focused on it. The coating material is highly reflective, usually aluminum. It is also 

called a laser disk. 

The advantages of CD-ROM are its high storing capacity, mass copy of information 

stored, removable from the computer, etc. 

 2. WORM or CD-R(CD-Recordable) 

It is write- once read-many type optical disk memory. The users can write data on 

WORM and read the written data as many times as desired. To write data on the 
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disk the laser beam of modest density is employed, which forms pits or bubbles on 

the disk surface. Its disk controller is somewhat expensive than that for CD-ROM. 

For writing operation, required laser power is more than that required for reading. 

Its advantages are its high capacity, better reliability and longer life. The drawback 

is greater access time compares to that of hard disk. 

3. Erasable Optical Disk or CD-ROM 

It is a read /write optical disk memory. Information can be written to and read from 

the disk. The disk contents can be erased and new data can be rewritten. So it can 

serve as a secondary memory of a computer. Its advantages over magnetic hard disk 

are : 

 Very high storage capacity 

 An optical disk can be removed from the drive 

 It has long life 

 It is more reliable etc. 

 The drawback is its longer access time compared to that of a hard disk 

4. DVD ROM 

DVD stands for Digital Versatile Disks. A DVD stores much more data than CD-

ROM. Its capacity are 4.7 GB, 8.5 GB, 20 GB, etc. the capacity depends on whether 

it is a single layer, double layer single sided or double sided disk. DVD ROM uses 

the same principle as a CDROM for reading and writing. But a smaller wavelength 

beam is used. A lens system is used to focus on two different layers on the disk. On 

each layer data is recorded. Thus, the capacity can be doubled. Further the recording 

beam is sharper compared to CDROM and the distance between successive tracks 

on the surface is smaller. The total capacity of DVD ROM is 8.5 GB. In double 

sided DVDROM two such disks are stuck back to back which allows recording on 

both sides. This requires the disk to be reversed to read the reverse side. Hence, the 

double sided DVDROM’s capacity is 17 GB. However, double sided DVDROM 

should be handled carefully as both sides have data, they are thinner, and could be 

accidentally damaged. 
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5. VCD 

Video CD (abbreviated as VCD, and also known as Compact Disc digital video) is 

a home video format and the first format for distributing films on standard 120 mm 

(4.7 in) optical discs. The format is a standard digital format for storing video on 

a compact disc. VCDs are playable in dedicated VCD players and widely playable 

in most DVD players, personal computers and some video game consoles.  

6. DVD RW 

Stands for "Digital Versatile Disk Rewritable." A DVD-RW is like a DVD-R but 

can be erased and written to again. Like CD-RWs, DVD-RWs must be erased in 

order for new data to be added. DVD-RWs can hold 4.7GB of data and do not come 

in double-layered or double-sided versions like DVD-Rs do. Because of their large 

capacity and ability to be used mulitple times, DVD-RW discs are a great solution 

for frequent backups. To record data onto a DVD-RW disc, you'll need a DVD 

burner that supports the DVD-RW format. 

7. Blue Ray Disc. 

Blu-ray Disc is a high-density optical disc format similar to DVD. Blu-ray is the 

type of disc used for PlayStation 3 games and for playing high-definition (HD) 

movies. In the past, there were other standards for such movies, such as the HD 

DVD format. Blu-ray won what is called the format war. 

A dual-layer Blu-ray disc can store up to 50GB (gigabytes) of data. This is over 

five times the capacity of a DVD, and over 70 times more than a CD or VCD.  

Flash drives 

A flash drive is a small, ultra-portable storage device which, unlike an optical 

drive or a traditional hard drive, has no moving parts. 

Flash drives connect to computers and other devices via a built-in USB Type-

A plug, making a flash drive a kind of combination USB device and cable. 

SD Cards 

The SD card is a basic way of transferring information and storing it. The good 

thing about it is that it’s a non-volatile solution just like the majority of storage 
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devices and you don’t need power source for it to keep the data 

.  

MMC Memory Cards: 

MultiMediaCard (MMC) is a memory-card standard used for solid-state storage. 

MMC operates as a storage medium for a portable device, in a form that can easily 

be removed for access by a PC. For example, a digital camera would use an MMC 

for storing image files. MMCs are available in sizes up to and including 512 GB. 

 
Physical structure of floppy and hard disk ,drive naming conventions in PC 

Physical Structure of floppy disk 

A floppy disk is basically a circular sheet of plastic, coated with magnetic material. 

A hard disk is made of a stack of circular metal platters, also coated with magnetic 

material. Before a disk can be used it must be formatted. The surface of the disk is 

divided up into a number of concentric tracks, each of which is subdivided 

into sectors. 

Floppy disks have 80 tracks on each side and each track is split into 18 sectors. A 

3.5" floppy disk with 80 tracks and 18 sectors will have 80 x 18 = 1,440 storage 

units, each uniquely identified by its track and sector position. Each storage unit 

can hold 512 bytes of data, so the disk has a capacity of 1,440 x 512 = 737,280 

bytes (720 KBytes) per side, or 1,400 KBytes (1.4 MBytes) per disk. 

A hard disk is a sealed unit containing a stack of circular platters mounted on a 

common spindle. Electromagnetic read/write heads are located above and below 

each platter. The platters rotate at a constant speed, eg: 7200 rpm. While they are 

spinning the heads can move in towards the centre or out towards the edge. This 
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allows them to reach any location on the platter. 

 
Physical Structure of hard disk 

 

The above picture is the physical structure of a hard disk; the hard disk consists of 

several discs. How to locate a position on a hard disk? There are three words you 

should learn: cylinder, head and sector. 

Cylinder 

The disc that makes up the hard disk is divided into tracks; tracks of all discs which 

have same track value are called a cylinder, so the cylinder is a pile of tracks with 

same track value of a hard disk. 

Head 
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Normally, a disc has two heads for reading or writing data, one is for the top and 

the other one is for the opposite side; the head value means the disc location and 

side. 

Sector 

A track is composed of sectors and the number of sectors of all tracks on the hard 

disk is the same.Sector is the minimal storage unit of a hard disk; the size of one 

sector is always 512 bytes (rarely, it might be 1024, 2048 or 4096 bytes in some 

special hard disks).  

2.4. Input Device 

An input device is a piece of computer hardware equipment used to provide data 

and control signals to an information processing system such as a computer or 

information appliance. Examples of input devices include keyboards, mouse, 

trackball, joystick, digitizing tablet, scanners, digital cameras, MICR, OCR, OMR, 

Bar-code Reader, Voice Recognition, Light pen, Touch Screen etc. 

Keyboard 

Keyboard is the most common and very popular input device which helps to input 

data to the computer.  he layout of the keyboard is like that of traditional typewriter, 

although there are some additional keys provided for performing additional 

functions. 

 
Keyboards are of two sizes 84 keys or 101/102 keys, but now keyboards with 104 

keys or 108 keys are also available for Windows and Internet. 
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The keys on the keyboard are as follows 

S.No Keys & Description 
1 Typing Keys 

These keys include the letter keys (A-Z) and digit keys (0-9) which 
generally give the same layout as that of typewriters. 

2 Numeric Keypad 
It is used to enter the numeric data or cursor movement. Generally, it 
consists of a set of 17 keys that are laid out in the same configuration used 
by most adding machines and calculators. 

3 Function Keys 
The twelve function keys are present on the keyboard which are arranged 
in a row at the top of the keyboard. Each function key has a unique 
meaning and is used for some specific purpose. 

4 Control keys 
These keys provide cursor and screen control. It includes four directional 
arrow keys. Control keys also include Home, End, Insert, Delete, Page 
Up, Page Down, Control(Ctrl), Alternate(Alt), Escape(Esc). 

5 Special Purpose Keys 
Keyboard also contains some special purpose keys such as Enter, Shift, 
Caps Lock, Num Lock, Space bar, Tab, and Print Screen. 

 

Mouse 

Mouse is the most popular pointing device. It is a very famous cursor-control device 

having a small palm size box with a round ball at its base, which senses the 

movement of the mouse and sends corresponding signals to the CPU when the 

mouse buttons are pressed. 

Generally, it has two buttons called the left and the right button and a wheel is 

present between the buttons. A mouse can be used to control the position of the 

cursor on the screen, but it cannot be used to enter text into the computer. 

Track Ball 

Track ball is an input device that is mostly used in notebook or laptop computer, 

instead of a mouse. This is a ball which is half inserted and by moving fingers on 
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the ball, the pointer can be moved.Since the whole device is not moved, a track ball 

requires less space than a mouse. A track ball comes in various shapes like a ball, a 

button, or a square. 

Joystick 

Joystick is also a pointing device, which is used to move the cursor position on a 

monitor screen. It is a stick having a spherical ball at its both lower and upper ends. 

The lower spherical ball moves in a socket. The joystick can be moved in all four 

directions.The function of the joystick is similar to that of a mouse. It is mainly used 

in Computer Aided Designing (CAD) and playing computer games. 

Digitizer 

Digitizer is an input device which converts analog information into digital form. 

Digitizer can convert a signal from the television or camera into a series of numbers 

that could be stored in a computer. They can be used by the computer to create a 

picture of whatever the camera had been pointed at.Digitizer is also known as Tablet 

or Graphics Tablet as it converts graphics and pictorial data into binary inputs. A 

graphic tablet as digitizer is used for fine works of drawing and image manipulation 

applications. 

Scanner 

Scanner is an input device, which works more like a photocopy machine. It is used 

when some information is available on paper and it is to be transferred to the hard 

disk of the computer for further manipulation. Scanner captures images from the 

source which are then converted into a digital form that can be stored on the disk. 

These images can be edited before they are printed. 

Digital Camera 

A digital camera is a camera that takes video or photographs and input to the 

computer in the digital format. At first, the photographs are stored in the camera's 

memory and then transferred to a computer through a cable. Then, we can edit that 

photograph according to our requirement. Most of the camera we use today are 

digital. 
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Magnetic Ink Card Reader (MICR) 

MICR input device is generally used in banks as there are large number of cheques 

to be processed every day. The bank's code number and cheque number are printed 

on the cheques with a special type of ink that contains particles of magnetic material 

that are machine readable. 

 

This reading process is called Magnetic Ink Character Recognition (MICR). The 

main advantages of MICR is that it is fast and less error prone. 

Optical Character Reader (OCR) 

OCR is an input device used to read a printed text. 

 

OCR scans the text optically, character by character, converts them into a machine 

readable code, and stores the text on the system memory. 

Optical Mark Reader (OMR) 

OMR is a special type of optical scanner used to recognize the type of mark made 

by pen or pencil. It is used where one out of a few alternatives is to be selected and 

marked. 
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It is specially used for checking the answer sheets of examinations having multiple 

choice questions. 

Bar Code Readers (BCR) 

Bar Code Reader is a device used for reading bar coded data (data in the form of 

light and dark lines). Bar coded data is generally used in labeling goods, numbering 

the books, etc. It may be a handheld scanner or may be embedded in a stationary 

scanner. 

 

Bar Code Reader scans a bar code image, converts it into an alphanumeric value, 

which is then fed to the computer that the bar code reader is connected to. 

Voice Recognition 

Voice or speaker recognition is the ability of a machine or program to receive and 

interpret dictation or to understand and carry out spoken commands. Voice 

recognition has gained prominence and use with the rise of AI and intelligent 

assistants, such as Amazon's Alexa, Apple's Siri and Microsoft's Cortana. 

Voice recognition systems enable consumers to interact with technology simply by 

speaking to it, enabling hands-free requests, reminders and other simple tasks. 

Voice recognition is a computer software program or hardware device with the 

ability to decode the human voice.  
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Light Pen 

Light pen is a pointing device similar to a pen. It is used to select a displayed menu 

item or draw pictures on the monitor screen. It consists of a photocell and an optical 

system placed in a small tube. 

 

When the tip of a light pen is moved over the monitor screen and the pen button is 

pressed, its photocell sensing element detects the screen location and sends the 

corresponding signal to the CPU. 

Microphone 

Microphone is an input device to input sound that is then stored in a digital form. 

The microphone is used for various applications such as adding sound to a 

multimedia presentation or for mixing music. 

 
Touch Screen 

A touch screen is a display device that allows the user to interact with a computer 

by using their finger. They can be quite useful as an alternative to a mouse or 

keyboard for navigating a graphical user interface (GUI). Touch screens are used 

on a variety of devices such as computer and laptop monitors, smart phones, tablets, 

cash registers, and information kiosks. Some touch screens use a grid of infrared 

beams to sense the presence of a finger instead of utilizing touch-sensitive input. 
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2.5. Output devices 

Following are some of the important output devices used in a computer. 

 Monitors 

 Graphic Plotter 

 Printer 

Monitors 

Monitors, commonly called as Visual Display Unit (VDU), are the main output 

device of a computer. It forms images from tiny dots, called pixels that are arranged 

in a rectangular form. The sharpness of the image depends upon the number of 

pixels. 

There are two kinds of viewing screen used for monitors. 

 Cathode-Ray Tube (CRT) 

 Flat-Panel Display 

Cathode-Ray Tube (CRT) Monitor 

The CRT display is made up of small picture elements called pixels. The smaller 

the pixels, the better the image clarity or resolution. It takes more than one 

illuminated pixel to form a whole character, such as the letter ‘e’ in the word help. 
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There are some disadvantages of CRT Large in Size and High power consumption. 

Flat-Panel Display Monitor 

The flat-panel display refers to a class of video devices that have reduced volume, 

weight and power requirement in comparison to the CRT. You can hang them on 

walls or wear them on your wrists. Current uses of flat-panel displays include 

calculators, video games, monitors, laptop computer, and graphics display. 

 

The flat-panel display is divided into two categories 

 Emissive Displays− Emissive displays are devices that convert electrical 

energy into light. For example, plasma panel and LED (Light-Emitting 

Diodes). 

 Non-Emissive Displays− Non-emissive displays use optical effects to 

convert sunlight or light from some other source into graphics patterns. For 

example, LCD (Liquid-Crystal Device). 

Characteristics of a monitor 

Following are the characteristics of a monitor: 

a) Size: The most important aspect of a monitor is its size. Screen sizes are 

measured in diagonal inches, the distance from one corner to another opposite 

corner diagonally. 

b) Resolution: The resolution of a monitor indicates how density the pixels are 

packed. Pixel is short short for picture element. A pixel is a single point in a 

graphic image.  

c) Band Width: The amount of data that can be transmitted in a fixed amount 

of time. 

d) Refresh Rate:  Display monitors must be refresh many times per second. The 

refresh rate determines how many times per seconds the screen is to be red 
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drawn. The refresh rate of a monitor is measured in Hertz.  

e) Interlacing: It is a technique in which instead of scanning the image one line 

at a time, it scans alternately i.e. alternate lines are scanned at each pass.  

Video Standard 

It will be frustrating if you get a new monitor and then find out you can't connect it 

to your computer! Your computer needs to send information to your monitor so you 

can see it. The precise way it does that, and through what kind of cable, is the video 

standard used. Four different standards are widely used. Each has sub-

standards. Your computer will normally have from 1 to 3 of those options available 

to you. They seldom offer all four standards. Your monitor will probably offer 2 or 

3 options. Sometimes your computer might not have the type of standard used by 

your monitor, especially if you are adding a second monitor. 

VGA  

The oldest standard is VGA. It stands for Video Graphics Array and was introduced 

by IBM in 1987. It has been improved since then to allow for more pixels and better 

performance. This is an Analog display standard, so cabling, and distance can 

degrade the quality of the output. Generally speaking, newer monitors will look 

better using a digital standard.  

SVGA 

A Super Video Graphics Array (SVGA) monitor is an output device which uses the 

SVGA standard. SVGA is a video-display-standard type developed by the Video 

Electronics Standards Association (VESA) for IBM PC compatible personal 

computers (PCs). 

XGA 

XGA (Extended Graphics Array) is a high-resolution video display mode that 

provides screen pixel resolution of 1,024 by 768 in 256 colors or 640 by 480 in high 

(16-bit) color.  

The XGA standard is used in desktop and laptop computers as well as in projection 

systems. 
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Printers 

Printer is an output device, which is used to print information on paper. 

There are two types of printers– 

 Impact Printers 

 Non-Impact Printers 

Impact Printers 

Impact printers print the characters by striking them on the ribbon, which is then 

pressed on the paper. 

Characteristics of Impact Printers are the following − 

 Very low consumable costs 

 Very noisy 

 Useful for bulk printing due to low cost 

 There is physical contact with the paper to produce an image 

These printers are of two types − 

 Character printers 

 Line printers 

Character Printers 

Character printers are the printers which print one character at a time. 

These are further divided into two types: 

 Dot Matrix Printer(DMP) 

 Daisy Wheel 

Dot Matrix Printer 

In the market, one of the most popular printers is Dot Matrix Printer. These printers 

are popular because of their ease of printing and economical price. Each character 

printed is in the form of pattern of dots and head consists of a Matrix of Pins of size 

(5*7, 7*9, 9*7 or 9*9) which come out to form a character which is why it is called 

Dot Matrix Printer. 



54 Computer Application : Grade 9 

 

Advantages 

 Inexpensive 

 Widely Used 

 Other language characters can be printed 

Disadvantages 

 Slow Speed 

 Poor Quality 

Daisy Wheel 

Head is lying on a wheel and pins corresponding to characters are like petals of 

Daisy (flower) which is why it is called Daisy Wheel Printer. These printers are 

generally used for word-processing in offices that require a few letters to be sent 

here and there with very nice quality. 

 

Advantages 

 More reliable than DMP 

 Better quality 

 Fonts of character can be easily changed 
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Disadvantages 

 Slower than DMP 

 Noisy 

 More expensive than DMP 

Line Printers 

Line printers are the printers which print one line at a time. 

 

These are of two types– 

 Drum Printer 

 Chain Printer 

Drum Printer 

This printer is like a drum in shape hence it is called drum printer. The surface of 

the drum is divided into a number of tracks. Total tracks are equal to the size of the 

paper, i.e. for a paper width of 132 characters, drum will have 132 tracks. A 

character set is embossed on the track. Different character sets available in the 

market are 48 character set, 64 and 96 characters set. One rotation of drum prints 

one line. Drum printers are fast in speed and can print 300 to 2000 lines per minute. 

Advantages 

 Very high speed 

Disadvantages 

 Very expensive 

 Characters Fonts cannot be changed 

Chain Printer 

In this printer, a chain of character sets is used, hence it is called Chain Printer. A 

standard character set may have 48, 64, or 96 characters. 
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Advantages 

 Character fonts can easily be changed. 

 Different languages can be used with the same printer. 

Disadvantages 

 Noisy 

Non-impact Printers 

Non-impact printers print the characters without using the ribbon. These printers 

print a complete page at a time, thus they are also called as Page Printers. 

These printers are of two types  

 Laser Printers 

 Inkjet Printers 

Characteristics of Non-impact Printers 

 Faster than impact printers 

 They are not noisy 

 High quality 

 Supports many fonts and different character size 

Laser Printers 

These are non-impact page printers. They use laser lights to produce the dots needed 

to form the characters to be printed on a page. 

 

Advantages 

 Very high speed 

 Very high quality output 
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 Good graphics quality 

 Supports many fonts and different character size 

Disadvantages 

 Expensive 

 Cannot be used to produce multiple copies of a document in a single printing 

Inkjet Printers 

Inkjet printers are non-impact character printers based on a relatively new 

technology. They print characters by spraying small drops of ink onto paper. Inkjet 

printers produce high quality output with presentable features. 

 
They make less noise because no hammering is done and these have many styles of 

printing modes available. Color printing is also possible. Some models of Inkjet 

printers can produce multiple copies of printing also. 

Advantages 

 High quality printing 

 More reliable 

Disadvantages 

 Expensive as the cost per page is high 

 Slow as compared to laser printer 

2.6. Computer Software: 

Software is a set of programs, which is designed to perform a well-defined function. 

A program is a sequence of instructions written to solve a particular problem. 

Software is a collection of instructions that enable the user to interact with a 
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computer, its hardware, or perform tasks. Without software, most computers would 

be useless. For example, without your Internet browser software, you can not surf 

the Internet or read the page. Without an operating system, the browser can not run 

on your computer. The picture to the right shows a Microsoft Excel box, an example 

of a spreadsheet software program. 

2.6.1. Necessity of computer software 

Software is the soul of the computer. Without it, the computer will never be useful. 

In simple words software is a set of programs, procedures, algorithms and its 

documentation. Program software performs the function of the program it 

implements, either by directly providing instructions to the computer hardware or 

by serving as input to another piece of software. 

Some necessities of computer software are Security, Encryption Software, Backup 

& Disaster discovery, Network Enhancement, etc. 

2.6.2. Types of Software 

There are two types of software – 

 System Software 

 Application Software 

System Software 

The system software is a collection of programs designed to operate, control, and 

extend the processing capabilities of the computer itself. System software is 

generally prepared by the computer manufacturers. These software products 

comprise of programs written in low-level languages, which interact with the 

hardware at a very basic level. System software serves as the interface between the 

hardware and the end users. 

Some examples of system software are Operating System, Compilers, Interpreter, 

Assemblers, etc. 
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Here is a list of some of the most prominent features of a system software – 

 Close to the system 

 Fast in speed 

 Difficult to design 

 Difficult to understand 

 Less interactive 

 Smaller in size 

 Difficult to manipulate 

 Generally written in low-level language 

Application Software 

Application software products are designed to satisfy a particular need of a 

particular environment. All software applications prepared in the computer lab can 

come under the category of Application software. 

Application software may consist of a single program, such as Microsoft's notepad 

for writing and editing a simple text. It may also consist of a collection of programs, 

often called a software package, which work together to accomplish a task, such as 

a spreadsheet package. 

Examples of Application software are the following– 

 Payroll Software 

 Student Record Software 

 Inventory Management Software 

 Income Tax Software 

 Railways Reservation Software 

 Microsoft Office Suite Software 

 Microsoft Word 
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 Microsoft Excel 

 Microsoft PowerPoint 

 

Features of application software are as follows − 

 Close to the user 

 Easy to design 

 More interactive 

 Slow in speed 

 Generally written in high-level language 

 Easy to understand 

 Easy to manipulate and use 

 Bigger in size and requires large storage space 

SUMMARY 

 The computer along with various hardware units and software that makes the 

computer function and perform the different tasks is collectively known as 

computer system. 

 Hardware refers to the part of the computer which we can touch. It is the 

physical devices of the computer. 

 The software is the term used to describe the instruction that tells the 

hardware, what and how to perform a task. 

 Data can be considered as the raw facts whether in a paper, electronic or the 

other form that is processed by the computer. 

 Input devices are used to interact with a computer system or used to enter data 

and instructions to the computer. 

 CPU is the component that actually responsible for interpreting and executing 

most of the commands from the computer hardware and software and also 

controls the operation of all other components such as memory unit, input and 
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output devices. 

 The control unit provides the necessary timing and controls signals to all the 

operations on the computer. 

 The ALU performs arithmetic operations such as addition, subtraction, 

multiplication and division and logical operation such as comparison AND, 

OR and Exclusive OR. 

 Registers are the high-speed temporary storage locations in the CPU made 

from electronic devices such as transistors, flip-flops, etc. 

 The output unit is formed by the output devices attached to the computer. 

Output devices are used to present result produced by the computer to the 

users. 

 Memory unit stores data and instructions, which are entered through input 

devices. 

 Memory storage that communicates directly with CPU is called main 

memory. 

 The programs and data that the CPU requires during execution of a program 

are stored in RAM memory. 

 Stores crucial information essential to operate the system, like the program 

essential to boot the computer is ROM. 

 Cache memory is a very high speed memory that is placed between the CPU 

and main memory, to operate at the speed of the CPU. 

 Auxiliary storage is also known as secondary storage. It is the memory that 

supplements the main memory. These are a non-volatile memory. It is mainly 

used to transfer data to program from one computer to another computer. 

 Primary data refers to the first hand data gathered by the researcher himself. 

 Secondary data means the data collected by someone else earlier. 

 Magnetic tape is a type of physical storage media for different kinds of data. 

 A floppy disk, also called a floppy, diskette, or just disk, is a type of disk 

storage composed of a disk of thin and flexible magnetic storage medium, 

sealed in a rectangular plastic enclosure lined with fabric that removes dust 

particles. 
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 A hard disk drive (HDD), hard disk, hard drive, or fixed disk, is an 

electromechanical data storage device that uses magnetic storage to store and 

retrieve digital information using one or more rigid rapidly rotating disks 

(platters) coated with magnetic material. 

 An optical disc (OD) is a flat, usually circular disc which encodes binary data 

(bits) in the form of pits (binary value of 0 or off, due to lack of reflection 

when read) and lands (binary value of 1 or on, due to a reflection when read) 

on a special material (often aluminum) on one of its flat surfaces. 

 DVD stands for Digital Versatile Disks. A DVD stores much more data than 

CD-ROM. 

 A flash drive is a small, ultra-portable storage device which, unlike an optical 

drive or a traditional hard drive, has no moving parts. 

 Multi Media Card (MMC) is a memory-card standard used for solid-state 

storage. 

 The disc that makes up the hard disk is divided into tracks; tracks of all discs 

which have same track value are called a cylinder, so the cylinder is a pile of 

tracks with same track value of a hard disk. 

 Normally, a disc has two heads for reading or writing data, one is for the top 

and the other one is for the opposite side; the head value means the disc 

location and side.  

 A track is composed of sectors and the number of sectors of all tracks on the 

hard disk is the same. 

 Sector is the minimal storage unit of a hard disk; the size of one sector is 

always 512 bytes 

 Mouse is the most popular pointing device. It is a very famous cursor-control 

device having a small palm size box with a round ball at its base, which senses 

the movement of the mouse and sends corresponding signals to the CPU when 

the mouse buttons are pressed. 

 Track ball is an input device that is mostly used in notebook or laptop 

computer, instead of a mouse. 

 Joystick is also a pointing device, which is used to move the cursor position 
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on a monitor screen. 

 Digitizer is an input device which converts analog information into digital 

form. 

 Scanner is an input device, which works more like a photocopy machine. It is 

used when some information is available on paper and it is to be transferred 

to the hard disk of the computer for further manipulation. 

 A digital camera is a camera that takes video or photographs and input to the 

computer in the digital format. 

 Bar Code Reader is a device used for reading bar coded data (data in the form 

of light and dark lines). 

 Voice or speaker recognition is the ability of a machine or program to receive 

and interpret dictation or to understand and carry out spoken commands. 

 Light pen is a pointing device similar to a pen. It is used to select a displayed 

menu item or draw pictures on the monitor screen. 

 Microphone is an input device to input sound that is then stored in a digital 

form. 

 A touch screen is a display device that allows the user to interact with a 

computer by using their finger. 

 Monitors, commonly called as Visual Display Unit (VDU), are the main 

output device of a computer. It forms images from tiny dots, called pixels that 

are arranged in a rectangular form. 

 The flat-panel display refers to a class of video devices that have reduced 

volume, weight and power requirement in comparison to the CRT. 

 VGR stands for Video Graphics Array and was introduced by IBM in 1987. 

It has been improved since then to allow for more pixels and better 

performance. 

 Printer is an output device, which is used to print information on paper. 

 Impact printers print the characters by striking them on the ribbon, which is 

then pressed on the paper. 

 Non-impact printers print the characters without using the ribbon. These 

printers print a complete page at a time, thus they are also called as Page 
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Printers. 

 Software is a set of programs, which is designed to perform a well-defined 

function. A program is a sequence of instructions written to solve a particular 

problem. 

 The system software is a collection of programs designed to operate, control, 

and extend the processing capabilities of the computer itself. 

 Application software products are designed to satisfy a particular need of a 

particular environment. 

Self Evaluation 

1. Write very short answer to the following question. 

1. What is obtained after processing data? 

2. Which memory is volatile? 

3. Which is portable storage device these days? 

4. Which type of software is designed to meet the specific requirement of 

individual or organization? 

5. Is register an input device? 

6. Which is an audio output device? 

2. Write short answer to the following question. 

1. What is computer system?  
2. Differentiate between primary and secondary data. 
3. Draw physical structure of hard disk. 

4. Define computer hardware with some examples. 

5. What is CPU ? Write its major parts. 

6. Write the importance of software in computer. 

7. Write the function of CU and ALU. 

8. Differentiate between input device and output device. 

9. List the main unit of computer system. 

10. What is primary memory? List its major types. 

11. What are the necessities of computer software? 
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3. Write long answer to the following question. 

1. Explain different types of hardware devices that make computer 

system. 
2. What is software? Discuss types of software with example and explain 

also. 
3. Draw and explain the block diagram of computer system. 
4. What is a printer? Differentiate between impact and non impact printer. 

5. What is a monitor? Explain its types. 

6. What is an input device? Explain its types. 
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Unit: 3 

Operating System 
Learning Outcomes:- 

After completion of this unit you will be able to  

 explain/describe introduction of operating system. 

 explain/describe type of operating system. 

 explain/describe disk operating system. 

 explain/describe windows operating system 

 explain/describe Open sources operating system 

3.1. Introduction of operating system: 

An operating system is a kind of system software that controls and co-ordinates the 

overall operations of the computer system. The Operating System is a program with 

the following features − 

 An operating system is a program that acts as an interface between the 

software and the computer hardware. 

 It is specialized software that controls and monitors the execution of all other 

programs that reside in the computer, including application programs and 

other system software. 
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Characteristics of Operating System 

Here is a list of some of the most prominent characteristic features of Operating 

Systems  

 Memory Management  

 Processor Management  

 Device Management  

 File Management Security 

 Job Accounting Control  

 Over System Performance 

 Interaction with the Operators  

 Coordination Between Other Software and Users  

3.2. Types of operating system 

An Operating System performs all the basic tasks like managing file, process, and 

memory. Thus operating system acts as manager of all the resources, i.e. resource 

manager. Thus operating system becomes an interface between user and machine. 

Some of the widely used operating systems are as follows- 

Batch Operating System 

The users of a batch operating system do not interact with the computer directly. 

Each user prepares his job on an off-line device like punch cards and submits it to 

the computer operator. To speed up processing, jobs with similar needs are batched 

together and run as a group. The programmers leave their programs with the 

operator and the operator then sorts the programs with similar requirements into 

batches. 

The problems with Batch Systems are as follows − 

 Lack of interaction between the user and the job. 

 CPU is often idle because the speed of the mechanical I/O devices is slower 

than the CPU. 

 Difficult to provide the desired priority. 
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Single-user, single tasking Operating System  

As the name implies, this operating system is designed to manage the computer so 

that one user can effectively do one thing at a time. The Palm OS for Palm handheld 

computers is a good example of a modern single-user, single-task operating system. 

Single-user, multi-tasking Operating System 

This is the type of operating system most people use on their desktop and laptop 

computers today. Microsoft's Windows and Apple's Mac OS platforms are both 

examples of operating systems that will let a single user have several programs in 

operation at the same time. For example, it's entirely possible for a Windows user 

to be writing a note in a word processor while downloading a file from the Internet 

while printing the text of an e-mail message. 

Multiprogramming Operating System 

In a multiprogramming system there are one or more programs loaded in main 

memory which are ready to execute. Only one program at a time is able to get the 

CPU for executing its instructions (i.e., there is at most one process running on the 

system) while all the others are waiting their turn. 

The main idea of multiprogramming is to maximize the use of CPU time. Indeed, 

suppose the currently running process is performing an I/O task. Then, the OS may 

interrupt that process and give the control to one of the other in-main-memory 

programs that are ready to execute (i.e. process context switching). In this way, no 

CPU time is wasted by the system waiting for the I/O task to be completed, and a 

running process keeps executing until either it voluntarily releases the CPU or when 

it blocks for an I/O operation. Therefore, the ultimate goal of multiprogramming is 

to keep the CPU busy as long as there are processes ready to execute. 

Finally, note that if there are N ready processes and all of those are highly CPU-

bound (i.e., they mostly execute CPU tasks and none or very few I/O operations), 

in the very worst case one program might wait all the other N-1 ones to complete 

before executing. 
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Multi-user Operating System 

A multi-user operating system allows many different users to take advantage of the 

computer's resources simultaneously. The operating system must make sure that the 

requirements of the various users are balanced, and that each of the programs they 

are using has sufficient and separate resources so that a problem with one user 

doesn't affect the entire community of users. Unix, VMS and mainframe operating 

systems, such as MVS, are examples of multi-user operating systems. 

Multiprocessing Operating System 

Multiprocessing sometimes refers to executing multiple processes (programs) at the 

same time. This might be misleading because we have already introduced the term 

“multiprogramming” to describe that before. In fact, multiprocessing refers to 

the hardware (i.e., the CPU units) rather than the software (i.e., running processes). 

If the underlying hardware provides more than one processor then that is 

multiprocessing. Several variations on the basic scheme exist, e.g., multiple cores 

on one die or multiple dies in one package or multiple packages in one system. 

Anyway, a system can be both multi programmed by having multiple programs 

running at the same time and multiprocessing by having more than one physical 

processor. 

Multitasking Operating System 

Multitasking has the same meaning of multiprogramming but in a more general 

sense, as it refers to having multiple (programs, processes, tasks, threads) running 

at the same time. This term is used in modern operating systems when multiple 

tasks share a common processing resource (e.g., CPU and Memory). At any time 

the CPU is executing one task only while other tasks waiting their turn. The illusion 

of parallelism is achieved when the CPU is reassigned to another task (i.e. process 

or thread context switching). Just to make it easy to remember, both multi-

programming and multitasking operating systems are (CPU) time sharing systems. 

However, while in multiprogramming (older OSs) one program as a whole keeps 

running until it blocks, in multitasking (modern OSs) time sharing is best 

manifested because each running process takes only a fair quantum of the CPU 
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time. 

Multithreading Operating System 

Multitasking refers to multiple tasks running (apparently) simultaneously by 

sharing the CPU time. Finally, multiprocessing describes systems having multiple 

CPUs. Multithreading is an execution model that allows a single process to have 

multiple code segments (i.e., threads) run concurrently within the “context” of that 

process. Multiple threads of a single process can share the CPU in a single CPU 

system or (purely) run in parallel in a multiprocessing system. 

Time-sharing operating systems: 

Time-sharing is a technique which enables many people, located at various 

terminals, to use a particular computer system at the same time. Time-sharing or 

multitasking is a logical extension of multiprogramming. Processor's time which is 

shared among multiple users simultaneously is termed as time-sharing. 

Real-time operating system (RTOS)  

Real-time operating systems are used to control machinery, scientific instruments 

and industrial systems. An RTOS typically has very little user-interface capability, 

and no end-user utilities, since the system will be a "sealed box" when delivered for 

use. A very important part of an RTOS is managing the resources of the computer 

so that a particular operation executes in precisely the same amount of time, every 

time it occurs. In a complex machine, having a part move more quickly just because 

system resources are available may be just as catastrophic as having it not move at 

all because the system is busy. 

Distributed operating System 

Distributed operating systems use multiple central processors to serve multiple real-

time applications and multiple users. Data processing jobs are distributed among 

the processors accordingly. 

Network operating System 

A Network Operating System runs on a server and provides the server the capability 

to manage data, users, groups, security, applications, and other networking 
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functions. The primary purpose of the network operating system is to allow shared 

file and printer access among multiple computers in a network, typically a local 

area network (LAN), a private network or to other networks. 

Examples of network operating systems include Microsoft Windows Server 2003, 

Microsoft Windows Server 2008, UNIX, Linux, Mac OS X, Novell NetWare, and 

BSD. 

3.3. Disk operating system: 

Disk Operating System (DOS) was the first operating system used by IBM-

compatible computers. It was originally available in two versions that were 

essentially the same, but marketed under two different names. "PC-DOS" was the 

version developed by IBM and sold to the first IBM-compatible manufacturers. 

"MS-DOS" was the version that Microsoft bought the rights to, and was bundled 

with the first versions of Windows. 

DOS uses a command line, or text-based interface, that allows the user to type 

commands. By typing simple instructions such as pwd (print working directory) 

and cd (change directory), the user can browse the files on the hard drive, open files, 

and run programs. While the commands are simple to type, the user must know the 

basic commands in order to use DOS effectively (similar to Unix). This made the 

operating system difficult for novices to use, which is why Microsoft later bundled 

the graphic-based Windows operating system with DOS. 

The first versions of Windows (through Windows 95) actually ran on top of the 

DOS operating system. This is why so many DOS-related files (such as .INI, .DLL, 

and .COM files) are still used by Windows. However, the Windows operating 

system was rewritten for Windows NT (New Technology), which enabled 

Windows to run on its own, without using DOS. Later versions of Windows, such 

as Windows 2000, XP, and Vista, also do not require DOS. 

DOS is still included with Windows, but is run from the Windows operating system 

instead of the other way around. The DOS command prompt can be opened in 

Windows by selecting "Run..." from the Start Menu and typing cmd. 
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Command or Character based User Interface (CUI) 

CUI is a traditional user interface. It provides the interactive terminal where user 

can enter the command to interpret. It is the only one common place where the 

program and the user communicate with each other. MS-DOS and Novell Netware 

are some example of CUI based operating system. In CUI, user has to interact with 

the applications by making use of commands. In CUI, only one task can run at a 

time. 

CLI or CUI  advantages and disadvantages 

The advantages of a command line interface are: 

 granular control of an OS or application 

 faster management of a large number of operating systems 

 ability to store scripts to automate regular tasks; and 

 basic command line interface knowledge to help with troubleshooting, such 

as network connection issues. 

The disadvantages of a command line interface are : 

 GUI is more user-friendly; 

 steeper learning curve associated with memorizing commands and complex 

syntax/arguments; and 

 different commands used in different shells. 

Concept of File and Directory 

A file is systematic collection of related data or information or program instructions. 

A unique name is given for each file to identify it is called file name. A file name 

contains two parts: name and extension. Name helps to identify the file and 

extension helps to identify the type of file. Example, sarthak.exe. here, sarthak is 

file and .exe is extension. 

Rules for writing Filename 

1. Only alphanumeric characters are used in file name. 

2. The name can have maximum 8 characters long and extension can have three 

characters long. 
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3. The name and extension are separated by. (period) sign. 

4. Space, commas, colon and backslash cannot be used in filename. 

A directory is a location for storing files on your computer. Directories are found 

in a hierarchical file system, such as Linux, MS-DOS, OS/2, and Unix. 

In the picture to the right is an example of the tree command output that shows all 

the local and subdirectories (e.g., the "big" directory in the cdn directory). When 

looking at this overview, the C: drive is considered the current directory and root 

directory because there is nothing beneath it and you can't go back any further. If 

you are using an operating system with multiple user accounts the directory may 

also be referred to as a home directory. 

Wildcards and pathname 

Wild card character, a wildcard is a symbol used to replace or represent one or 

more characters. Wildcards are typically either an asterisk (*), which represents one 

or more characters or question mark (?), which represents a single character. In the 

examples below of how a wildcard may be used, realize that wildcards are relatively 

universal. 

Path is used to specify the location of files. It is the way of indicating the location 

of file. The path is specified by giving pathname. The pathname is a sequence of 

directory name followed by a file name and separated by "\" slash. 

Example: C:\program files\photoshop 

System Files: 

 IO.SYS (or IBMBIO.COM): This contains the system initialization code and 

built in device drivers. It is hidden file which manages and controls other 

programs. 

 MSDOS.SYS (or IBMDOS.COM): This contains the DOS kernel. Command 

line interpreter (Shell). It is hidden file which manages input/output 

operations of input/output devices. 

 COMMAND.COM: This is the command interpreter. User configuration 

files: 
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 AUTOEXEC.BAT: This is run by the default shell (usually 

COMMAND.COM) to execute commands at startup. 

 CONFIG.SYS: This contains statements to configure DOS and load device 

drivers. 

3.4. Windows operating system 

In windows operating system, we can give commands to the computer by clicking 

on icons, menus and buttons by using a mouse. We do not need to remember 

commands to perform any tasks in the computer like MS-DOS.  

Graphical User Interface (GUI) 

With advancement of technology, computer system has become quicker and 

cheaper. Operating environment has also changed. This lead the development of 

graphical user interface where users can interact with the computer using picture 

and graphs, rather than character and commands. It displays the icon, buttons, 

dialog box etc. Popular GUI based operating system is Microsoft Windows. 

Advantages of graphical user interface 

 Easiness for non-technical people 

 Drag and drop feature 

 Looks nicer than text interface 

 Hotkeys usage 

 User-friendly 

 Disabled people 

Disadvantages of graphical user interface 

 Difficult to develop and high cost 

 Slower than command line tools 

 Extra attention required 

 Using flat screen 

 Time consumption 

 Memory resources 

 Implementation 
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Examples of GUI 

 Microsoft Windows, Mac OS 

Difference between GUI and CUI 

S.N. GUI CUI 
1. It is based on graphical user 

interface mode and instructions are 

given using graphical components 

like menu bar, toolbar etc. 

It is based on command user interface 

mode and instructions are given using 

characters. 

2. It is graphical and user friendly and 

easy to learn and operate. 

It is more textual and less user friendly 

and difficult to operate and learn. User 

needs to memorise the commands to 

operate the system. 

3. It consists of different components 

such as text box, icon, desktop, 

pointing devices etc. 

It does not consist of such different 

components. 

4. E.g. Windows, Linux OS E.g. MS-DOS, Unix OS 
 

Working with a Windows Environment and Windows Application Program 

Desktop 

The desktop is the background displayed on your computer screen. It is the total 

visible area on the screen which users get immediately after turning on the 

computer. Files, folders, and program icons can be displayed on the desktop for 

easy access to users. 
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Fig.: Desktop icons 

Desktop 

On the desktop, files, folders and programs are displayed on window frame. The 

desktop may contain many items such as Computer, Network, Recycle Bin, User, 

etc. The desktop can be customized with themes and backgrounds to personalize 

the look of the computer. 

Start Menu: 

The start menu provides access to the most useful items on your computer including 

all programs, most recent documents, help and support and other items on your 

computer. Present Windows includes more Start menu customization options. This 

menu appears by clicking on the start button. 

Fig. Startup menu 

Icons 

Icons are the small graphical image used in GUI OS environment. It represents the 
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symbolic meaning of the command, file, program, web page, etc. Icons help to 

execute commands, open programs or documents quickly. To execute a command 

by using an icon, click or double-click on the icon. An icon is a group of images of 

various formats (size and colors). 

Fig. Icons 

Window 

Windows are frames on the desktop that contains the contents of opened files, 

folders, and programs. In other words, it is usually a rectangular portion of the 

display on a computer monitor that presents its contents (e.g. the contents of a 

directory, a text file or an image) on the screen. Windows are one of the elements 

that comprise a graphical user interface (GUI). 

Task Bar 

The taskbar displays opened files, folders, and programs. When multiple windows 

are open, you can click on the file, folder or program buttons in the taskbar to switch 

between windows. 

 

Fig. Task Bar 

List of components of tasks bar 

1. Start button 

2. Quick launch bar 

3. System trays with some programs 

4. Time bar 

For example, all documents using the same extension have the same icon. Some 

folders can have a customized icon applied to them. The name of file, folder or 
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program is displayed under the icon. 

Computer 

Computer folder displays all hard disk drives and removable storage devices 

connected to your computer. Double-clicking on a drive or removable storage 

device displays its contents. 

Fig. Computer 
To open the computer Folder 

1. Click on start Icon>Computer or double-click on the Computer icon. 

Documents 

Documents folder provides a place to store all of your files. When you save a 

document, the default save location is the Documents folder: 

Fig. Documents 
To open the Documents Folder 

1. Click Start>Documents or Double-Click. 

2. Networks 

3. The Networks folder displays all the shared resources connected to your 

computer by a network. 

Networks 

The Networks folder display all the shared resources connected to your computer 

by a network. 

Fig. Networks 
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To open the Network Folders 

1. Click start>Networks or Double-click on the Networks. 

Recycle Bin 

When you delete a program, file or folder, it is moved to the Recycle Bin. The 

Recycle Bin gives you the opportunity of retrieving your deleted items later if you 

change your minds. Items in the Recycle Bin still take up hard disk space. 

Fig. Recycle bin 

When the Recycle Bin is full, Windows automatically cleans out enough space to 

accommodate the newest deleted items. By default, the Recycle Bin is located on 

your desktop. 

To restore items from the Recycle Bin 

1. Double-click on the Recycle Bin on the desktop. This opens the Recycle Bin 

windows. 

2. Select the items you want to restore. 

3. Click the Restore this item link in the Recycle Bin Tasks area. 

Music 

By default, the Music folder is situated in the Libraries folder. When you use 

Windows Media Player to copy music from a CD or download music from the 

Internet, the default save location is the music folder. 

Fig. Music 

To open the Music folder: 

1. Click start>Music. 
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Pictures 

By default, my pictures folder is situated in the libraries folder. When you save 

pictures from your digital camera or scanner to your computer or save a file in a 

graphics program, such as Microsoft Paint, the default save location is the pictures 

folder. 

 
To open the Pictures folder: 

1. Click start>My pictures. 

2. Working with files and folders 

Folder 

Folders on a computer provide a storage system similar to folders in a filing cabinet. 

Folders can contain files and other subfolders. Windows provides a number of 

personal folders to start your computer filing system. A folder is typically 

represented by a folder icon. The folder name is the icon. The folder in Windows is 

also known as a directory in DOS. 

 

Creating the personal folder on the desktop 

1. Right click on the desktop. 

2. Select New>folder. 

3. Give the name of the folder then press enter. 

Alternative way to create the personal folder 

1. Click on the file>folder. 

2. Give the name of the folder then press enter. 
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Operating a file or folder 

1. Double-click on the file or folder you want to open. 

2. The file or folder is displayed in a window. 

To copy or cut files and folders 

1. Right click on the file or folder you want to copy or cut. 

2. From the pop-up menu, Select Copy or cut. 

3. Open the location you want the copied or cut item to be placed. 

4. Right-click in the location. 

5. From the pop-up menu, select paste. 

To rename files and folders 

1. Right-click on the file or folder you want to rename. 

2. From the pop-up menu, select rename. 

3. Type a new name. 

4. Press the Enter key on your keyboard. 

To delete a file or folder location in a folder 

1. Select the file or folder you want to delete. 

2. Right, click on the file or folder you want to delete. 

3. From the pop-up menu, select Delete. 

OR 

1. Select the file or folder you want to delete. 

2. Press the Delete key on your keyboard. 

Changing File and Folder Views: 
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Fig. Changing file and folder views 

To change how the files and folders within a folder are viewed 

1. Click the Change your Views option. 

2. Select the file and folder view you want. 

Display File and Folder Properties 

Files and folders have property sheets that include information such as the type, 

size and location of file or folder; the data of a file or folder was created, modified 

or accessed; file and folder attributes; the name of the program that opens a file and 

the number of files or subfolders contained in a folder. 

To display properties for files and folders within a folder window: 

1. Select the file or folder (in the folder window) for which you want to display 

properties. 

2. Right –click on the file or folder for which you want to display properties. 

3. From the pop-up menu, select properties. 

Modifying Folder Options 

1. Open the folder for which you want to modify. 

2. Select Organize> Folder and Search Options. 

3. This opens the folder Options dialog box. 
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4. Make the folder modifications you want 

5. Click OK. 

Using Task Panels 

Task panels provide an easy way to access the most commonly used folder tasks. 

The task panel displays a list of hyperlinked tasks to the left of the folder contents. 

 

Fig.Using task panel 

Several folders offer additional specialized hyperlinked tasks. For example, the 

pictures and Music folders offer links that help you manage your picture and music 

files. The recycle bin offers links to empty the Recycle Bin or restore items from 

Recycle Bin. 

Computer folders offer links to view system information, add or remove programs, 

and change system settings. 

Searching Files/ folders using search companion 

 
Fig. Searching files and folders 

Enhanced for Windows 7, the Search Companion is designed to help you quickly 

find what you`re looking for. 

1. Click start Icon 

2. Type whatever you want to search. 

3. Working with a Windows Application Program 
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Customizing the Desktop 

By default, the Windows theme is applied the first time you start Windows. A 

desktop theme affects the whole look of your desktop. 

 

Fig. Customizing the desktop 

To apply a desktop theme 

1. Right click a desktop. 

2. From the pop-up menu, select personalize. This opens the Personalization 

dialog box. 

3. Select a theme from the Theme option. 

To apply a desktop background 

1. Right click on the Desktop. 

2. From the pop-up menu, select Personalize. This opens the Personalization 

dialog box. 

3. Click the Desktop Background option. 

4. Select a background from Background list. 
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5. Click on Save Changes. 

Control Panel 

As you`ve read earlier Control panel is one of the most important system folders, 

which consist of various controlling program`s icon to control an overall operation 

of the Windows. The following is the Sample of Control panel. 

 
Fig. Control panel 

Date and Time 

With the help of this option, we can change / set our system date and time as we 

need. 
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Display 

This option is to customize the Desktop environment. 

Keyboard 

We can set keyboard settings like its character repetition and cursor blinking rate, 

a width of the cursor. 

Program and Features 

This option allows the user to do following things; 

Allows users to uninstall and change existing software packages, as well as 

indicating how much space individual programs take and how frequently they are 

used. 

1. Allows users to manually install software and install add-ons from Windows 

Update. 

2. Allows users to change which Windows components are installed. 

Administrative Tools 

This option contains tools for system administration, including security, 

performance, and service configuration. These are the links to various 

configurations of the Microsoft Management Console such as the local services list 

and the Even Viewer. 

Windows Update 

This option is used to specify how the automatic updates client should download 

updates from Microsoft update website, by default this is set to download and install 

daily. 

Windows Keyboard Shortcuts 

Use shortcut keys as an alternative to the mouse when working Windows. You can 

open, close and navigate the Start menu, desktop, menus dialogue boxes and Web 

pages using keyboard shortcuts. It makes users use Windows easy. 
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3.5. Open sources operating system 

Open-source software (OSS) is a type of computer software whose source code is 

released under a license in which the copyright holder grants users the rights to 

study, change, and distribute the software to anyone and for any purpose. Open-

source software may be developed in a collaborative public manner. According to 

scientists who have studied it, open-source software is a prominent example of open 

collaboration. The term is often written without a hyphen as "open source software".  

Open-source software development, or collaborative development between 

multiple independent contributors, generates an increasingly more diverse scope of 

design perspective than any one company is capable of developing and sustaining 

long term. 

Advantages of open source software 

1. These software are freely available and no license is required to use them. 

2. Source code of these software is freely available in the internet and it can be 
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easily downloaded. 

3. It has freedom at work. Everyone is free to modify the software according to 

the requirement from its source code. 

4. The OSS allows to take our own security ownership. 

5. There is no restriction of law to use them. 

6. By adopting open source software, we become part of a community of users 

and developers. 

Introduction to Linux 

Linux is a free open-source operating system based on Unix. Linux was originally 

created by Linus Torvalds with the assistance of developers from around the globe. 

Linux is free to download, edit and distribute. Linux is a very powerful operating 

system and it is gradually becoming popular throughout the world. 

Advantages of Linux 

Low cost: There is no need to spend time and huge amount money to obtain licenses 

since Linux and much of it's software come with the GNU General Public License.  

Stability: Linux has high stability compared with other operating systems. There is 

no need to reboot the Linux system to maintain performance levels.  

Performance: Linux provides high performance on various networks. It has the 

ability to handle large numbers of users simultaneously. 

Networking: Linux provides a strong support for network functionality; client and 

server systems can be easily set up on any computer running Linux. It can perform 

tasks like network backup faster than other operating systems. 

Flexibility: Linux is very flexible. Linux can be used for high performance server 

applications, desktop applications, and embedded systems.  

Compatibility: It runs all common Unix software packages and can process all 

common file formats. 

Fast and easy installation: Linux distributions come with user-friendly 

installation. 

Security: Linux is one of the most secure operating systems. File ownership and 
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permissions make linux more secure. 

Open source: Linux is an Open source operating systems. You can easily get the 

source code for linux and edit it to develop your personal operating system. 

Today, Linux is widely used for both basic home and office uses. It is the main 

operating system used for high performance business and in web servers. Linux has 

made a high impact in this world. 

Introduction to UNIX 

The Unix operating system is a set of programs that act as a link between the 

computer and the user.The computer programs that allocate the system resources 

and coordinate all the details of the computer's internals is called the operating 
system or the kernel. Users communicate with the kernel through a program 

known as the shell. The shell is a command line interpreter; it translates commands 

entered by the user and converts them into a language that is understood by the 

kernel. Unix was originally developed in 1969 by a group of AT&T employees Ken 

Thompson, Dennis Ritchie, Douglas McIlroy, and Joe Ossanna at Bell Labs.There 

are various Unix variants available in the market. Solaris Unix, AIX, HP Unix and 

BSD are a few examples. Linux is also a flavor of Unix which is freely available. 

 Several people can use a Unix computer at the same time; hence Unix is called 

a multiuser system. 

 A user can also run multiple programs at the same time; hence Unix is a 

multitasking environment. 

SUMMARY 

 An operating system is a kind of system software that controls and co-

ordinates the overall operations of the computer system. 

 The processors communicate with one another through various 

communication lines (such as high-speed buses or telephone lines). These are 

referred as loosely coupled systems or distributed systems. 

 A Network Operating System runs on a server and provides the server the 

capability to manage data, users, groups, security, applications, and other 

networking functions. 



90 Computer Application : Grade 9 

 Real-time operating systems are used to control machinery, scientific 

instruments and industrial systems. 

 As the name implies, this operating system is designed to manage the 

computer so that one user can effectively do one thing at a time. The Palm 

OS for Palm handheld computers is a good example of a modern single-user, 

single-task operating system. 

 A multi-user operating system allows many different users to take advantage 

of the computer's resources simultaneously. 

 In a multiprogramming system there are one or more programs loaded in main 

memory which are ready to execute. 

 Multitasking has the same meaning of multiprogramming but in a more 

general sense, as it refers to having multiple (programs, processes, tasks, 

threads) running at the same time. 

 Stands for "Disk Operating System." DOS was the first operating system used 

by IBM-compatible computers. It was originally available in two versions 

that were essentially the same, but marketed under two different names. "PC-

DOS" was the version developed by IBM and sold to the first IBM-

compatible manufacturers. "MS-DOS" was the version that Microsoft bought 

the rights to, and was bundled with the first versions of Windows. 

 CUI is a traditional user interface. It provides the interactive terminal where 

user can enter the command to interpret. 

 A file is systematic collection of related data or information or program 

instructions. 

 A directory is a location for storing files on your computer. 

 Wild card character, a wildcard is a symbol used to replace or represent one 

or more characters. Wildcards are typically either an asterisk (*), which 

represents one or more characters or question mark (?), which represents a 

single character. 

 In windows operating system, we can give commands to the computer by 

clicking on icons, menus and buttons by using a mouse. 

 With advancement of technology, computer system has become quicker and 
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cheaper. Operating environment has also changed. This lead the development 

of graphical user interface where users can interact with the computer using 

picture and graphs, rather than character and commands. It displays the icon, 

buttons, dialog box etc. Popular GUI based operating system is Microsoft 

Windows. 

 The desktop is the background displayed on your computer screen. 

 The start menu provides access to the most useful items on your computer 

including all programs, most recent documents, help and support and other 

items on your computer. 

 Icons are the small graphical image used in GUI OS environment. 

 Windows are frames on the desktop that contains the contents of opened files, 

folders, and programs. 

 The taskbar displays opened files, folders, and programs. 

 When you delete a program, file or folder, it is moved to the Recycle Bin. 

 Folders on a computer provide a storage system similar to folders in a filing 

cabinet. 

 Open-source software (OSS) is a type of computer software whose source 

code is released under a license in which the copyright holder grants users the 

rights to study, change, and distribute the software to anyone and for any 

purpose. 

 Linux is a free open-source operating system based on Unix. Linux was 

originally created by Linus Torvalds with the assistance of developers from 

around the globe. 

 The Unix operating system is a set of programs that act as a link between the 

computer and the user. 

Self Evaluation 

1. Write very short answer to the following question. 

1. Where is open source software available for user? 

2. Is Unix a single user operating system? 

3. Which file of Ms Dos contains all internal commands? 
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4. Which wild card symbol indicates single characters? 

5. Write one example of GUI operating system besides windows. 

6. What is file? 

7. What is directory? 

2. Write short answer to the following question. 

1. Write the features of OSS. 

2. What is an operating system? Write two examples. 

3. What are the basic functions of an operating system? List any four of 

them. 

4. What is single user operating system? Write two examples. 

5. What is MS DOS? Write its two features. 

6. What are wild cards? Write some wildcard characters. 

7. Distinguish between GUI and CUI? 

8. What is Linux? Write its advantages. 

3. Write long answer to the following question. 

1. Explain the types of operating system. 
2. Why is GUI operating software more popular than CUI give reasons 

these days? Discuss. 
3. What is windows operating system? Explain. 
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Unit: 4 

Programming Languages 
 

Learning Outcomes 

After completion of this unit you will be able to  

 explain/describe programming languages 

 explain/describe type of language processing software 

 explain/describe high level programming language 

 explain/describe program control structures 

 explain/describe program design tools, and 

 explain/describe QBASIC 

4.1. Introduction of Programming Language 

Programming 

The method used to develop a solution or a program is called programming. It is 

the way of writing program using specific computer language to perform specific 

task. 

Computer Language(Code) : The set of codes which is used to write computer 

program is called computer language . It is artificial language and can be used to 

define a sequence of instructions that can ultimately be processed and executed by 

the computer. 

Source program(Code) : The original program written in high level language is 

called source program. It should be translated into machine code, so that computer 

understands and responses it. 

Object Program(Code) : The program converted into machine code by compiler 

is called object program. 

Types of computer language 

Machine level language 

The program written using machine code or binary numbers (0 and 1) is called 
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machine level language. It is computer’s own binary-based language, or machine 

language which is difficult for human beings to use. It is machine dependent 

complicated and time consuming. It is also called first generation language. 

Assembly language 

The language which permits the use of mnemonics (which are combination of codes 

and English phrases) for each instruction that machine can do is called low level 

language. It remains in between machine level language and high level language. It 

is easier than machine level language and should be translated into machine code 

using assembler. It is also called second generation language. Example pseudo 

programming. 

Advantages of low level language 

I) The computation time of an assembly language program is less. 

II) Program debugging is easier. 

Disadvantages of low level language 

I) It is machine dependent. 

II) Too difficult to learn and implement. 

Bug and Debug 

Any type of error in the program is called bug. The process of correcting bugs is 

called debug. 

High level language 

The language which uses plain English words or phrases and mathematical 

notation, following the correct syntax (Certain rules which are followed to write 

programs) is called high level language. It should be translated into machine code 

using compiler or interpreter. So they are slower. It is also called third generation 

language. Example: QBASIC, C, C++, LOGO, LISP, ADA, PASCAL etc. 

Advantages of high level language 

 It is very simple because plain English words are used for programming. 

 There are pre-defined commands, which minimize the work of programmers. 

 All the commands are syntax driven, so they are very easy to learn and 
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implement. 

Features of high level language: 

 It is machine independent and problems oriented. 

 It does not require extensive mathematics knowledge and computer hardware 

knowledge. 

 It requires less time to learn and write the programs. 

 Provide better implementation and documentation. 

4GL: Fourth-generation language (4GL): 

Fourth-generation computer programming language (4GL) are closer to human 

language than other high-level languages and are accessible to people without 

formal training as programmers. They allow multiple common operations to be 

performed with a single programmer-entered command. They are intended to be 

easier for users than machine languages (first-generation), assembly languages 

(second-generation), and older high-level languages (third-generation). 

A 4GL normally contains utility software (tool) that interacts with the database 

management system (DBMS) software to store, manipulate and retrieve data 

needed to satisfy user requirements for information. 

Merit of 4GL 

1. Programming productivity is increased. One line of 4GL code is equivalent 

to several lines of 3GL code. 

2. System development is faster. 

3. Program maintenance is easier. 

4. The finished system is more likely to be what the user envisaged, if a 

prototype is used and the user is involved throughout the development. 

5. End user can often develop their own applications. 

6. Programs developed in 4GLs are more portable than those developed in other 

generation of languages. 

7. Documentation is improved because many 4GLs are self documenting. 
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Demerit of 4GL 

1. The programs developed in the 4GLs are executed at a slower speed by the 

CPU. 

2. The programs developed in these programming languages need more space 

in the memory of the computer system. 

4.2. Types of language processor software 

Language processor: The set of program codes, which are used to translate 

program written in high level language or low level language into machine code, is 

called language processor. There are three types of language processor. 

 Interpreter : The language processor which converts High level language 

and Low level language into machine code is called interpreter. It translates 

programming codes line by line so it is slower than compilers and assemblers. 

 Compiler : The language processor which translates the program written in 

high level language into machine code is called compiler. 

 Assembler : The language processor which translates the program written in 

low level language into machine code is called assembler. 

4.3. List of high level programming language 

Fortran 

It is a procedural, imperative, general purpose computer programming language 

that works well for scientific computations and numeric operations. After IBM 

developed it in the 1950s, it soon gained popularity in programming. It is very 

popular in the field of high-performance computing. It is a structured and compiled 

programming language that is a subset of Fortran95. Fortran 2003, a revised version 

of Fortran supports object-oriented programming. 

COBOL 

The name stands for Common Business-Oriented Language that is designed for the 

business and finance domain. COBOL 2002 standard supports object-oriented 

programming. It is one of the very old programming languages that are still in use. 
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BASIC 

Developed by John George Kemeny and Thomas Eugene Kurtz at Dartmouth in 

1964, it is an acronym for Beginner’s All-purpose Symbolic Instruction Code. It 

was designed with the intent of giving the non-science people an access to 

computers. 

Pascal 

It is a procedural programming language that was intended to use data structuring 

and structured programming. Niklaus Wirth, a Swiss computer scientist designed 

this language and it was named after Blaise Pascal, a French mathematician and 

philosopher. 

C 

Dennis Ritchie at the Bell Telephone Laboratories developed C to be used on the 

Unix platform. It is a general-purpose, cross-platform, procedural, imperative 

programming language. It is used for implementing system software and 

application software and is one of the most-used computer programming languages 

today. The development of C++ and C# was influenced by C. 

C++ 

It consists of a combination of high-level and low-level language features and is 

hence considered as a middle-level programming language. Bjarne Stroustrup of 

Bell Labs developed C++ as an extension of the C language. Originally known as 

‘C with Classes’, it came to be known as C++ from 1983. It is a multi-paradigm 

language that supports procedural programming, generic programming, object-

oriented programming, and data abstraction. 

C# 

C Sharp is a multi-paradigm programming language that supports imperative, 

generic and object-oriented programming. It is a part of the Microsoft .NET 

Framework. It is similar to C++ in its object-oriented syntax and is also influenced 

by Java and Delphi. 
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Java 

It is a general-purpose computer programming language that is concurrent, class-

based, object-oriented, and specifically designed to have as few implementation 

dependencies as possible. Compiled Java code can run on all platforms that support 

Java without the need for recompilation. It is a very popular language of the modern 

times. 

Visual Basic 

It is an event-driven programming language that is packaged with an integrated 

development environment. It inherits many of its features from BASIC. Its 

graphical development features make it easy for beginners to learn VB. 

Visual FoxPro 

It is an object-oriented and procedural programming language derived from FoxPro. 

It is integrated with a relational database system of its own and does not require an 

additional programming environment. It supports dynamic programming. 

XML 

The name stands for Extensible Markup Language. It is extensible because it allows 

the users to define their own XML elements. It supports the sharing of structured 

data over the Internet and the encoding and serializing of data. It originated as a 

subset of SGML. 

PHP 

PHP is one of the very popularly used general purpose scripting languages. It is 

developed for creating dynamic web pages and supports a command line interface 

capability. 

4.4. Difference between Program and Software: 

SOFTWARE-Software are made up of two or more than two programs. 

It instructs computer processor to perform specific operation . 

(In simple words it gives instruction or data to computer processor(CPU). .) 

PROGRAMS- A computer program is a collection of instructions that performs a 
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specific task when executed by a computer. A set of instruction tells a computer 

what to do (instruction is in the form code .binary.) 

A software can be program but a program can not be software. 

Software typically consists of files while programs can be files or even notes. 

4.5. Program Control Structures 

The structures which regulate the order in which program statements are executed 

are called Control Structures. There are 3 types of control structure. They are: 

Sequence 

It is the set of program instructions which follow one another and are to be executed 

unconditionally (not dependent on any program conditions). Instructions are put in 

a predefined sequence (just like a queue in a cinema hall) and the next instruction 

is executed by CPU only after the execution of the previous instruction (C never 

comes before B). 

Selection 

It is the set of instructions which are to be executed conditionally i.e. they are 

executed based on a condition that can be either true or false. Commonly used logic 

for selection are if condition, if else condition, if else if condition, nested if else 

condition and switch case condition. 

If condition 

If condition is used in case the given problem has only one condition and only one 

action. Considering either true or false part, if the given condition is true then the 

statement will be executed. Otherwise, the control exits from the condition. 

else If condition 

This condition is used if the problem has one condition but two alternative actions. 

Here, if the condition is true, statement 1 will be executed; otherwise, statement 2 

will be executed.  

Iteration 

These are the computer instructions which are to be performed repeatedly and 
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conditionally i.e. loop statements are driven by the loop condition. Commonly used 

logic for iteration are while loop, do while loop and for a loop. 

While loop 

In this loop, first, the condition is checked by the computer and if the condition 

turns out to be true, then the statement inside the loop is executed. This process is 

repeated and the value of increment and decrement operator is always changing. 

When the condition is false, the loop stops. 

Algorithm Syntax 

Initialization 

while (condition) 

{ 

statements 

………………. 

………………. 

increment/decrement 

} 

Do while loop 

In this loop, first, the computer checks the initial value; second executes the 

statements inside the loop and finally, checks the condition. The process is repeated 

for next pass, if the condition is true. Otherwise, the loop stops. If the condition is 

initially false, it will execute for at least one time. 

Algorithm Syntax 

Initialization 

do { 

statements 

……………….. 

……………….. 

increment/ decrement 
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} while (condition) 

For loop 

It is the most commonly used loop. It consists of 3 expressions; initialization, 

condition and counter, which are defined within a statement. 

Algorithm Syntax 

for (initialization; condition; counter) 

{ 

statements 

………………. 

………………. 

} 

Where, initialization is starting point, the condition is stopping point and increment/ 

decrement is a counter. 

4.6. Program design tools 

Also known as the Programming tools, Program Design tools are the tools used to 

develop a program. During designing a program, different tools are required to 

solve several problems. Some of the frequently used tools are: 

1. Algorithm 

An algorithm is a sequence of instructions or step by step instruction to find the 

solution of a problem. An algorithm should be simple and clear. It must be to the 

point and should lead to the solution of the problem in a finite number of steps. 

An algorithm is a collection of a finite number of instructions arranged in a 

sequence to find the solution of a problem. 

Example 1: Algorithm for adding the two numbers. 

Step 1: Start the program 

Step 2: Input number x, y 
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Step 3: Read x, y 

Step 4: Z = x + y 

Step 5: Print Z 

Step 6: Stop the program 

Example 2: An algorithm to go to the cinema and see a movie. 

Step 1: Start the program  

Step 2: Go to the cinema hall  

Step 3: Is the ticket counter open? 

Step 4: If it is not open, return home 

Step 5: If it is open, buy a ticket  

Step 6: Get into the cinema hall  

Step 7: Watch the movie 

Step 8: Return home  

Step 9: End the program 

2. Flowchart 

A flowchart is a pictorial representation of an algorithm. We can also define it as a 

program planning tool for organizing a sequence of steps necessary to solve a 

problem, which is shown in terms of symbols. 

Flowchart uses symbols that have 

geometrical shapes to indicate the different 

operations. These symbols are connected by 

flow lines which indicate the order of 

execution of the various activities. It is used 

by the programmers to develop programs 

and by system, designers to represent the 

overall system while analyzing and 

developing the system. 
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Example 

The advantages of flowchart are : 

 It is an independent language. So, the flowchart we design for programming 

in one language is applicable for programming in another language. 

 Once the flowchart is prepared, it is very easy to do the coding by looking at 

the algorithm. 

 It is very easy to understand the logic of program by designing the flowchart. 

Even people who don’t know the coding can understand the logic of a 

program with the help of flowchart. 

 Systematic debugging and testing is easily possible with the help of flowchart. 

The disadvantages of flowchart are 

 Preparing a flowchart is a time-consuming process. 

 If there is a change in logic again, we have to develop the new flowchart. 

 Flowchart does not provide any convenient means to highlight the most 

important operation. 

 The flowchart is quite costly to produce and difficult to use and manage. 

 Complex and detailed charts can be laborious to plan and draw. 

Symbols for flowcharts: 

 
Fig. Basic symbol for flowchart 
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3. Structured English (Pseudo code) 

The general meaning of Pseudo code is false code or fake code. Before we write a 

real program, we write a program that looks like a code on the basis of algorithm 

and flowchart, which may not be syntactically correct but looks like a program code 

is called Pseudo code. The instruction of pseudo code is written by using English 

phrase and mathematical expression. It has no hard or fast rules for writing 

instruction but the instruction is closer to high-level language instructions. 

Therefore, the pseudo code designers should have basic knowledge about high-level 

language before writing it. It is independent of any programming language. 

Example: Pseudo code for calculating area of rectangle 

Input length, breadth 

Calculate area= length*breadth 

Output area 

4.7. Introduction to QBASIC 

Q-BASIC is a high level programming language developed by Microsoft 

Corporation, USA for microcomputers in 1985. It uses Interpreter as a language 

translator program.  It uses a set of keywords and mathematical symbols to write 

programs. The programs written in QBASIC need to be converted into machine 

codes by using Interpreter. 

4.7.1. Elements of QBASIC 

The elements used in Q basic are as follows: 

 Character set 

 Variables 

 Constants 

 Operator and Operands 

 Expression 

 Statements 
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Character Set 

QBASIC has the character set consisting of the following elements: 

1. Alphabets: A, B, C,....Z 

2. Digits: 0, 1, 2........,9 and 

3. Special characters: + - * / ( ) . , $ ; ,: ,= ,> ,< , ^ 

The symbol ^ (caret) is used to denote exponentiation operator, the symbol * 

(asterisk) is used to denote multiplication and other symbols which have their usual 

meanings. 

Constants 

A quantity in a computer program which does not change its value during the 

execution of the program is called a constant. QBASIC allows the following 

constants: 

Numeric constant 

The numeric constant is one that is formed by a sequence of digits 0, 1, 2,.....9 and 

may include a decimal point. A numeric constant may be an integer or a real 

number. 383, +57, 0, -6.2 and 6.15E4 are valid numeric constants. The number 

6.15E4, in fact, represent 6.15 * 104. The notation E is used to represent the 

exponential form. The number after E is the exponent which can be positive or 

negative. However, its length cannot exceed two digits. 

String constant 

A string constant consists of a sequence of characters which must be enclosed by a 

quotation mark. 

Variables 

The quantity which may change its values during the execution of the program is 

called the variable. 

In QBASIC, variables are also of two types 

 Numeric variable: Numeric variable can assume numeric value and is 

represented by an alphabet or an alphabet followed by another alphabet or 
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digit. For example A, C, A2, ABC, A6 etc, represent numeric variables. 

 String variable: A string variable is represented by an alphabet followed by 

dollar ($) sign. It should be kept in mind that while constructing the string 

variable, dollar ($) should be the last character. For example, B1$, NAME$, 

BOOK1$, etc are valid string variables. 

Expression 

An expression can be a string, or numeric constant, a variable or a combination of 

constants, variables with operators which return a single value. 

Operands 

Operands are the data or variables on which mathematical, logical and string 

operations take place. 

Operators 

Operators are the symbols, which are used to perform specific task such as 

arithmetic operations, logical expressions, and string expressions. 

Statements 

A statement is a set of instructions written using keywords or commands of 

QBASIC. Every programming language uses keywords as a statement with certain 

syntax. 

4.7.2. QBASIC Statement 

A statement (for the QBASIC) is a set of instructions written by using keywords or 

commands of QBASIC. Every programming language uses keywords as a 

statement with certain syntax. The keywords have specific meaning in the QBASIC 

programming. The statements are the first stored in the memory and executed only 

when the RUN command is given. 

The different types of statements used in QBASIC are as follows: 

 Declaration statement 

 Assignment statement 

 Input/output statement 
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 Control statement 

4.7.2.1 Declaration Statement 

The statements which are used to define and declare the values, variables, constants 

etc for programming purpose are known as declaration statement. The declaration 

statements are DIM, REM, CONST, DECLARE etc. 

REM Statement 

It is a basic declaration statement that allows explanatory remarks to be inserted in 

a program. The remarks may be useful in a program to explain about different kinds 

of statements and user defined words. Adding comments in the program allows us 

to remind about the program and also helps other programmers to understand the 

logic of the program. 

Syntax: REM < Remarks> 

CONST  Statement 

The statement declares one or more symbolic constants in program. 

Syntax CONST constantname = expression [,constantname = expression]... 

Constant 
name 

The name of the constant. This name can consist of up to 40 
characters and must begin with a letter.  
Valid characters are A-Z, 0-9, and period (.). 

expression An expression that is assigned to the constant can consist of 
literals (such as 1.0), other constants, any arithmetic or logical 
operators except exponentiation (^), or a single literal string. 

 

Example CONST PI = 3.141593 

DIM Statement 
DIM declares an array or specifies a data type for a non array variable.  

Syntax 
Example 
CLS 
Const pi = 3.14 
Dim r as single 
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Dim a as single 
r = 5 
a= pi *r^2 
PRINT "area of circle ="; a 
END 

DIM [SHARED] variable [(subscripts)] [AS type] [, variable[(subscripts)] 
[AS type]]... 
SHARED Specifies that variables are shared with all SUB or 

FUNCTION 
 procedures in the module. 

Variable The name of an array or variable. 

Subscripts Dimensions of the array, expressed as follows: 

 [lower TO] upper [,[lower TO] upper]... 

 lower The lower bound of the array's subscripts. 
The default lower bound is zero. 

 upper The upper bound. 

AS type 
Declares the data type of the array or variable  
(INTEGER, LONG, SINGLE, DOUBLE, STRING, or a user-defined data type). 

 

4.7.2.2 Assignment Statement: 

The statements which are used to assign the value to the related variable are known 

as assignment statements. The assignment statements are Let, Swap etc. 

LET Statement 

LET is an assignment statement. It is used to assign the value to a variable. LET is 

an optional statement i.e. without using LET statement one can assign the value to 

a variable. The data type must match with the variable type otherwise type 

mismatch error will occur. 

Syntax: |LET| variable = value or expression 

Example: 
CLS 
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INPUT " First Number"; A 

INPUT "Second Number"; B 

LET S = A+B 

PRINT " The Sum is"; S 

END 
 

Read Data Statement 

It is used in conjunction with the DATA command which lets QBASIC to  read 

data. It is used mostly when dealing with large quantities of data in program. 

Example 

CLS 

READ A, B, C 

PRINT A, B, C 

DATA 15,25,35 

END 

4.7.2.3 Input/output Statement 

The statements which are used to provide input to variables of QBASIC program 

for processing and display the result as output on the screen are known as 

input/output statement. The input/output statements are : CLS, INPUT, LINE 

INPUT, PRINT, PRINT USING etc. 

CLS Statement 

The CLS statement clears the screen. If you write CLS statement in the middle of 

the program then you cannot see the outputs generated before execution of CLS 

because it clears the screen. 

Syntax: CLS 

INPUT statement 

It receives input from the keyboard during the execution of the program. 
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Syntax: INPUT [“Message”] ; Variable 

PRINT Statement 

PRINT statement provides output on the screen. It prints the values of the 

expression on the screen. If the expression list is blank, no characters are printed. 

The expressions in the list may be numeric or string. In case of number, the negative 

number is preceded by a minus sign (-) but in positive number it is preceded by a 

space. 

We can use semicolon and comma with a print statement which results differently 

than a normal PRINT statement. If expression list ends with comma or semicolon, 

the next PRINT statement prints on the same line. Comma provides a TAB space 

but semicolon provides only one space. 

Syntax: PRINT ["Message"]; expression 

Example 
CLS 

PRINT "We live in Nepal." 

PRINT 

PRINT "Nepal lies in between India and China." 

PRINT 2076 

PRINT " The number is: "; 7 

END 

Output 
We live in Nepal. 

Nepal lies in between India and China. 

2076 

The number is: 7 

LINE INPUT 

This statement allows inputting line of data at a time and assigning in to single 

variable. 
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Syntax: LINE INPUT “string”; string variable 

Example 

CLS 

LINE INPUT “please enter the data”; n$ 

PRINT n$ 

END 

4.7.2.4 Control Statement 

The statements which are used to transfer the control of program from one part to 

another part with or without condition are known as control statements. The control 

statements are IF THEN, SELECT CASE, FOR NEXT, DO LOOP, ON GOTO etc. 

GOTO Statement 

The GOTO is a jumping statement which jumps from one point to another point 

within program. It is used to transfer the control from one point of the program to 

another point without testing a condition. The GOTO statement is marked by label 

statement. It sends the controls to the labeled block and starts executing. 

Syntax: GOTO <label / line number> 

Where label is a name followed by a colon. 

Example 

CLS 

INPUT "ENTER YOUR AGE"; A 

IF A>18 THEN GOTO TEST1 ELSE GOTO TEST2 

TEST1: 

PRINT "YOU ARE ELIGIBLE FOR VOTE" 

GOTO LAST 

TEST2: 

PRINT "YOU ARE NOT ELIGIBLE FOR VOTE" 

LAST: 

END 
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If – Then Statement 

When there is a single option to be executed on the basic of true result of a 

condition, then ' if – then –end if ' statement used. So, there is a test for a condition 

in 'if – then' statement and if the result of the condition is found to be 'TRUE', then 

the statement of 'If- Then' block is executed and if the result of the condition is 

FALSE, then there is no statement to execute. In such case, simply the program 

execution goes to the line below the END IF statement. So, it performs when the 

condition is only TRUE. 

Syntax 

If [condition] then 

 Block of statements 

End If 

Example: 

Cls 

Input"Enter your age"; a 

If a<=10 then 

Print "Child" 

End if  

End 

If Then Else Statement 

When there is a need to select an option to be executed out of two options on the 

basis of two conditions, the 'if – then – else statement is used but the second 

condition is seldom checked. So, there is a test for a condition in if – then – else ' 

statement and if the result of the condition is found to be true, then the block of 

statement associated with 'if' part is executed otherwise the block of statement 

associated with 'Else" part is executed. There is no chance to execute both if and 

else part within a single if – then – else statement. 
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Syntax 

If [condition] then  

Block 1 of statements 

Else 

Block 2 of statements 

End if 

Example 

CLS 

INPUT "ENTER A NUMBER"; N 

IF N MOD 2 = 0 THEN 

PRINT "EVEN NUMBER" 

ELSE 

PRINT "ODD NUMBER" 

END IF 

END 

If  Then Elseif Statement 

When there is a need to select an option to be executed out of multiple options on 

the basis of multiple conditions, the 'if – then – elseif statement is used. If none of 

condition is  true, then statement associated with 'else' part is executed. 

Syntax 

If [condition1] then  

Block 1 of statements 

Elseif [condition2] then 

Block 2 of statements 

Elseif[condition3] then 

Block 3 of statements 

……………………. 
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…………………… 

……………………. 

Else 

Block 'n' of statements 

End if 

Example 

REM POSITIVE, NEGATIVE OR NEUTRAL NUMBER 

CLS 

INPUT "ENTER A NUMBER"; N 

IF N > 0 THEN 

PRINT "POSITIVE NUMBER"; N 

ELSEIF N<0 THEN 

PRINT "NEGATIVE NUMBER"; N 

ELSE 

PRINT "NEUTRAL NUMBER"; N 

END IF 

END 

Select… Case...  Statement 

Select case is also the multiple branching statements. It is used to executed one of 

several statement blocks depending on the value of an expression. 

Syntax 

Select case test_expression 

Case test1 

Statements 

Case test 2 

Statement 

Case Else 
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Statement 

End Select 

 

Example 

CLS 

INPUT "ENTER AGE OF A PERSON"; A 

SELECT CASE A 

CASE 1 TO 12 

 PRINT"CHILD " 

CASE 13 TO 19 

 PRINT"TEENAGE " 

CASE 1 TO 12 

 PRINT"CHILD " 

CASE 20 TO 40 

 PRINT"YOUNG " 

CASE 41 TO 70 

 PRINT"OLD " 

END SELECT 

END 

FOR NEXT Statement 

Repeats a group of statements a specified number of times. 

Syntax 

For counter = start To end [Step step] 

    [statements] 

    [Exit For] 

    [statements] 

Next 

The For...Next statement syntax has these parts: 
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Part Description 

Counter Numeric variable used as a loop counter. The variable can't be 

an array element or an element of a user-defined type. 

Start Initial value of counter. 

End Final value of counter. 

Step Amount counter is changed each time through the loop. If not 

specified, step defaults to one. 

statements One or more statements between For and Next that are executed the 

specified number of times. 
 

Remarks 

The step argument can be either positive or negative. The value of 

the step argument determines loop processing as follows: 

Value Loop executes if 

Positive or 0 counter <= end 

Negative counter >= end 
 

Once the loop starts and all statements in the loop have executed, step is added 

to counter. At this point, either the statements in the loop execute again (based on 

the same test that caused the loop to execute initially), or the loop is exited and 

execution continues with the statement following the Next statement. 

Example 

REM DISPLAY FROM 1 TO N NUMBER 

CLS 

INPUT " ENTER THE VALUE OF N"; N 

FOR I =1 TO N 

PRINT I; 

NEXT I 

END 
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Write a program to display Fibonacci series 2,2,4,6,10,16,…, up to 10th terms. 

CLS 

A=2 

B=2 

FOR J=1 to 10 

       PRINT A; 

       C=A+B 

       A=B 

       B=C 

NEXT J 

END 

  

Write a program to display the reverse word for any entered word by a user. 

CLS 

INPUT “Enter any word”;n$ 

FOR j=LEN(n$) TO 1 STEP -1 

       C$=MID$(n$,j,1) 

       Rev$=Rev$+C$ 

NEXT j 

PRINT “The reverse word is ”;Rev$ 

END 

 

Write a program to find the greatest number among any 10 numbers entered 
by a user using an array. 

CLS 

OPTION BASE 1 

DIM n(10) 

PRINT “Enter any 10 numbers” 

FOR j=1 TO 10 
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       INPUT n(j) 

NEXT j 

FOR k=1 TO 10 

       IF n(k)>g THEN g=n(k) 

NEXT k 

PRINT “The greatest number is ”;g 

END 

 

SUMMARY 

 The method used to develop a solution or a program is called programming. 

It is way of writing program using specific computer language to perform 

specific task. 

 The set of codes which is used to write computer program is called computer 

language. 

 The original program written in high level language is called source program. 

 The program converted into machine code by compiler is called object 

program. 

 The program written using machine code or binary numbers (0 and 1) is called 

machine level language. 

 The language which permits the use of mnemonics (which are combination 

of codes and English phrases) for each instruction that machine can do is 

called low level language. 

 The language which uses plain English words or phrases and mathematical 

notation, following the correct syntax (Certain rules which are followed to 

write programs) is called high level language. 

 Fourth-generation computer programming language. 4GLs are closer to 

human language than other high-level languages and are accessible to people 

without formal training as programmers. 

 The set of program codes, which are used to translate program written in high 

level language or low level language into machine code, is called language 
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processor. 

 The language processor which converts High level language and Low level 

language into machine code is called interpreter. 

 The language processor which translates the program written in high level 

language into machine code is called compiler. 

 The language processor which translates the program written in low level 

language into machine code is called assembler. 

 Developed by John George Kemeny and Thomas Eugene Kurtz at Dartmouth 

in 1964, it is an acronym for Beginner’s All-purpose Symbolic Instruction 

Code. It was designed with the intent of giving the non-science people an 

access to computers. 

 PHP is one of the very popularly used general purpose scripting languages. It 

is developed for creating dynamic web pages and supports a command line 

interface capability. 

 Software are made up of two or more than two programs. 

 Software are made up of two or more than two programs. 

 A computer program is a collection of instructions that performs a specific 

task when executed by a computer. 

 The structures which regulate the order in which program statements are 

executed are called Control Structures. There are 3 types of control structure. 

 Program Design tools are the tools used to develop a program. During 

designing a program, different tools are required to solve several problems. 

 An algorithm is a sequence of instructions or step by step instruction to find 

the solution of a problem. 

 A flowchart is a pictorial representation of an algorithm. 

 The instruction of pseudo code is written by using English phrase and 

mathematical expression. 

 Q-BASIC is a high level programming language developed by Microsoft 

Corporation, USA for microcomputers in 1985. It uses Interpreter as a 

language translator program.  It uses a set of keywords and mathematical 

symbols to write programs. 
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 A quantity in a computer program which does not change its value during the 

execution of the program is called a constant. 

 The quantity which may change its values during the execution of the 

program is called the variable. 

 An expression can be a string, or numeric constant, a variable or a 

combination of constants, variables with operators which return a single 

value. 

 Operands are the data or variables on which mathematical, logical and string 

operations take place. 

 Operators are the symbols, which are used in arithmetic operations, logical 

expressions, and string expressions. 

 A statement is a set of instructions written using keywords or commands of 

QBASIC. Every programming language uses keywords as a statement with 

certain syntax. 

 The statements which are used to define and declare the values, variables, 

constants etc for programming purpose are known as declaration statement. 

The declaration statements are DIM, REM, CONST, DECLARE etc. 

 The statements which are used to assign the value to the related variable are 

known as assignment statements. The assignment statements are Let, Swap 

etc. 

 The statements which are used to provide input to variables of QBASIC 

program for processing and display the result as output on the screen are 

known as input/output statement. The input/output statements are : CLS, 

INPUT, LINE INPUT, PRINT, PRINT USING etc. 

 The statements which are used to transfer the control of program from one 

part to another part with or without condition are known as control statements. 

The control statements are IF THEN, SELECT CASE, FOR NEXT, DO 

LOOP, ON GOTO etc. 

Self Evaluation 

1. Write very short answer to the following question. 

a. Which is computer's native language? 
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b. Which codes are used by Assembly language? 

c. Write two examples of high level programming language. 

d. Which type of language is known as first generation programming 

language? 

e. Which language is used to write algorithm? 

f. Which symbol is used to put processing in flowchart? 

g. What is the extension of Q basic program file? 

h. Which key is used to run Q basic program? 

i. Which operator is used to perform addition in Q basic? 

2. Write short answer to the following question. 

a. What are the lists of high level programming language? 

b. Distinguish between program and software? 

c. What is control structure? Write its type. 

d. What are the elements of Q basic? 

e. What are the different types of Q basic statement? 

f. What is language processing software? Write its types. 

g. Differentiate between compiler and interpreter. 

h. Define term program and programming. 

i. What is programming language? Write its types. 

j. What is machine level language? Write its features. 

k. What is assembly language? Write merits of assembly language. 

l. Why is pre planning necessary before writing actual program? 

m. What is algorithm? Write algorithm to calculate area of rectangle. 

n. What are character set used in Q basic while programming? 

3. Write long answer to the following question. 

a. What is programming language? Explain machine level and assembly 

level programming language. 

b. What is high level language? Write its features. 

c. What is programming tool? Discuss the role of algorithm to design 

effective program. 
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d. Explain flowchart with the common symbols used in it. 

e. What is Q basic programming language? Discuss its features. 

f. What is 4GL? Explain its merits and demerits. 
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Unit: 5 
Application Software 

 

Learning Outcomes 

After completion of this unit you will be able to  

 explain/describe word processing software 

 explain/describe spreadsheet software, and 

 explain/describe presentation software 

5 .1. Word processing software 

Word processor software is an application package that allows a user to create, edit, 

store and print out text based documents. Word processing is the techniques of 

creating, formatting, editing and manipulating documents, reports, etc. Most 

modern companies that have a need for producing business letters or other types of 

text documents will have access to word processing software and a printer.  

Some of the widely used computer word processing software are Microsoft Word, 

Word Perfect, Word Star, Word Pad, Vim Editor etc. 

Types of Word Processing Software 

Microsoft Word 

Microsoft Word is a widely used commercial word processor designed by 

Microsoft. Microsoft Word is a component of the Microsoft Office suite of 

productivity software, but can also be purchased as a stand-alone product.It was 

initially launched in 1983 and has since been revised numerous times. Microsoft 

Word is available for both Windows and Macintosh operating systems.Microsoft 

Word is often called simply Word or MS Word. 

Microsoft Word offers several features to ease document creation and editing, 

including: 

 WYSIWYG (what-you-see-is-what-you-get) display: It ensures that 

everything displayed on screen appears the same way when printed or moved 

to another format or program. 
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 Spell check: Word features a built-in dictionary for spell checking; misspelled 

words are marked with a red squiggly underline. Sometimes, Word auto-

corrects an obviously misspelled word or phrase. 

 Text-level features such as bold, underline, italic and strike-through 

 Page-level features such as indentation, paragraphing and justification 

The default file format was .doc prior to the Microsoft Word 2007 version; in 2007, 

.docx became the default file format. 

WordPerfect 

WordPerfect is a word processing application from Corel Corp.. WordPerfect was 

popular in the early 1990s. It is best for writing simple essays and articles. Though 

it isn't used as much today, WordPerfect is compatible with Microsoft Word, 

meaning that you can open and edit WordPerfect files in the Word program, then 

save them as WordPerfect files again. WordPerfect also can be used for formatting 

and laying out documents. 

Lotus Word Pro 

If you use Lotus Notes or Lotus 1-2-3--common in corporate environments--Lotus 

Word Pro is an ideal program for your word processing needs. This program works 

in concert with Lotus applications to allow you to create and distribute formatted 

text documents. It is produced and distributed by IBM Corp. Lotus Word Pro is also 

compatible with Microsoft Word and ideal for writing reports, memos and 

proposals. 

Uses of Word Processor 

Word processors have a variety of uses and applications within the business world, 

home, and education. Businesses tend to have their own format and style for any 

documents produced. In Business word processing is used for legal copies, letters 

and letter head,  memos,  reference documents etc. 

Many homes have word processors on their computers, in the home word 

processing tends to be educational, planning or business related, dealing with 

assignments or work being completed at home, or recreational.  
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 In education word processing is used in a variety of different ways in the 

production of assignments, notes, exams, and for practicing its uses! 

Word Processor's Interface  

Word processor interface consists of main editing window; it displays a document 

and several tools to manipulate it. Tools are grouped together in different toolbar in 

order to work with document. 

 

Title Bar 

Title bar is located at the top of the screen. Word processor displays the name of 

the current document on it. 

Menu bar 

Each word on the menu bar represents a different menu. Each menu contains 

different commands of word. 

Standard bar 

Standard bar displays some of the most common word processing tasks. The tasks 

are opening, copying and printing files etc. 

Formatting toolbar 

Formatting toolbar is used to access various formatting commands quickly such as 

font type, font style and text alignment etc. 
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Status Bar 

The status bar is a horizontal area at the bottom of the document window. It provides 

information about the current state of the documents. 

Scroll Bars 

Scroll bars are used to move in the document. You can scroll the document by 

clicking the scroll arrows at either end of the scroll bar or by dragging the scroll 

button in scroll bar. 

Rulers 

The horizontal ruler can be used to set tab stops and indents or to adjust the width 

of columns. The horizontal or vertical ruler can also be used to change the page 

margins or place items on the page. 

Enter and Edit Text Formatting: 

The processing of typing text in a document is called entering text. The processing 

of changing the existing document is called editing text. The word processor places 

a blinking insertion point at the top left corner of screen. It is known as cursor. Te 

cursor indicates the location where the next character will be placed in the 

document. The cursor moves forward on the screen as the user types. The cursor 

moves to the next line as it reaches the end of line. 

Word process allows the user to change some text without retyping the whole 

document. It is different from type writer where the user has to type whole 

document again. There are many ways to edit an existing document. 

1. Typing Modes 

All word processor provide two modes of typing. These are as follows: 

i. Insert Mode 

Insert mode is used to insert text in the existing document. The existing character 

moves to the right side when the user types a character. It is the default mode of MS 

word. The following procedure is used to write text in insert mode: 

2. Place the cursor where the text is to be typed in insert mode. 
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3. Make sure that [OVR] option on status bar is not highlighted. If it is 

highlighted, press insert key to disable it. 

4. Type any text. The existing text will move to the right side and new text will 

appear. 

ii. Overtype Mode 

In overtype mode, the new character replaces the existing characters. The following 

procedure is used to write text in overtype mode: 

 
5. Place the cursor where the text is to be typed in overtype mode. 

6. Press the insert key, the overtype mode will be activated. The [OVR] option 

on status bar will be highlighted. 

7. Type any text. The existing text will be overwritten by the new text. 

8. Erasing Text 

 Two keys on the keyboard are used to erase text from a document. These are: 

ii. Delete Key 

 The delete key erases the character to the right of the cursor. 

iii. Backspace key 

Backspace key erases the character to the left of the cursor. 

The delete and backspace keys erase one character at a time. The user can select 

multiple characters and then press delete key to delete all selected characters. 

iv. Undo and Redo 

Undo command is used to remove the effect of the last action or number of actions. 

Redo command is used to remove the effect of undo command. 

9. Formatting text 

 Formatting of a document includes: 

i. Changing the appearance of the text. 
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ii. Adding picture and graphics 

iii. Controlling the layout of the text on the page. 

 The formatting toolbar is the easiest way to change any attribute. 

Paragraphs Formatting: 

A paragraph is a unit of text or other content that starts at the beginning of a 

document, immediately after a hard return (a carriage return), a page break, or a 

section break, or at the beginning of a table cell, header, footer, or list of footnotes 

and ends with a hard return (carriage return) or at the end of a table cell. Word 

documents generally contain paragraphs with different formatting. Even a very 

simple document with a centered heading and a justified body contains paragraphs 

with two different types of formatting. 

Word's graphical user interface (GUI) provides ways to apply numerous formatting 

options to your paragraphs. However, these options are not available in a single 

location, and some of these locations differ in different versions of Word. For this 

reason, this page is divided into the following sections, and the applicable options 

are described in each section. 

 The Paragraph Group 

 The Paragraph Dialog Box 

 The Tabs Dialog Box 

 Keyboard Shortcuts 

 More Information 

The Paragraph Group 

Many options are available directly in the Paragraph group on the Home tab of 

the Ribbon, in the Paragraph group on the Page Layout tab, and on the contextual 

toolbar and menu that appear when you right-click within text. 

Alignment 

Alignment or justification refers to the way in which the lines of a paragraph are 

aligned. There are four types of alignment, and the type of alignment of the 

paragraph where your cursor is located is indicated by the highlighted button in 

the Paragraph group on the Home tab. 
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 With left alignment ( ) (the default), the left-hand ends of all the lines in the 

paragraph are aligned along the left-hand margin of the text area. 

 With center alignment ( ), the mid-points (centers) of all the lines in the 

paragraph are aligned along the same imaginary vertical line at the center of 

the text area between the margins. 

 With right alignment ( ), the right-hand ends of all the lines in the 

paragraph are aligned along the right-hand margin of the text area. 

 With justified alignment or full justification ( ), all the lines in the 

paragraph, except the last line, are extended so that the left-hand end of each 

line is aligned along the left-hand margin of the text area, the right-hand end 

of each line is aligned along the right-hand margin of the text area, and the 

lines are all of the same length. This is achieved by inserting additional space 

between words. 

You can change the type of alignment of the paragraph where your cursor is located 

or of a group of selected paragraphs by clicking the applicable button in 

the Paragraph group on the Home tab. There are also shortcut keys (see the table 

in Keyboard Shortcuts below) for setting the type of alignment. 

Note. When you apply justified alignment to a paragraph, the last line does not 

extend across the full width of the text area. You can make all the lines in a 

paragraph extend across the full width of the text area by placing your cursor within 

the paragraph and pressing Ctrl+Shift+J, but it should be mentioned that in this 

case Word also adds space between letters within words to extend the lines. 

Line Spacing 

Line spacing refers to the vertical distance between the lines within a paragraph and 

determines the location of each line relative to the line above it. Line spacing can 

be specified by name (single, 1.5 lines, double), by a number that indicates a 
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multiple of single spacing (for example, 2.0 is equivalent to double spacing), and 

by an exact distance in points, where a point (pt) is equal to 1/72 of an inch. You 

can quickly view and change the line spacing to several common standard values 

by clicking the Line Spacing button ( ) in the Paragraph group on 

the Home tab. More line spacing options become available when you click Line 
Spacing Options to open the Paragraph dialog box (see below). 

Indents 

The indent before text refers to the width of the additional empty space that is 

inserted between the margin and the text on the left-hand side of a paragraph of left-

to-right text, and the indent after text refers to the width of the additional empty 

space that is inserted between the text and the margin on the right-hand side of a 

paragraph of left-to-right text. You can quickly increase the indent before text to 

the next tab stop by clicking the Increase Indent button ( ) in the Paragraph 

group on the Home tab, and you can quickly decrease the indent before text to the 

preceding tab stop by clicking the Decrease Indent button ( ) in the Paragraph 

group on the Home tab. 

You can set the indent before text (the left indent for left-to-right text) to values that 

do not correspond to tab stops, and you can also set the indent after text (the right 

indent for left-to-right text) in the Paragraph group on the Page Layout tab. 

 

Paragraph Spacing 

The spacing between your paragraphs is determined by the spacing before it and 

the spacing after it that are set for each paragraph. You can modify the spacing 

before a paragraph and the spacing after it by changing the values in the applicable 

boxes in the Paragraph group on the Page Layout tab. 
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Note. When the first of two consecutive paragraphs has non-zero spacing after it 

and the second paragraph has non-zero spacing before it, only the larger of the two 

spaces will be inserted between the paragraphs. 

Borders 

If you want to add borders around the paragraph where your cursor is located, click 

the Borders button ( ) to add the current default borders (the original default or 

the last border style that you selected). If you want to select a border style that 

differs from the current default border style, click the small arrow on 

the Borders button, and select one of the border styles displayed or click Borders 
and Shading to define your own custom borders. If you want to add borders around 

multiple paragraphs, select the applicable paragraphs before you click 

the Borders button or the small arrow on it. 

Shading (Colored Background) 

If you want to add shading with the current default background color to the entire 

text area of the paragraph where your cursor is located, click the Shading button (

) in the Paragraph group on the Home tab. If you want to select a background 

color other than the current default color, click the small arrow on 

the Shading button and then click one of the colors displayed or define your own 

custom color. If you want to apply the same shading to multiple paragraphs, select 

the applicable paragraphs before you click the Shading button or the small arrow 

on it. 

If you choose a very dark background color, Word will automatically change the 

text color to white to maintain good contrast and keep your text visible. 

The Paragraph Dialog Box 

Many of the paragraph formatting options described in the previous sections and 

additional paragraph formatting options are available in the Paragraph dialog box, 

which has two tabs. 

 Indents and Spacing 

 Line and Page Breaks 
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Before opening the Paragraph dialog box, place your cursor anywhere within a 

single paragraph that you want to format or select the multiple paragraphs that you 

want to format. To open the Paragraph dialog box, on the Home tab or on 

the Page Layout tab, at the bottom of the Paragraph group, click the Paragraph 

dialog box launcher ( ). 

When you click OK in the Paragraph dialog box or press Enter, any changes that 

you have made on either tab will be applied to the single paragraph where you 

cursor was located or to the paragraphs that you selected. 

The paragraph formatting options that are available on the Indents and 
Spacing tab of the Paragraphdialog box are divided among the General, 
Indentation, and Spacing groups. 

 

These paragraph formatting options are described in the next subsections. 

Alignment 

Alignment or justification refers to the way in which the lines of a paragraph are 

aligned. There are four types of alignment, namely, left, center, right, and justified, 

and they have been described above in detail in The Paragraph Group. 

Indentation 

The value in the Before text box specifies the width of the additional empty space 

that is inserted between the margin and the text on the left-hand side of a paragraph 
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of left-to-right text, and the value in the After text box specifies the width of the 

additional empty space that is inserted between the text and the margin on the right-

hand side of a paragraph of left-to-right text. A negative value specifies the distance 

by which the text extends beyond the respective margin. 

Two types of special indentation can be specified in the Special box. 

 If you choose First line, you can set the amount of additional indentation 

before the text on the first line of a paragraph or multiple paragraphs in 

the By box. 

 If you choose Hanging, you can create a hanging indent. In this case you can 

set the additional indentation before the text for all the lines except the first 

in the By box. If you want a part of the text on the first line to be aligned with 

the other lines in the paragraph, set the value in the Bybox equal to the first 

tab stop or set the first tab stop equal to the value in the By box and insert a 

tab character in the first line before the text to be aligned. 

Spacing 

The spacing between two paragraphs is determined by the spacing before one 

paragraph and the spacing after the preceding paragraph, which are displayed and 

can be modified in the Before and After boxes. 

Note. When the first of two consecutive paragraphs has non-zero spacing after it 

and the second paragraph has non-zero spacing before it, only the larger of the two 

spaces will be inserted between the paragraphs. 

Line spacing refers to the vertical distance between the lines within a paragraph and 

determines the location of each line relative to the line above it. The following types 

of line spacing can be specified in the Line spacing box. 

 Single, 1.5 lines, Double, 

 At least. When this option is selected, an exact distance in points, where a 

point (pt) is equal to 1/72 of an inch, is specified in the At box. 

 Exact. When this option is selected, an exact distance in points, where a point 

(pt) is equal to 1/72 of an inch, is specified in the At box. 
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 Multiple. When this option is selected, a number that indicates a multiple of 

single spacing (for example, 2.0 is equivalent to double spacing), is specified 

in the At box. 

Line and Page Breaks Tab 

The paragraph formatting options that you can configure on the Line and Page 
Breaks tab of the Paragraph dialog box can help you control where automatic 

page breaks occur in your document. 

 
These paragraph formatting options include the following. 

 Widow/orphan control. A widow is the last line of text in a paragraph with 

two or more lines that appears alone on the top of a page. An orphan is the 

first line of text in a paragraph with two or more lines that appears alone at 

the bottom of a page. When the Widow/orphan control option is selected for 

a paragraph, Word will break the paragraph at the end of a page only if it 

contains four or more lines and only if there is room for at least two lines at 

the bottom of the page before the break and there is room for at least two lines 

at the top of the page after the break. 

 Keep with next. When this option is selected for a paragraph, the paragraph 

and the next paragraph will be on the same page, and no page break will occur 
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between them unless a manual page break is inserted between them or 

the Page break before option is selected for the next paragraph. 

 Keep lines together. When this option is selected for a paragraph, all the lines 

in the paragraph will remain on the same page unless the paragraph cannot fit 

on a single page. If there is not sufficient space for the whole paragraph on 

the page containing the preceding paragraph, the paragraph will start at the 

top of the next page. 

 Page break before. When this option is selected for a paragraph, the 

paragraph will be located at the top of the page following the preceding 

paragraph. In many situations, it is preferable to use this option to force a page 

break before a specific paragraph and not to insert a manual page break. 

The Tabs Dialog Box 

Tab stops are used to horizontally align portions of text or other content on one or 

more lines when the portions of text or other content in each line are separated by 

tab characters. When you set a tab stop, you can configure it to align text to 

the left of the tab stop position, to align text to the right of it, to center text at it, to 

align the decimal point in the text at it, or to add a solid vertical line or bar at the 

tab stop in front of the aligned text. 

If you do not set any tab stops in a paragraph either directly or by applying a style 

to it, Word creates default tab stops every 0.5" (1.27 cm) across the entire width of 

the text area. The tab stops that are configured in a paragraph apply to all the lines 

in the paragraph. 

The Tabs dialog box can be used to set tab stops for one or more paragraphs. Before 

opening the Tabs dialog box, place your cursor anywhere within a single paragraph 

for which you want to set tab stops or select the multiple paragraphs for which you 

want to create tab stops. Then open the Tabs dialog box as follows. 

 First open the Paragraph dialog box as described in The Paragraph Dialog 

Box. 

 Then in the Paragraph dialog box click Tabs. 
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If you want to modify the tab stops that appear in the Tabs dialog box for the single 

paragraph or multiple paragraphs that you selected, perform the following steps. 

1. If one or more tab stops are listed under Tab stop position, click Clear All to 

delete all of them, or select each tab stop that you want to delete and 

click Clear. 

2. To set a new tab stop, enter its position in the Tab stop position text box, 

under Alignment select the desired type of alignment, under Leader select 

None or the desired type of leader, and then click Set. 
3. The position of the new tab stop should appear under Tab stop position. 

4. If you want to set more than one tab stop, repeat the previous step for each 

tab stop that you want to set. 

5. If you want to use evenly spaced default tab stops, after you have cleared any 

tab stops that may have been listed under Tab stop position, adjust the 

distance that appears in Default tab stops to the desired default spacing. 

6. Click OK. 

Keyboard Shortcuts 

The keyboard shortcuts (or shortcut keys or shortcut key combinations) that you 

can use to quickly apply paragraph formatting are listed in the following table. 
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Keyboard shortcuts for using in paragraph formatting 

Key Action 
Ctrl+E Applies center alignment. 
Ctrl+J Applies justified alignment. 

Ctrl+Shift+J Spreads the current paragraph across the entire width 
between the margins. 

Ctrl+M Increases the indentation of the current paragraph or 
selected paragraphs to the next tab stop. 

Ctrl+Shift+M Decreases the indentation to the preceding tab stop. 

Ctrl+Q Resets the paragraph formatting to the default paragraph 
formatting of the applied style. 

Ctrl+R Applies right alignment. 

Ctrl+Shift+S 
Opens the Apply Styles task pane for applying, creating, or 
modifying styles and formatting (use Alt+Ctrl+Shift+S to 
modify a style without applying it to the selection). 

Alt+Ctrl+Shift+S Opens the Styles pane. 

Ctrl+1 Applies single line spacing to the current paragraph or 
selected paragraphs. 

Ctrl+2 Applies double spacing to the current paragraph or selected 
paragraphs. 

Ctrl+5 Applies 1.5 line spacing to the current paragraph or 
selected paragraphs. 

Ctrl+0 Adds or removes additional space before the current 
paragraph or selected paragraphs. 

Shift+F1 Shows or hides the formatting properties in the task pane. 
 

Formatting Document 

Formatting document is the technique which allows making our document more 

attractive and professional. It includes changing font, setting margins, setting text 

alignments etc. 

Changing the Font Type 

There are different types of fonts supported by MS-Word. To change the font follow 

these steps: 

Step 1: Select the text to change the font type. 

Step 2: Click on the drop down arrow of Font button in the Font group of the Home 

tab. 
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Step 3: Click on the font name to apply. 

Changing the Font style (Bold, Italic and Underline) 

Different font styles such as bold, italic and underline are available in MS-Word.  

Step 1: Select the text to make Bold, Italic and Underline. 

Step 2: To make the text bold, click on bold button in the font group of the Home 

tab. 

Step 3: To make the text italic click on the italic button 

Step 4: To make the text underline click on the underline button. 

Changing the Font Size 

To change font size follow these steps:  

Step 1: Select the text which you want to change the size. 

Step 2: Click on the dropdown arrow of the Font size button in the font group of 

the Home tab. 

Step 3: Choose required font size. 

Press ctrl+] key to increase the font size. Press ctrl+[ key to decrease the font size. 

Changing the Font Color 

To change font color follow these steps:  

Step 1: Select the text which you want to change their colours. 

Step 2: Click on the dropdown arrow of the font color button in the font group of 

the Home tab. 

Then a color box with different colors will display. 

Step 3: Click on desired color from the list. 

Subscript and Superscript 

Superscript is the number, figure or symbol that is raised up from the base line. For 

example a2 + b2. Likewise subscript is dropped down from the base line. For 

example H2O. To change subscript/superscript follow these steps. 
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Step 1: Select the required character to make subscript or superscript. 

Step 2: Open the Font dialog box. 

Step 3: Put tick mark on the required option(subscript/superscript) 

Step 4: Click on the OK button. 

 OR, press Ctrl and +keys for subscript. Ctrl, shift and + keys for superscript. 

Changing line Spacing 

1. Select Design > Paragraph Spacing. 

2. However the cursor over each option to see a preview, and then select the 

option you want. 

3. For single spacing, select No Paragraph Space. 

4. Change line spacing for part of your document 

5. Select the paragraphs you want to change. 

6. Select Home > Line and Paragraph Spacing, and choose the spacing you 

want. 

Work with Special features of Word Processing 
A word processor enables you to create a document, store it electronically on a dis

k, display it on a screen, modify it by entering commands and characters from the 

keyboard, and print it on a printer. 

The great advantage of word processing over using a typewriter is that you can ma

ke changes without retyping the entire document. 

If you make a typing mistake, you simply back up thecursor and correct your mist

ake. 

If you want to delete a paragraph, you simply remove it, without leaving a trace. 

It is equally easy to insert a word, sentence, or paragraph in the middle of a 

document. 

Word processors usually support these features (and a few others) : 

 Cut and paste: Allows you to remove (cut) a section of text from one place 

in a document and insert (paste) it somewhere else 
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 Word wrap: The word processor automatically moves to the next line when 

you have filled oneline with text, and it will readjust text if you change the 

margins 

 Print: Allows you to send a document to a printer to get hardcopy 

 Font specifications: Allows you to change fonts within a document 

 For example, you can specify bold, italics, and underlining 

 Most word processors also let you change the font size and even thetypefac. 

 Graphics: Allows you to embed illustrations and graphs into a document 

 Some word processors let you create the illustrations within the word 

processor; others let you insert an illustration produced by a different program 

 Headers, footers, and page numbering: Allows you to specify customized 

headers and footersthat the word processor will put at the top and bottom 

of every page 

The word processor automatically keeps track of page numbers so that the correct 

number appears on each page. 

 Layout: Allows you to specify different margins within a single document 

and to specify variousmethods for indenting paragraphs. 

 Merges: Allows you to merge text from one file into another file. 

 This is particularly useful for generating many files that have the same format 

but different data. 

 Generating mailing labels is the classic example of using merges. 

 Spell checker: A utility that allows you to check the spelling of words. 

 It will highlight any words that it does not recognize. 

 Thesaurus: A builtin thesaurus that allows you to search for synonyms 

without leaving the word processor. 

Language Tools 

Microsoft Word’s language tools are more than just red or blue squiggly lines. 

There’s help to choose alternative words, alternate languages, check and improve 

grammar, hyphenate documents and even test the document for readability. 

You may think you know all about the language tools, but Word always has a few 
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extras tucked away to surprise even experts. 

 Spelling 

 AutoCorrect 

 Thesaurus 

 Grammar 

 Delay 

 Options 

 Word Count and Statistics 

 Readability 

 Hyphenation 

 Translation 

Spelling 

We all know about the red squiggly line on misspelled words. Right-click to see 

possible correct spellings.  

Ignore All– Word will consider that word as correctly spelled in this 

document.  There’s no option to ignore just one instance of a misspelled word. 

Add to Dictionary– adds this word to your custom dictionary.  It won’t be marked 

as wrong in any other documents. 

Smart Lookup– new in Office 2016. Opens a Bing search for that word in a side-

pane. 

AutoCorrect 

AutoCorrect is Word magically changing common spelling mistakes as you 

type.  It’s different from the speller checker but related. 

Things like  tpye   accomodation  youve and many more are loaded into an 

AutoCorrect list at Options | Proofing | AutoCorrect.   When you type something 

from the ‘Replace’ column, Word will insert the ‘With’ value instead. 

You can add your own common mistakes to this list or use AutoCorrect to save 

typing by changing a shortcut term into a longer one. (e.g.  type  IRSf  to get Internal 

Revenue Service) 
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At the bottom of these options is ‘Automatically use suggestions from the spelling 

checker’ which ties the spell check to Autocorrect. 

Thesaurus 

In a paper thesaurus (like the famous Roget’s Thesaurus that I pored over as a kid 

and still available) you looked up a word to see alternatives or synonyms 

Microsoft Word has a thesaurus in some languages.  Right-click on a correctly 

spelled word and choose Synonyms. Here we’re looking for synonyms of 

‘thesaurus’: 

Click on a synonym to replace the current word. 

Or choose ‘Thesaurus…’ to see more in a side-pane. If your computer is connected 

to the Internet you’ll see extra options. 

There’s a longer list of synonyms and you can type other words into the search box 

at the top. 

The speaker icon next to the word will play a voice speaking the word. 

Click on ‘See More…’ to open a web page about that word.  In this case the page 

includes a great line from Steven Wright, “What’s another word for Thesaurus?” 

At the bottom of the pane you can switch languages or variants.  For example, 

switch between US English and ‘real’ English from the Mother Country <g>. 

Grammar 

The blue squiggly line checks not just for grammar but also common typing 

mistakes.  For example, adding extra spaces between words. 

Or missing the comma after ‘For example’ <g>. 

Ignore Once – removes the blue squiggly line with no change. 

Grammar  – opens the Grammar pane to show more options and examples.  Like 

the Spelling pane, there’s a change language option. 

The English grammar check in Word isn’t perfect by any means.  Just skimming 

through a document looking for blue squiggles won’t catch everything.  Surely this 
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sentence deserves a squiggle or two? 

And there are instances where the grammar check is wrong.   English is such a 

messy language that the Microsoft grammar check should be regarded as a minor 

miracle for what it can do, rather than its shortcomings. 

Tables 

Insert a table 

In Microsoft Office Word 2007, you can insert a table by choosing from a selection 

of preformatted tables — complete with sample data — or by selecting the number 

of rows and columns that you want. You can insert a table into a document, or you 

can insert one table into another table to create a more complex table. 

Use table templates 

You can use table templates to insert a table that is based on a gallery of 

preformatted tables. Table templates contain sample data to help you visualize what 

the table will look like when you add your data. 

1. Click where you want to insert a table.  

2. On the Insert tab, in the Tables group, click Table, point to Quick Tables, 

and then click the template that you want.  

3. Replace the data in the template with the data that you want. 

Use the Table menu 

1. Click where you want to insert a table.  

2. On the Insert tab, in the Tables group, click Table, and then, under Insert 
Table, drag to select the number of rows and columns that you want.  

Use the Insert Table command 

You can use the Insert Table command to choose the table dimensions and format 

before you insert the table into a document. 

1. Click where you want to insert a table.  

2. On the Insert tab, in the Tables group, click Table, and then click Insert 
Table.  
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3. Under Table size, enter the number of columns and rows.  

4. Under AutoFit behavior, choose options to adjust the table size. 

Word Art 

WordArt is a gallery of text styles that you can add to your 2007 Microsoft Office 

system documents to create decorative effects, such as shadowed or mirrored 

(reflected) text. In Microsoft Office PowerPoint 2007, you can also convert existing 

text into WordArt. To insert word art, follow these steps:  

1. On the Insert tab, in the Text group, click WordArt, and then click the 

WordArt style that you want.  

2. Type your text in the Text box. 

Convert existing text to WordArt in Office PowerPoint 2007 

1. Select the text that you want to convert to WordArt.  

2. On the Insert tab, in the Text group, click WordArt, and then click the 

WordArt that you want.  

 
Create, apply, or remove a chart template 

To reuse a favorite chart type that you customized to meet your needs, you can save 

that chart as a chart template (*.crtx) in the charts template folder. 

Apply a chart template 

1. Do one of the following:  

 To create a new chart based on the template, on the Insert tab, in the Charts 

group, click any chart type, and then click All Chart Types.  
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You can also click the Dialog Box Launcher next to Charts in the Charts 

group on the Insert tab. 

2. To make a selected chart match a template, on the Design tab, in the Type 

group, click Change Chart Type.  

 

3.. Click Templates in the first box, and then click the template that you want to 

use in the second box under My Templates.  

 NOTE    If a chart template is located in a folder other than the Charts folder, 

click Manage Templates, locate the chart template, and then copy or move it to 

the Charts folder under Templates. 

Remove or delete a chart template 

1. On the Insert tab, in the Charts group, click any chart type, and then click 

All Chart Types.  

 
You can also click the Dialog Box Launcher next to Charts in the Charts 

group on the Insert tab. 

2. Click Manage Templates  

3. Do one of the followings; 

Save a chart as a chart template 

1. Click the chart that you want to save as a template.  

 This displays the Chart Tools, adding the Design, Layout, and Format tabs. 

2. On the Design tab, in the Type group, click Save Template.  
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3. In the Save in box, make sure that the Charts folder is selected.  

4. In the File name box, type an appropriate name for the chart template. 

Add a shape from within the SmartArt graphic: 

1. Click the SmartArt graphic that you want to add a shape to.  

2. Click the existing shape that is located closest to where you want to add the 

new shape.  

3. Under SmartArt Tools, click the Design tab.  

 

4. In the Create Graphic group, click the arrow under Add Shape, and then do 

one of the following to select a location for the new shape:  

 

 To insert a shape at the same level as the selected shape but following it, click 

Add Shape After.  

 To insert a shape at the same level as the selected shape but before it, click 

Add Shape Before 

 To insert a shape one level above the selected shape, click Add Shape Above.  

 The new shape takes the position of the selected shape, and the selected shape 

and all of the shapes below it are demoted one level each. 

 To insert a shape one level below the selected shape, click Add Shape Below.  

 The new shape is added at the end of other shapes at the same level. 
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5.2. Spreadsheet software 

Spreadsheet software is a software application capable of organizing, storing and 

analyzing data in tabular form. The application can provide digital simulation of 

paper accounting worksheets. They can also have multiple interacting sheets with 

data represented in text, numeric or in graphic form. With these capabilities, 

spreadsheet software has replaced many paper-based systems, especially in the 

business world. Originally developed as an aid for accounting and bookkeeping 

tasks, spreadsheets are now widely used in other contexts where tabular lists can be 

used, modified and collaborated. 

Spreadsheet software is also known as a spreadsheet program or spreadsheet 

application. 

Uses of Spreadsheets 

Spreadsheets provide invaluable tools for collecting and calculating data of all 

types. Beyond arithmetic, they can be formatted to create clear, concise reports and 

can be sorted and updated with the touch of a button. 

Lists 

You can create lists, from shopping lists to contact lists, on a spreadsheet.  

Accounting 

Beyond sorting, spreadsheets are invaluable calculators. By entering the appropriate 

mathematical functions into cells, you can turn a simple spreadsheet into an 

accounting page.  

Time Sheets 

Besides adding and subtracting integers, spreadsheets can also perform those 

calculations on time-based numbers. Formatting cells to reflect data as a time (as 

opposed to simple integers) can allow you to use the spreadsheet as a time sheet.  

Database Use 

Although spreadsheets are not true relational databases, they can be designed and 

formatted to function as simplified ones.  
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Chart Creation 

Charts and graphs create better depictions of trends and percentages than raw 

numbers.  

Types of Spreadsheets 

Spreadsheets play a central role in the daily administrative tasks within many 

businesses both small and large. With spreadsheet software such as Microsoft 

Excel, business managers and administrators can capture, manipulate, analyze and 

present valuable data related to particular areas of their operation. The types of data 

spreadsheets are used to manage typically fall into one of a few common categories. 

As well as recording business data, spreadsheets can be used to manage it in a 

variety of ways. 

Financial 

Many businesses use spreadsheets to manage accounting data. This includes budget 

management such as tracking income and expenses.  

Statistical 

Spreadsheets are primarily used to capture data, but they also provide the means to 

analyze and manipulate data sets.  

Presentation 

Once a spreadsheet has been populated with one or more data sets, users can exploit 

features within the spreadsheet application to present these data sets graphically.  

Future Planning 

Spreadsheet data sets can be used to inform the process of making future plans for 

a business. As well as including graphs or tables representing historical business 

data within business plans, spreadsheets can be created specifically for the purposes 

of projection.  

Project Tracking 

Spreadsheets can play a role in project management tasks within certain 

organizations.  
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Spreadsheet's Interface 

The Excel Interface 

File Tab & Ribbon 

In Excel 2010, the Office button  has been replaced by a modification of the familiar 

File menu . Click to reveal the New, Open, Save, Print and Close options. 

If you are upgrading to 2010 from 2007, not much of the interface has 

changed.  However, if you are upgrading from an older version of Excel, you may 

be unfamiliar with the new interface, which will be explained in the sections below. 

Seven tabs are displayed across the top-left of the window.  

Home Tab 

The Home tab contains the most common text editing tools used in Excel. 

 
Shortcut Menu 

The most common Excel commands and functions can be accessed quickly by using 

the shortcut menu. To access this feature, simply right-click the element you wish 

to edit if you are using a PC, or control-click the element you wish to edit if you are 

using a Mac. The options displayed will vary depending on the element you have 

selected. 

Spreadsheet Basics 

Each Excel file is a workbook that can hold many worksheets. The worksheet is a 

grid of columns (designated by letters) and rows (designated by numbers). The 

letters of the columns are indicated in the blue buttons across the top of the 

worksheet. The numbers of the rows are indicated in the blue buttons down the left 

of the worksheet. The intersection of a column and a row is called a cell. You can 

input your data into the cells. Cells can contain text, numbers, or formulas for 

automatic calculations. Each cell on the spreadsheet has a cell address that is the 
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column letter followed by the row number. 

Formula bar 

This will be one of the most useful tools as you use Excel. The formula bar allows 

you to see all the details and methods used to return what is seen in a cell. Whenever 

you input any information into a cell, the output, or end result is what is shown once 

you move away from the cell. This is most prominent when using functions, as you 

do not see the whole equation in the cell in the worksheet, only the result. The 

formula bar is located below the ribbon and spans most of the window. 

 
 
It is possible to hide the formula bar, though is not recommended. We can hide or 

show the formula bar. If it is mistakenly hidden, go to Excel Options at the bottom 

right of the menu that opens when you click the Office button. Go to 

the Advanced option, and under Display, you can click the check box for Show 
formula bar. When done, simply click Ok. 
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Addin a Worksheet 

By default, three worksheets are included in each Excel workbook. You can access 

the different worksheets by clicking the worksheet tabs just above the status bar. 
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To add a new worksheet, click the Insert Worksheet tab, to the right of the existing 

worksheet tabs. 

Renaming a Worksheet 

To rename a worksheet tab, follow either of these steps: 

Steps Actions 

Option 1 

1. Right-click the tab you want to rename if you are using a PC, or control-click 

the tab you want to rename if you are using a Mac. A shortcut menu will open. 

2. Click Rename from the shortcut menu. 

3. Type the new name. 

4. Press . 

Option 2 

1. Hover over the tab you want to rename, and double Left-click the tab. 

2. Begin typing to rename the tab. 

2. Press  
Worksheets 

A worksheet is a collection of cells where you keep and manipulate the data. Each 

Excel workbook can contain multiple worksheets. 

Select a Worksheet 

When you open an Excel workbook, Excel automatically selects Sheet1 for you. 

The name of the worksheet appears on its sheet tab at the bottom of the document 

window. 
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Insert a Worksheet 

You can insert as many worksheets as you want. To quickly insert a new 

worksheet, click the plus sign at the bottom of the document window. 

 

Result: 

 

Rename a Worksheet 

To give a worksheet a more specific name, execute the following steps. 

1. Right click on the sheet tab of Sheet1. 

2. Choose Rename. 
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3. For example, type Sales 2016. 

 

Move a Worksheet 

To move a worksheet, click on the sheet tab of the worksheet you want to move and 

drag it into the new position. 

1. For example, click on the sheet tab of Sheet2 and drag it before Sales 2016. 

 
Result: 

 

Delete a Worksheet 

To delete a worksheet, right click on a sheet tab and choose Delete. 
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1. For example, delete Sheet2. 

 

Result: 

 

Copy a Worksheet 

Imagine, you have got the sales for 2016 ready and want to create the exact same 

sheet for 2017, but with different data. You can recreate the worksheet, but this is 

time-consuming. It's a lot easier to copy the entire worksheet and only change the 

numbers. 

1. Right click on the sheet tab of Sales 2016. 

2. Choose Move or Copy. 
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The 'Move or Copy' dialog box appears. 

3. Select (move to end) and check Create a copy. 

 

4. Click OK. 

Result: 

 

Note: you can even copy a worksheet to another Excel workbook by selecting the 

specific workbook from the drop-down list (see the dialog box shown earlier). 

Labels and values: 

Entering data into a spreadsheet is just like typing in a word processing program, 

but you have to first click the cell in which you want the data to be placed before 

typing the data. 

All words describing the values (numbers) are called labels. The numbers, which 

can later be used in formulas, are called values. 

Notice also that the labels (composed of letters) are all left justified and the values 

(composed of numbers) are all right justified in their cells. 

Formulas: 

Click the cell in which you want the answer (result of the formula) to appear. 

Press enter once you have typed the formula. 
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All formulas start with an = sign. 

Refer to the cell address instead of the value in the cell e.g. =A2+C2 instead of 

45+57. That way, if a value changes in a cell, the answer to the formula changes 

with it. 

+ means add e.g. A2+C2 Add the value (number) in A2 to the value 
(number) in C2. 

- means subtract e.g. A2-C2 Subtract the value (number) in C2 from the 
value (number) in A2. 

* means multiply e.g. A2*4 Multiply the value (number) in A2 by 4. 

/ means divide e.g. A2/3 Divide the value (number) in A2 by 3. 
 

Functions 

These formulas are used for working with long lists of numbers. A typical function 

looks like this: 

=SUM(A3:A30) 

 SUM is a function, meaning that it sums (adds up) the list of numbers. 

 The list of numbers is indicated in brackets. 

 The address of the first cell in the list is A3. 

 A colon : separates this cell address from the last cell in the list, which is A30. 

=SUM(B3:B9) 
Adds list of values from cell B3 to cell 
B9 

=AVERAGE(B3:B9) 
Averages the values from cell B3 to 
cell B9 

Other functions: 

There are many functions that you could explore with time. SUM and AVERAGE 

are two of the most common, below are a few more: 

SUM adds the numbers in the list 

AVERAGE averages the numbers in the list 

PRODUCT multiplies the numbers in the list 

MAX identifies the highest number in the list 

MIN identifies the lowest number in the list 

COUNT counts the number of numerical items in the list 
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COUNTA counts the number of alphabetical items in the list 

COUNTIF counts the number of items that satisfy certain criteria 

e.g. =COUNTIF(A4:A20,">50")  counts the number of values that 

are higher than 50 in the list from A4 to A20 - notice the use of 

the comma and quotation marks to separate the list (A4:A20) from 

the criteria (>50). 
 

Date & Time Functions: 

To enter a date in Excel, use the "/" or "-" characters. To enter a time, use the ":" 

(colon). You can also enter a date and a time in one cell. 

Note: Dates are in US Format. Months first, Days second. This type of format 

depends on your windows regional settings. Learn more about Date and Time 

formats. 

Year, Month, Day 

To get the year of a date, use the YEAR function. 

Note: use the MONTH and DAY function to get the month and day of a date. 

Format a worksheet 

You can help improve the readability of a worksheet by applying different types of 

formatting. For example, you can apply borders and shading to help define the cells 

in a worksheet. 

Apply cell borders 

1. Select the cell or range of cells that you want to add a border to. 

Tip    To quickly select the whole worksheet, click the Select All button. 

 

2. On the Home tab, in the Font group, click the arrow next to Borders  ,  

3. and then click the border style that you want. 
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Tips : The Borders button displays the most recently used border style.  

You can click the Bordersbutton (not the arrow) to apply that style. 

Change text color and alignment 

1. Select the cell or range of cells that contain (or will contain) the text that you 

want to format. You can also select one or more portions of the text within a 

cell and apply different text colors to those sections. 

2. To change the color of text in the selected cells, on the Home tab, in 

the Font group, click the arrow next to Font Color  , and then 

under Theme Colors or Standard Colors, click the color that you want to 

use. 

 Note    To apply a color other than the available theme colors and standard 

colors, click More Colors, and then define the color that you want to use on 

the Standard tab or Custom tab of the Colors dialog box. 

3. To change the alignment of the text in the selected cells, on the Home tab, in 

the Alignmentgroup, click the alignment option that you want. 

 

For example, to change the horizontal alignment of cell contents, click Align Text 

Left  , Center  , or Align Text Right  . 

Apply cell shading 

4. Select the cell or range of cells that you want to apply cell shading to. 

5. On the Home tab, in the Font group, click the arrow next to Fill Color  , 

and then under Theme Colors or Standard Colors, click the color that you 

want. 

Relative and Absolute Cell References: 

There are two types of cell references: relative and absolute. Relative and absolute 

references behave differently when copied and filled to other cells. Relative 

references change when a formula is copied to another cell. Absolute references, 
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on the other hand, remain constant no matter where they are copied. 

Relative references 

By default, all cell references are relative references. When copied across multiple 

cells, they change based on the relative position of rows and columns. For example, 

if you copy the formula =A1+B1 from row 1 to row 2, the formula will 

become =A2+B2. Relative references are especially convenient whenever you need 

to repeat the same calculation across multiple rows or columns. 

To create and copy a formula using relative references: 

In the following example, we want to create a formula that will multiply each 

item's price by the quantity. Rather than create a new formula for each row, we 

can create a single formula in cell D2 and then copy it to the other rows. We'll use 

relative references so the formula correctly calculates the total for each item. 

1. Select the cell that will contain the formula. In our example, we'll select 

cell D2. 

2. Enter the formula to calculate the desired value. In our example, we'll 

type =B2*C2. 

Absolute references 

There may be times when you do not want a cell reference to change when filling 

cells. Unlike relative references, absolute references do not change when copied 

or filled. You can use an absolute reference to keep a row and/or column constant. 

An absolute reference is designated in a formula by the addition of a dollar sign 
($). It can precede the column reference, the row reference, or both. 
 

 

You will usually use the $A$2 format when creating formulas that contain absolute 

references. The other two formats are used much less frequently. 

When writing a formula in Microsoft Excel, you can press the F4 key on your 
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keyboard to switch between relative and absolute cell references. This is an easy 

way to quickly insert an absolute reference. 

To create and copy a formula using absolute references 

In our example, we'll use the 7.5% sales tax rate in cell E1 to calculate the sales tax 

for all items in column D. We'll need to use the absolute cell reference $E$1 in our 

formula. Because each formula is using the same tax rate, we want that reference to 

remain constant when the formula is copied and filled to other cells in column D. 

1. Select the cell that will contain the formula. In our example, we'll select 

cell D3. 

2. Enter the formula to calculate the desired value. In our example, we'll type 

=(B3*C3)*$E$1. 

3. Press Enter on your keyboard. The formula will calculate, and the result will 

display in the cell. 

4. Locate the fill handle in the lower-right corner of the desired cell. In our 

example, we'll locate the fill handle for cell D3. 

Formatting Values 

Create and build a custom numeric format to show your numbers as percentages, 

currency, dates, and more. 

1. Select the numeric data. 

2. Select More in the Number group. 

3. Select Custom. 

4. In the Type list, select an existing format, or type a new one in the box. 

5. To add text to your number format: 

6. Type what you want in quotation marks. 

7. Add a space to separate the number and text. 

8. Select OK. 

Labels and Cells 

A label is text that identifies the purpose of a cell or text box or that displays 

descriptive text, such as titles, captions, or brief instructions. In addition, a label can 
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display a descriptive picture. Use a label for flexible placement of instructions, to 

emphasize text, and when merged cells or a specific cell location is not a practical 

solution. 

A cell or text box is a rectangular box in which you can view, enter, or edit text or 

data that is bound to a cell. A text box can also be a static text field that presents 

read-only information. Use a text box as an alternative to entering text in a cell, 

when you want to display an object that floats freely. You can also use a text box 

to display or view text that is independent of row and column boundaries, 

preserving the layout of a grid or table of data on the worksheet. 

Add a label (Form control) 

1. If the Developer tab is not available, display it. 

Display the Developer tab 

a. Click the File tab, click Options, and click Customize Ribbon. 

b. Under Main Tabs , select the Developer check box, and then click OK. 

1. On the Developer tab, in the Controls group, click Insert and then, under 

Form Controls, click Label . 

 
2. Click the worksheet location where you want the upper-left corner of the label 

to appear. 

3. To specify the control properties, right-click the control, and then 

click Format Control. 

Label (Form control) 

 

Label (ActiveX control) Text Box (ActiveX control) 
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Add a label (ActiveX control) 

4. If the Developer tab is not available, display it. 

a. Display the Developer tab 

b. Click the File tab, click Options, and click Customize Ribbon. 

5. Under Main Tabs , select the Developer check box, and then click OK. 

 On the Developer tab, in the Controls group, click Insert and then, 

under ActiveX Controls, click Label  . 

 
6. Click the worksheet location where you want the upper-left corner of the label 

to appear. 

7. To edit the ActiveX control, make sure that you are in design mode. On 

the Developer tab, in the Controls group, turn on Design Mode  . 

8. Click the worksheet location where you want the upper-left corner of the label 

to appear. 

9. To specify the control properties, on the Developer tab, in the Controls 

group, click Properties  . 

Add Charts 
A simple chart in Excel can say more than a sheet full of numbers. As you'll see, 

creating charts is very easy. 

Create a Chart 
To create a line chart, execute the following steps. 

1. Select the range A1:D7. 
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2. On the Insert tab, in the Charts group, click the Line symbol. 

 
3. Click Line with Markers. 

 
Result 

 
Note: enter a title by clicking on Chart Title. For example, Wildlife Population. 

Change Chart Type 
You can easily change to a different type of chart at any time. 

1. Select the chart. 
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2. On the Design tab, in the Type group, click Change Chart Type. 

 
3. On the left side, click Column. 

 

4. Click OK. 

Result 

 

Data Filter 

Filter your Excel data if you only want to display records that meet certain criteria. 

1. Click any single cell inside a data set. 

2. On the Data tab, in the Sort & Filter group, click Filter. 
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Arrows in the column headers appear. 

3. Click the arrow next to Country. 

4. Click on Select All to clear all the check boxes, and click the check box next 

to USA. 

5. Click OK. 

Result. Excel only displays the sales. 

6. Click the arrow next to Quarter. 

7. Click on Select All to clear all the check boxes, and click the check box next 

to Qtr 4. 

8. Click OK. 

 Result. Excel only displays the sales in the USA in Qtr 4. 

9. To remove the filter, on the Data tab, in the Sort & Filter group, click Clear. 

To remove the filter and the arrows, click Filter. 

Sort data 

Sorting data is an integral part of data analysis. You might want to arrange a list of 

names in alphabetical order, compile a list of product inventory levels from highest 

to lowest, or order rows by colors or icons. Sorting data helps you quickly visualize 

and understand your data better, organize and find the data that you want, and 

ultimately make more effective decisions. 

You can sort data by text (A to Z or Z to A), numbers (smallest to largest or largest 

to smallest), and dates and times (oldest to newest and newest to oldest) in one or 

more columns. You can also sort by a custom list you create (such as Large, 

Medium, and Small) or by format, including cell color, font color, or icon set. 

Sort text 

1. Select a cell in the column you want to sort. 

2. On the Data tab, in the Sort & Filter group, do one of the following: 



Computer Application : Grade 9 167 

 To quick sort in ascending order, click  (Sort A to Z). 

 To quick sort in descending order, click  (Sort Z to A). 

Working with special features of spreadsheet 

When spreadsheet software first became available for computers in the early 1980s, 

it was known as a "killer application" because people began to buy computers just 

so they could work with spreadsheets. Today, spreadsheet software is practically a 

required part of any collection of office software, and it remains as useful now as it 

was in the beginning. 

Visual Design 

Spreadsheets allow you to lay figures out on a grid, calculating and manipulating 

them visually. Often, this may result in you being able to process the information 

more quickly. On a spreadsheet, you may also notice errors or omissions that you 

would not have otherwise. 

Automatic Calculations 

Spreadsheet software gives you the ability to enter mathematical formulas ranging 

from simple arithmetic to complex statistics.  

Dynamic Updates 

In addition to the standard method of entering data in a spreadsheet -- typing 

numbers in cells -- you can also create a cell with a value generated dynamically 

based on other cells.  

Data Analysis 

Spreadsheet software gives you the ability to analyze your data in ways other than 

simply looking at grids and lines. Most spreadsheet software can automatically 

create graphs and charts from your data, giving you different ways of comparing 

and analyzing information. These visual representations can also be printed and 

emailed, or exported into slide shows for presentations. 

Formulas and Functions: 

A formula is an expression which calculates the value of a cell. Functions are 
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predefined formulas and are already available in Excel. 

For example, cell A3 below contains a formula which adds the value of cell A2 to 

the value of cell A1. 

 

For example, cell A3 below contains the SUM function which calculates the sum 

of the range A1:A2. 

 

Enter a Formula 

To enter a formula, execute the following steps. 

1. Select a cell. 

2. To let Excel know that you want to enter a formula, type an equal sign (=). 

3. For example, type the formula A1+A2. 

 

Tip: instead of typing A1 and A2, simply select cell A1 and cell A2. 

4. Change the value of cell A1 to 3. 
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Excel automatically recalculates the value of cell A3. This is one of Excel's most 

powerful features! 

Edit a Formula 

When you select a cell, Excel shows the value or formula of the cell in the formula 

bar. 

 

 

1. To edit a formula, click in the formula bar and change the formula. 

 

2. Press Enter. 

 

Operator Precedence 

Excel uses a default order in which calculations occur. If a part of the formula is in 

parentheses, that part will be calculated first. It then performs multiplication or 

division calculations. Once this is complete, Excel will add and subtract the 

remainder of your formula. See the example below. 
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First, Excel performs multiplication (A1 * A2). Next, Excel adds the value of cell 

A3 to this result. 

Another example, 

 

First, Excel calculates the part in parentheses (A2+A3). Next, it multiplies this 

result by the value of cell A1. 

Copy/Paste a Formula 

When you copy a formula, Excel automatically adjusts the cell references for each 

new cell the formula is copied to. To understand this, execute the following steps. 

1. Enter the formula shown below into cell A4. 

 

2a. Select cell A4, right click, and then click Copy (or press CTRL + c)... 

 

...next, select cell B4, right click, and then click Paste under 'Paste Options:' (or 

press CTRL + v). 
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2b. You can also drag the formula to cell B4. Select cell A4, click on the lower 

right corner of cell A4 and drag it across to cell B4. This is much easier and 

gives the exact same result! 

 

Result. The formula in cell B4 references the values in column B. 

 

Insert a Function 

Every function has the same structure. For example, SUM(A1:A4). The name of 

this function is SUM. The part between the brackets (arguments) means we give 

Excel the range A1:A4 as input. This function adds the values in cells A1, A2, A3 

and A4. It's not easy to remember which function and which arguments to use for 

each task. Fortunately, the Insert Function feature in Excel helps you with this. 

To insert a function, execute the following steps. 

1. Select a cell. 

2. Click the Insert Function button. 
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The 'Insert Function' dialog box appears. 

3. Search for a function or select a function from a category. For example, 

choose COUNTIF from the Statistical category. 

 

4. Click OK. 

 The 'Function Arguments' dialog box appears. 

5. Click in the Range box and select the range A1:C2. 

6. Click in the Criteria box and type >5. 

7. Click OK. 
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Result. The COUNTIF function counts the number of cells that are greater than 5. 

 

Note: instead of using the Insert Function feature, simply type =COUNTIF 

(A1:C2,">5"). When you arrive at: =COUNTIF( instead of typing A1:C2, simply 

select the range A1:C2. 

5.3. Presentation software 

Present Program Basics 

Presentation software (sometimes called "presentation graphics") is a category 

of application program used to create sequences of words and pictures that tell a 

story or help support a speech or public presentation of information. Presentation 

software can be divided into business presentation software and more general 

multimedia authoring tools, with some products having characteristics of both. 

Business presentation software emphasizes ease- and quickness-of-learning and 

use. Multimedia authoring software enables you to create a more sophisticated 

presentation that includes audio and video sequences. Business presentation 

software usually enables you to include images and sometimes audio and video 

developed with other tools. 

Some very popular presentation software, such as Microsoft's Power point and 

Lotus's Freelance Graphics, are sold stand-alone or can come as part of office-

oriented suites or packages of software. Other popular products include Adobe 

Persuasion, Astound, Asymetrix Compel, Corel Presentations, and Harvard 

Graphics. Among the most popular multimedia authoring tools are Macromedia 

Director and Asymetrix's Multimedia Toolbook. These authoring tools also include 

presentation capability as well. Most if not all of these products come in both PC 

and Mac versions. 

Recently, a new presentation tool has arrived: your Web browser and the tools for 

creating Web pages, such as Microsoft's FrontPage and Adobe's PageMill. The 
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ubiquity of these tools and the browser as a playback device make this a popular 

approach, especially when a presentation can combine HTML pages on the hard 

disk with links to outside sites (if you have a live Internet connection). 

Powerpoint  Software 

Everyone agrees that Microsoft Powerpoint is so 20th century.  It is not the best 

free presentation tool (In fact it’s not free at all).  

Powerpoint is a part of Microsoft office Package which allows to create, edit and 

display presentation in an interesting and effective way. 

The PowerPoint Interface 

To begin a presentation, open PowerPoint (Click Start, All Programs, Microsoft 

PowerPoint). PowerPoint opens as shown in Figure  

a. Title bar 

b. PowerPoint window control buttons 

c. Presentation close button 

d. Menu bar 

e. Standard toolbar 

f. Formatting toolbar 

g. Task pane 

h. Slide pane 

i. Notes pane 

j. Outline tab 

k. Slides tab 

l. View buttons 

m. Status bar 

n. Splitter bar 
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Create a Presentation Format Slides 

A PowerPoint has two methods for creating a slide presentation: 

 Choose a theme template 

 Create a blank presentation (this method is covered in Unit 3) 

 PowerPoint software has built in and free online pre-designed templates that 

contain various color schemes and pre-arranged elements in a slide, eg. text 

and graphics. Select a template and PowerPoint will format the entire 

presentation according to that template. 

 Steps to choosing a theme template: 

 Open PowerPoint. 

 At the PowerPoint window, click the File tab, then click New. 

 The Available Templates and Themes screen will appear, click on an 

available template or download a free template from the office.com online 

templates. 
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 Once you have selected the desired template, it will be displayed in normal 

view. New slides can be added as needed. 

 A theme template can be added to a presentation before, during or after you 

have added the presentation content. 

 To apply various templates to a presentation, click the Design tab, then click 

on the desired template in the themes group. 

 

Create a New Slide 

Whether you are using a pre-made theme template or working from your own 

design, it is very easy to insert a new slide. 

1. In the slide pane click on the slide where you would like the new slide to 

appear below. 

2. Click on the New Slide button located on the Home tab in the Slides group. 

 

1. The new slide should appear below the selected slide. If you want to add a 

new slide between two, select the first of the two slides and click New Slide. 
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2. Notice the New Slide button contains a New Slide button arrow. Click on the 

arrow to view different slide layouts. Another way to change the slide layout 

is by clicking on the Layout button located in the Slides group. The slide 

layout option determines the position of the objects on a slide. Simply click 

on the layout you want to use and it will appear in the slide  
Special features of Presentation Programs 

1. Insert Slide Feature: Allows you to inset slide anywhere in the presentation, 

at the beginning, middle or end. 

2. Deletion of Inserted slides: Any slide of the presentation can be removed. 

3. Allows cut and paste slides in any order. 

4. Allows duplication content or slide 

5. Allows you to display the presentation designed in a slide show system. 

(View Slide Feature) 

6. Allows animations and/or sounds manipulations on objects in the slide. 

7. Simple Find and Replace, and text editor features. 

Full Featured Presentation software need more features than that above 

8. Good font specifications - Allows you to change and use different font faces, 

styles, and effects 

9. Additional features for slide: footnotes, cross references, advanced navigation 

system, headers, footers 

10. Good layout management system: Presets or Customized layout designing 

11. Macros - for add interactive features 

12. Spell checkers and dictionary support 

Transition 

Transitions are a type of animations in between slides. You can view the 

Transitions pane to view all possible transition effects you can use. These are ideal 

when you want to have a noticeable transition between two slides, as you'll find in 

some examples later in this tutorial. 
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The transition pane, with transition effects you can choose. 

Animation 

You can view your options in the Animations pane. These are often used as action 

effects while you're presenting your slide. For example, an animation can be used 

to highlight a particular element on your slide. 

 

The animation pane, with different animations you can choose once you select an 

element on your slide. 

Your animations are controlled by using the animation pane. If you'd like to learn a 

little bit more about the animation pane in PowerPoint. 

Discover how and when to add animation to PowerPoint. Without further ado, let's 

dive into these helpful PowerPoint animation tips and tricks.  

Custom Animation 

Custom animation in PowerPoint 2007 is used to animate pictures, graphics and 

charts. Many presenters like to add animation to make their presentations more 

dynamic. There are four types of animations that can be applied: an entrance effect, 

emphasis effect, an exit effect, and a motion path effect. Each of these effects have 

numerous animation styles available to choose from. 

Entrance Effect 

The entrance effect tells PowerPoint how the item will appear in the presentation. 

By default, all images, graphs and other graphic items simply appear in the slide. 

However, by applying an entrance effect, the user can control not only how the item 
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appears, but also when. This allows the presenter to display graphical items before, 

during or after discussing the slide. 

Emphasis Effect 

Sometimes presenters like to have an image change once it is in the slide. These 

changes can include having the object grow, shrink, fade, change colors, change 

fonts, become transparent or blink. This gives the benefit of emphasizing a point 

while speaking, and also adds some pizzazz to the presentation. For example, you 

can use the emphasis effect as you talk about each bar in a bar chart. 

Exit Effect 

The exit effect is essentially how an animation leaves the screen. Presenters often 

use exit effects in conjunction with entrance effects to have an item disappear in 

tandem as another object is appearing. Some exit effects can be subtle, like simply 

disappearing, while other effects can be more exciting, like spiraling out or 

bouncing off the screen. 

Motion Path Effect 

The motion path effect allows a presenter to create movement in a presentation. 

Motion paths are used to move images across the screen. Some examples include 

moving text boxes to the middle of the screen while speaking and then move them 

back to the original position, separating pieces of a pie chart, or even having a 

picture zoom across the screen. There are more than 65 different motion paths 

available to choose from or a presenter can create a custom motion path. 

How to Apply a Custom Animation 
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Custom Animation Task Pane 

1. On the "Animations" tab, click the "Custom Animation" button. 

2. Click the "Add Effect" button. 

3. To make the text or object enter the slide show presentation with an effect, 

select an "Entrance Effect." 

4. To add an effect to text or an object that is on the slide, select an "Emphasis 

Effect." 

5. To add an effect to text or an object that makes it leave the slide at some point, 

select an "Exit Effect." 

6. To add an effect that makes an object move in a specified pattern, select a 

"Motion Path Effect." 

7. To reorder the animations, click the "Reorder" buttons. 

8. To preview the animation, click the "Play" button. 

Work with tables: 

In PowerPoint, tables are useful for organizing and presenting data. To use tables 

in your slide show, you'll need to know how to insert them, apply table styles, 

and format them. 

To insert a blank table: 

1. On the Insert tab, click the Table command. 

2. Hover your mouse over the diagram squares to select the number 

of columns and rows in the table. 

3. Click your mouse. The table will appear on the slide. 

4. You can now place the insertion point anywhere in the table to add text. 

To make sure your table looks good with the slide layout, you can also insert a table 

using the placeholder. Click the Insert Table icon in the placeholder, then enter 

the desired number of rows and columns. 
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To move a table 

1. Place the cursor over the edge of the table. The cursor will turn into a cross 

with arrows . 

2. Click and drag the table to the desired location. 

3. Release the mouse button to drop the table in the new location. 

Graphics or Pictures and clip arts 

On each slide you create in your presentation, you have information you want to 

communicate with the audience. You can do this with text and illustrations, such as 

pictures and clip art. 

You will learn how to insert a picture and clip art, as well as how to modify both 

types of illustrations. 

 

Pictures and clip art can be inserted from the Ribbon, as well as by using the 

commands that appear in certain placeholders. In both methods, the image is 

centered in the middle of any selected slide placeholders. 

To insert a picture from the Ribbon: 

 Select the Insert tab. 

 Click the Insert Picture command in the Illustrations group. The Insert 

Picture dialog box will appear. 

 

 Locate and select the picture you want to use. 
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 Click Insert, and it will appear on the slide. 

To insert a picture from a placeholder command: 

 Click the Insert Picture command in the placeholder. The Insert Picture 

dialog box will appear. 

 

 Locate and select the picture you want to use. 

 Click Insert, and it will appear on the slide. 

Word Art 

 

There are many features and commands you can use in PowerPoint to create 

visually appealing slides. Two of these features are WordArt and shapes. 

WordArt allows you to create stylized text with textures, shadows, and outlines. 

It can be applied to text on any slide. Additionally, in PowerPoint you can insert 
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a variety of shapes such as lines, arrows, callouts, stars, and basic shapes, 

including rectangles and circles. 

Working with WordArt 

To apply a WordArt style: 

 Select the text you want to modify. The Format tab will appear. 

 Select the Format tab. 

 Move your cursor over a WordArt style in the WordArt Styles group to see a 

live preview of the style on the slide. 

 

 Click the More drop-down arrow to see all possible WordArt styles. 

 

 Click an option to select it. 

Charts: 

A chart is a tool you can use to communicate your data graphically. Displaying 

charts in PowerPoint allows your audience to see the meaning behind the 
numbers, and it makes showing comparisons and trends much easier. In this 

lesson, you will learn how to insert charts and modify them so they communicate 

information effectively. 
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In many ways, charts are an ideal way to present information in PowerPoint 2010. 

They give you an illustration of your data. A chart can help you show your 
audience what your data means and why it's important. Plus, they can add visual 
interest to slide shows that are otherwise filled with text. To use charts effectively, 

you'll need to know how to insert and modify them. 

Types of charts 

Click the arrows in the slideshow below to view examples of some of the types of 

charts available in PowerPoint. 

 

PowerPoint has a variety of chart types, each with its own advantages. Click the 

arrows to see some of the different types of charts available in PowerPoint. 
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Identifying the parts of a chart 

Click the buttons in the interactive below to learn about the different parts of a chart. 
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Inserting charts 

PowerPoint uses an Excel worksheet as a placeholder for entering chart data. 

Therefore, when you insert or edit a chart in PowerPoint, an Excel window will 

automatically open. 

To insert a chart: 

1. Select the Insert tab. 

2. Click the Insert Chart command in the Illustrations Group. The Insert 
Chart dialog box will appear. 

 

3. Select a category from the left pane of the dialog box, and review 

the charts that appear in the center. If you are unsure about which chart best 

fits your needs, review the interactive on the previous page. 

 

4. Select the desired chart. 

5. Click OK. An Excel window will open with a placeholder for your data. 
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If a slide layout has a content placeholder, you can also click the Insert 
Chart command to insert a new chart. 

 

To enter chart data 

The data that appears in the Excel spreadsheet is placeholder source data that you 

will replace with your own information. The Excel source data is used to create the 

PowerPoint chart. 

 

1. Enter your data into the Excel spreadsheet. 
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Data Integration 

The main reason you want integration between Power Point and Excel surely is the 

ability to update Tables or/and Charts you are using in a PPT presentation for which 

the data source is in an Excel workbook. You gain in efficiency because the data or 

chart you have on PPT presentation will refresh automatically every time you have 

new input in the data source in Excel. 

That’s a same as PPT/Excel has pretty good linking options. Below some of favorite 

ones. 

1. Paste special 

 Copy your selected range from excel (table i.e.) 

 Go to PPT and select Paste → Paste special 

 

 This allows you to copy an exact range to your PPT which will update when 

you update the excel values 
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 In order to allow the mirroring select “Paste link” 

  

 Test this by editing the excel spreadsheet values. 

 You can use the feature to create a support excel file which you edit and the 

beautiful report ppt you will craft will automatically update the figures to 

charts/highlights you want in the ppt 

 If you reopen the Powerpoint presentation, the application will show warning 

to update the links. If you press YES, it will fetch the most recent numbers 

(in case you have for example restarted the pc), if NO it keeps the most recent 

values. 

2. This is just one of the many ways to do this, as this allows you to select a 

specific range and you can double click the sheet in PPT to be taken to the 

Excel application. With the Embed function it creates a mini-excel inside the 

PPT. 

If your excel has a lot of VBA or otherwise heavy, you might consider creating a 

sheet that captures the selected ranges as snapshots first and then use the technique 
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described above to copy + paste special the photos to your PPT. 

SUMMARY 

 Word processor software is an application package that allows a user to 

create, edit, store and print out text based documents. 

 Microsoft Word is a widely used commercial word processor designed by 

Microsoft. 

 WordPerfect is a word processing application from Corel Corp... 

 Word processor interface consists of main editing window; it displays a 

document and several tools to manipulate it. 

 Title bar is located at the top of the screen. Word processor displays the name 

of the current document on it. 

 Backspace key erases the character the left to the cursor. 

 A paragraph is a unit of text or other content that starts at the beginning of a 

document, immediately after a hard return (a carriage return), a page break, 

or a section break, or at the beginning of a table cell, header, footer, or list of 

footnotes and ends with a hard return (carriage return) or at the end of a table 

cell. 

 Line spacing refers to the vertical distance between the lines within a 

paragraph and determines the location of each line relative to the line above 

it. 

 The spacing between your paragraphs is determined by the spacing before 

it and the spacing after it that are set for each paragraph. 

 If you want to add borders around the paragraph where your cursor is located, 

click the Borders button  to add the current default borders (the original 

default or the last border style that you selected). 

 Alignment or justification refers to the way in which the lines of a paragraph 

are aligned. 

 Formatting document is the technique which allows making our document 

more attractive and professional. 

 The word processor automatically moves to the next line when you have 
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filled oneline with text, and it will readjust text if you change the margins. 

 WordArt is a gallery of text styles that you can add to your 2007 Microsoft 

Office system documents to create decorative effects, such as shadowed or 

mirrored (reflected) text. 

 Spreadsheet software is a software application capable of organizing, storing 

and analyzing data in tabular form. 

 In Excel 2010, the Office button  has been replaced by a modification of the 

familiar File menu . 

 A worksheet is a collection of cells where you keep and manipulate the data. 

Each Excel workbook can contain multiple worksheets. 

 A label is text that identifies the purpose of a cell or text box or that displays 

descriptive text, such as titles, captions, or brief instructions. 

 Sorting data is an integral part of data analysis. You might want to arrange a 

list of names in alphabetical order, compile a list of product inventory levels 

from highest to lowest, or order rows by colors or icons. 

 Presentation software (sometimes called "presentation graphics") is a 

category of application program used to create sequences of words and 

pictures that tell a story or help support a speech or public presentation of 

information. 

 Power point is a part of Microsoft office Package which allows to create, edit 

and display presentation in an interesting and effective way. 

 Transitions are a type of animations in between slides. 

 A chart is a tool you can use to communicate your data graphically. 

Self Evaluation 

1. Write very short answer to the following questions. 

a. Write any two word processing softwares. 

b. Which company released Excel programs? 

c. Which symbol is used to begin formula in MS Excel? 

d. How many types of data sorting are used in Excel? 

e. What is the extension of Excel worksheet? 
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f. Write any two presentation software. 

g. Which function key is used to view presentation? 

2. Write short answer to the following questions. 

a. What is word processor? 

b. What is MS Word? Write its features. 

c. What is meant by formatting document? 

d. What is spreadsheet? Write two examples. 

e. What is MS Excel? Write its features. 

f. What is formula? Write true rule for using formula. 

g. What is meant by sorting data?  

h. What is chart? List the common chart types. 

i. List any four features of power point. 

j. What is meant by formatting the presentation? 

3. Write long answer to the following questions. 

a. What is word processor? Write the purpose and importance of word 

processing. 

b. Why is MS Excel popular and user friendly spreadsheets software? 

Give you views. 

c. What is presentation ? Why is presentation very important in education.  
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Unit: 6 

Computer Network and Topologies 
 

Learning Outcomes 

After completion of this unit you will be able to  

 explain/describe introduction of computer network and topologies. 

 explain/describe modes of transmissions. 

 explain/describe communication channels. 

 explain/describe modem. 

 explain/describe types of networks 

 explain/describe topologies 

 explain/describe different network component, and 

 explain/describe uses of communication in daily life 

6 .1. Introduction of computer network 

Data communication 

The process of transferring data or information between among computers called 

data communications. 

Telecommunication 

It refer to all types of data transmission like characters, numerical, photos, audios 

and videos etc using electronic or light emitting media. 

Computer Network 

A computer network is a logical or physical inter connection between two or more 

computers in such a way that people could communicate with each other. It is used 

to provide users with the access to share resources. These shared resources include 

data files, application software and hardware. 

Components of computer network 

 Computer 

 Transmission media 
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 Network software. 

 Protocols. 

 Networking cables.(Transmission media) 

Advantages of computer network 

 It ensures resources data software and hardware can be shared. 

 It provides faster & cheaper communication and data transmission. 

 It provides as the tools for e-mail, teleconferencing, videoconferencing for 

communication. 

 Flexible working condition. 

 Office automation can be made very effective well managed. 

Disadvantages of computer network 

 High installation and administrative cost. 

 Attack on the privacy of the people. 

 Computer virus spread most easily through network. 

 Technologically very complicated. 

 If the server is out of order, then all workstations are hang up. 

 Well trained technical support is required. 

6.2. Modes of transmissions: 

The manner in which data are transmitted from one location to another is called 

data transmission mode. There are two ways or modes for data transmitting from 

one location to another. These are: 

1. Simplex mode: Simplex is one-way data transmission that takes place only 

from sender to receiver. An example of this would be a television that allows 

the signal to pass in only one direction. Computer network connections do not 

use simplex. 

2. Duplex mode: Duplex is two-way data transmission that takes place both 

directions over a communication channel. Computer uses duplex channel. For 

example if computer A and computer B are connected together and then both 

computer can share data or information. From computer A to computer B or 

computer B to computer A. 
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Types of Duplex Mode 

 Half duplex: Half duplex is two way data transmission that takes place in 

only one direction at a time 

 Full duplex: Full duplex is two-way data transmission that takes place in both 

directions at a time. 

 
6.3. Communication channels 

The media that are used to transfer data between the computers in the networks are 

called transmission media or communication channels. There are two types of 

media used in the network. They are: 

1. Wired or cable media(guided media) 

2. Wireless media(unguided media) 

Wired or Cables (Guided Media) 

Cables are the most common transmission media. Two or more devices are 

connected directly using cables. Three types of cables in computer networking they 

are : 

 Twisted pair cable : Twisted copper cables are used only for lower 

bandwidth. It consists of two isolated strands of copper wire twisted around 

each other. There are two types of twisted pair cables they are as follows: 

 UTP (Unshielded Twisted Pair) : UTP cables does not have metal shield 

except plastic coating. It contains number of twisted pairs of wires with a 

simple plastic casing. It is commonly used for LAN and Telephony. It is 

cheaper and easier to work with, but do not offer high bandwidth and good 
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protection from interferences. It can support data transmission rates from 10 

to 100 mbps. 

 STP (Shielded Twisted Pair) : STP is similar to UTP but it is shielded with 

metal sheath along with plastic coating. It offers high bandwidth and good 

protection from interferences. It is cheaper than fiber optic cable. It can 

support data transmission rates from 10 to 500 mbps 

 
Twisted pair cable 

 Co- axial cable: A co-axial cable carries higher bandwidth than twisted pair, 

it is easy to connect. It does not bend readily. This cable consists of one or 

more small cables in a protective covering. It offer very high data transfer rate 

and can be placed underground and laid on the floors of lakes and oceans. 

 Fiber Optic cable: Fiber optic cable is a thin filament of glass fiver wrapped 

in a protective jacket. It consists of strands of glass like thread, each about the 

diameter of a human hair. It offers high-speed data transmission rate because 

data travel as high-speed pulses of light. 

Summary of Cable Types 

Cable 
Type 

Susceptibility to 
Interference 

Transmission 
Speed 

Maximum 
Distance 

Installation 
Difficulty 

Thin coax Low 10 Mbps 185 meters Low 

Thick coax Very low 10 Mbps 500 meters Difficult 

UTP High 10 to 100 Mbps 100 meters Easy 

STP Low 10 to 500 Mbps 90 meters Moderate 
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RS-232 N/A 20 Kbps 50 Feet N/A 

Infrared High 115 Kbps-4 Mbps 1 meter Easy 

Fiber-optic None 100 Mbps to 1Gbps 
and beyond 

Up to 30 miles Difficult 

 
Wireless (Unguided Media): It is used to transfer data with in a large geographical 

areas or globally without the use of interconnecting wires or cables. It uses other 

components such as radio signals, microwaves, or infrared to connect network. 

Types of wireless communication: 

1. Microwave Systems: Microwave signals are similar to radio and television 

signals and are used to transmit data through the space without the use of 

cable. It provides high-speed data transmission. These signals cannot bend or 

pass obstacles like hills and tall buildings, so very high towers are used to 

mount the signals. The transmission is limited about 30 miles. Chain of towers 

is required to transmit the microwave signals in a long distance 

2. Satellite communication: Both microwaves signals and telephone signals 

can be relayed to a earth station for transmission to a communication satellite. 

The earth station consists of a satellite dish that functions as an antenna a 

communication equipment to transmit and receive data from satellite passing 

overhead. It is not disturbed by hills and tall buildings and visible from any 

point. So sender and receiver easily communicate with each other using 

antenna by aiming the satellite. It is very expensive for placing satellite along 

the earth orbit. 

Serial and Parallel Communication 

Data can be transmitted between a sender and a receiver in two main ways: serial 

and parallel. 

Serial communication is the method of transferring one bit at a time through a 

medium. 

Parallel communication is the method of transferring blocks, eg: BYTEs, of data at 

the same time. 
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Comparison Chart 

BASIS FOR 
COMPARISON

SERIAL 
TRANSMISSION 

PARALLEL TRANSMISSION 

Meaning Data flows in bi-
direction, bit by bit 

Multiple lines are used to send 
data i.e. 8 bits or 1 byte at a time 

Cost Economical Expensive 
Bits transferred 
at 1 clock pulse 

1 bit 8 bits or 1 byte 

Speed Slow Fast 
Applications Used for long distance 

communication. Eg, 
Computer to computer 

Short distance. Eg, computer to 
printer 

 

6.4. Modem 

 
The word "modem" is a contraction of the words modulator-demodulator. A 

modem is typically used to send digital data over a phone line. 

The sending modem modulates the data into a signal that is compatible with the 

phone line, and the receiving modem demodulates the signal back into digital 

data. Wireless modems convert digital data into radio signals and back. 

6.5. Types of network 

On the basis of size, physical and geographical division, computer network can be 

categorized into three types. They are : 
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Local Area Network 

The way of connecting two or more computers in a very limited area (about 100 to 

300 meters) or within a same building or a group of adjacent building is called LAN. 

It enables very high speed communication through wire connection or wireless 

connection some times. Small organizations prefer it because of less expensive and 

faster communication. 

 

Metropolitan Area Network 

The way of connecting computers inside a metropolitan area is called MAN. The 

area may be a part of city, whole part of city, district, zone or country. Radio wave 

is used to transmit the data for communication between the workstation and server 

in the system. Many different systems of networking and computing are brought 

together to form a MAN. 

 

Wide Area Network 

The connection of computers of networks covering more distance or the world by 

the help of wave, frequency and satellite is called WAN. Different types of LAN 
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and MAN are connected to form a WAN. It covers more area but it is slower than 

LAN and MAN. Examples - satellite communication, internet etc. 

 

Internet 

The internet is worldwide collection of computer networks and gateways that use 

TCP/IP suite of protocols to communicate with one another using telephone lines 

modems or satellites. Internet is network of networks. At the heart of the internet is 

a backbone of high speed data communication lines between major nodes or host 

computers, consisting of thousands of commercial governmental, educational and 

other computer system, that route data and messages. 

6.6. Topologies 

Network topology is the interconnected pattern of network elements. A network 

topology may be physical, mapping hardware configuration, or logical, mapping 

the path that the data must take in order to travel around the network. 

Types of Network Topology 

Network Topology is the schematic description of a network arrangement, 

connecting various nodes (sender and receiver) through lines of connection. 

BUS Topology 

Bus topology is a network type in which every computer and network device is 

connected to single cable. When it has exactly two endpoints, then it is 

called Linear Bus topology. 
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Advantages of Bus Topology 

1. It is cost effective. 

2. Cable required is least compared to other network topology. 

3. Used in small networks. 

4. It is easy to understand. 

5. Easy to expand joining two cables together. 

Disadvantages of Bus Topology 

1. When cables fail whole network fails. 

2. If network traffic is heavy or nodes are more, the performance of the network 

decreases. 

3. Cable has a limited length. 

4. It is slower than the ring topology. 

RING Topology 

It is called ring topology because it forms a ring as each computer is connected to 

another computer, with the last one connected to the first. Exactly two neighbors 

for each device. 

 
Advantages of Ring Topology 
1. Transmitting network is not affected by high traffic or by adding more nodes, 

as only the nodes having tokens can transmit data. 

2. Cheap to install and expand 
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Disadvantages of Ring Topology 

1. Troubleshooting is difficult in ring topology. 

2. Adding or deleting the computers disturbs the network activity. 

3. Failure of one computer disturbs the whole network. 

STAR Topology 

In this type of topology all the computers are connected to a single hub through a 

cable. This hub is the central node and all others nodes are connected to the central 

node. 

 

Advantages of Star Topology 

1. Fast performance with few nodes and low network traffic. 

2. Hub can be upgraded easily. 

3. Easy to troubleshoot. 

4. Easy to setup and modify. 

5. Only that node is affected which has failed, rest of the nodes can work 

smoothly. 

Disadvantages of Star Topology 

1. Cost of installation is high. 

2. Expensive to use. 

3. If the hub fails the whole network stops because all the nodes depend on the 

hub. 

4. Performance is based on the hub that is it depends on its capacity 
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MESH Topology 

It is a point-to-point connection to other nodes or devices. All the network nodes 

are connected to each other. Mesh has n(n-1)/2 physical channels to link n devices. 

 

Advantages of Mesh Topology 

1. Each connection can carry its own data load. 

2. It is robust. 

3. Fault is diagnosed easily. 

4. Provides security and privacy. 

Disadvantages of Mesh Topology 

1. Installation and configuration is difficult. 

2. Cabling cost is more. 

3. Bulk wiring is required. 

TREE Topology 

It has a root node and all other nodes are connected to it forming a hierarchy. It is 

also called hierarchical topology. It should at least have three levels to the hierarchy. 

 

Advantages of Tree Topology 

1. Extension of bus and star topologies. 

2. Expansion of nodes is possible and easy. 
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3. Easily managed and maintained. 

4. Error detection is easily done. 

Disadvantages of Tree Topology 

1. Heavily cabled. 

2. Costly. 

3. If more nodes are added, maintenance is difficult. 

4. If central hub fails, network fails. 

4.7. Different network component: 

1. MODEM: Modem is a device that directly converts digital signal from a 

computer or other digital devices into analog form for transmission over 

analog link i.e telephone line and vice versa. MODEM stands for Modulation 

and Demodulation. There are two types of modem used in computer they are 

as follows: 

a. Internal modem b. External modem. 

2. NIC: It is a Network Interface Card, which connects each computer to the 

wiring to the network. A NIC is a circuit board that fits in one of the 

computer’s expansion slots. It provides a port on the back of the computer to 

connect in the network. 

3. Hub: Hubs are connectivity devices, which contain multiple ports for 

connecting to network components. Hubs connect the computers in a star 

topology. It lies between server and clients computers. 

4. Connector: Bridge and Gateway are the two different connectors, which play 

role to link between two network systems. 

a. Bridge: Bridge connects networks using same communications 

protocols or similar networks so that information can be passed from 

one to the other. 

b. Gateway: Gateway connects networks using different communications 

protocols or dissimilar networks so that information can be passed from 

one to the other. 

5. Switch: A device that is capable of forwarding packets directly to the ports 
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associated with particular network addresses. Hubs and switches are almost 

same but switch is new technology and intelligent compare to hub. 

6. Repeater: A device used on communications circuits that decrees distortion 

by amplifying or regenerating a signals so that it can be transmitted onward 

in its original strength and form as they pass through a network cable. 

7. Protocols: Protocols are the set of rules and formats for sending and receiving 

data. It works as guidelines to govern the exchange between 

equipments. There are different types of protocols that we can use. Some of 

popular protocols are TCP/IP, HTTP, FTP, IPX/SPX. 

8. Router: A router is a device that is used to connect different LAN in the 

network. It receives transmitted messages and forwards them their correct 

destinations over most efficient available route. 

NOS: The operating, which can support network environment, is called Network 

Operating System. For example Windows XP, 2000, server, unix, linux, Novel 

Netware etc. 

Network architectures or (Types of Network Architecture) or LAN Architecture: 

 Client server: This is old model of computer network. In this kind of network 

model one main computer equipped with very powerful processor, large 

memory and network operating system works as a main computer or service 

provider. Other computers connected with server, which are also called 

workstation or node or terminals can use the hardware and software resources 

of server computer. There are different types of server such as file server, 

print server, network server or email server. 

Advantages of client server network: 

 It works with any size or physical layout of LAN. 

 It does not tend to slow down with heavy use. 

 The network can be expanded to any size as we wish. 

 It provides very high level security 

 It reduces software installation time and cost to all computers. 

Disadvantages of client server network: 
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 It is very difficult to setup and well trained technicians are required to handle 

and setup. 

 It is expensive compared to peer to peer network. 

 All software and operating systems are installed in server computer so that 

other client computer has to depend on it. 







 

 Peer to peer: It is also called workgroups also. Because all computers in the 

network have equal responsibilities. All computers in the network have access 

to at least one or more computers. It mostly used in LAN and every 

organizations, research centers such as banks, travel agencies, airlines 

educational institutions etc. 

Advantages of peer to peer network 

 It is easy to setup. 

 Users in each computer can determine the resources to be shared among other 

computers. 

 Any required software can be installed on individual computers , they don’t 

have to depend on the server. 

 It is suitable at home, office, banks and small organization. 

 It is cheaper compared to client server network. 
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Disadvantages of peer to peer network: 

 It is slow because of heavy load. 

 It is suitable for limited area such as school offices and small organization. 

 The network expansion is limited and can not be expanded as the wish. 

 It has limited security level. 

 

Note: Band width : The amount of data which is sent through a data-transmitting 

medium, such as a computer network, telephone line, or coaxial cable, in a given 

amount of time is called band width. 

Note: Bits : In computer processing and storage, a bit is the smallest unit of 

information handled by a computer and is represented physically by an element 

such as a single pulse sent through a circuit or a small spot on a magnetic disk 

capable of storing either a 1 or a 0. 

Modulation: The process of changing some characteristics (amplitude, frequency 

or phase) of carrier wave in accordance with the intensity of the signal is known 

as modulation. 

Types of modulation: 

1. Amplitude Modulation (AM) 

2. Frequency Modulation (FM) 

3. Phase Modulation (PM) 

6.9. Use of Communication in daily life: 

1. It is an exchange of ideas. 
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Communication is the process through which an exchange of information takes 

place. It is the sharing of information, ideas, concepts and messages. 

2. Two parties are involved in it. 

In communication, the exchange of information takes place between two or more 

persons. This implies that there are minimum two people involved in the 

communication process at any given time. 

The one who initiates the exchange is the sender of the message (speaker/writer) 

and the one who receives and interprets it is the receiver of the message 

(listener/reader). 

3. It is a two-way process. 

Communication is a two-way process of exchanging ideas or information. One 

person alone cannot carry out communication. When you communicate, there has 

to be a receiver or an audience that would reciprocate. Then only your 

communication can be complete. 

Thus, communication is a process of transmitting and receiving verbal and non-

verbal messages. It is considered effective only when it achieves the desired 

reaction or response from the receiver. The response may be positive or negative. 

In case of absence of any response, communication is incomplete. 

Thus, communication is effective only when a concise and clear message is 

delivered well, received successfully, understood fully, and responded to promptly. 

SUMMARY 

 The process of transferring data or information between computers is called 

data communications. 

 A computer network is a logical or physical interconnection between two or 

more computers such that they could communicate with each other. It is used 

to provide users with the access to share resources. These shared resources 

include data files, application software and hardware. 

 The manner in which data are transmitted from one location to another is 

called data transmission mode. 
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 Simplex is one-way data transmission that takes place only from sender to 

receiver. 
 Duplex is two-way data transmission that takes place both directions over a 

communication channel. 

 The media that are used to transfer data between the computers in the 
networks are called transmission media or communication channels. 

 Twisted copper cables are used only for lower bandwidth. It consists of two 

isolated strands of copper wire twisted around each other. 
 A co-axial carries higher bandwidth than twisted pair, it is easy to connect. 
 Fiber optic cable is a thin filament of glass fiver wrapped in a protective 

jacket. 
 Wireless media is used to transfer data within a large geographical areas or 

globally without the use of interconnecting wires or cables. 
 Both microwaves signals and telephone signals can be relayed to a earth 

station for transmission to a communication satellite. 
 Serial communication is the method of transferring one bit at a time through 

a medium. 

 Parallel communication is the method of transferring blocks, eg: BYTEs, of 

data at the same time. 

 The sending modem modulates the data into a signal that is compatible with 

the phone line, and the receiving modem demodulates the signal back into 

digital data. 
 The way of connecting two or more computers in a very limited area (about 

100 to 300 meters) or within a same building or a group of adjacent building 

is called LAN. 
 The way of connecting computers inside a metropolitan area is called MAN. 

The area may be a part of city, whole part of city, district, zone or country. 
 The connection of computers of networks covering more distance or the 

world by the help of wave, frequency and satellite is called WAN. 
 The internet is worldwide collection of computer networks and gateways that 

use TCP/IP suite of protocols to communicate with one another using 
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telephone lines modems or satellites. 
 Network topology is the interconnected pattern of network elements. 
 Bus topology is a network type in which every computer and network device 

is connected to single cable. 
 Ring topology forms a ring as each computer is connected to another 

computer, with the last one connected to the first. 
 In star topology, all the computers are connected to a single hub through a 

cable. This hub is the central node and all others nodes are connected to the 

central node. 

 Mesh Topology is a point-to-point connection to other nodes or devices. 
 Tree Topology is  a root node and all other nodes are connected to it forming 

a hierarchy. It is also called hierarchical topology. 
 Network Interface Card, which connects each computer to the wiring to the 

network. 
 Hubs are connectivity devices which contain multiple ports for connecting to 

network components. 
 Bridge connects networks using same communications protocols or similar 

networks so that information can be passed from one to the other. 
 Gateway connects networks using different communications protocols or 

dissimilar networks so that information can be passed from one to the other. 
 Switch is a device that is capable of forwarding packets directly to the ports 

associated with particular network addresses. 
 Repeater is device used on communications circuits that decrees distortion by 

amplifying or regenerating a signals so that it can be transmitted onward in 

its original strength and form as they pass through a network cable. 
 Protocols are the set of rules and formats for sending and receiving data. 
 A router is a device that is used to connect different LAN in the network. 
 The operating, which can support network environment, is called Network 

Operating System. For example Windows XP, 2000, server, unix, linux, 

Novel Netware etc. 
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Self Evaluation 

1. Write very short answer to the following questions 

a. What is data communication? 

b. Define computer network. 

c. Write the example of LAN. 

d. Give example of WAN. 

e. What is communication? 

f. Which is the fastest media in which data are transmitted according to 

the speed of light? 

g. Which network topology places hub at the center? 

h. Which device contains multiple ports? 

2. Write short answer to the following questions. 

a. What are the advantages of computer network? 

b. What is meant by network topology? 

c. List types of topology and briefly explain. 

d. Draw and explain about star topology. 

e. Differentiate between star and ring topology. 

f. List components of data communication. 

g. What is data transmission mode? List different types of data 

transmission modes. 

h. Differentiate between simplex and duplex mode of communication. 

i. What are the differences between wired or wireless media with 

example. 

j. What is Local Area Network? Write its features. 

k. What is Metropolitan Area Network? Write its importance. 

l. What is WAN? Write its properties. 

m. What is modem with working? 

n. Explain the use of communication in our daily life. 
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3. Write long answer to the following questions. 

a. What is computer network? Explain the types of computer networks. 

b. Explain different services provided by computer network. 

c. What is network architecture or model? List its types. 

d. Explain different types of topologies with their merits and demerits. 

e. Differentiate between LAN and WAN. 

References: 

https://www.tutorialspoint.com 

https://www.computerhope.com 

https://www.kullabs. 

https://www.tutorialspoint.com 
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Unit: 7 

Internet and Electronic mail (Email) 
Learning Outcomes 

After completion of this unit you will be able to  

 explain/describe internet and its uses. 

 explain/describe different protocol, and 

 explain/describe web, web server, browser, DNS, URL. 

7 .1. Introduction of Internet 

The internet is worldwide collection of computer networks and gateways that use 

TCP/IP suite of protocols to communicate with one another using telephone lines 

modems or satellites. Internet is network of networks. At the heart of the internet is 

a backbone of high speed data communication lines between major nodes or host 

computers, consisting of thousands of commercial governmental, educational and 

other computer system, that route data and messages. 

Equipment used in internet/ components required to use internet 

 A set of computer 

 A modem and regular telephone line or broadband internet connection. 

 An account in ISP to access the internet host. 

 Communication software for example: Internet Explorer, Netscape 

Navigator, Mozilla Firefox, Opera, Google Chrome etc. 

7.2. Use of Internet: 

Some of the common services provided by the internet are 
 Electronic mail (E-Mail) 

 Information sharing and resources. 

 Business communication 

 Advertising 

 Online shopping 

 Stock trading 

 Discussion and chat 
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 Entertainment 

 E-banking 

 Virtual library 

E-Mail: E-mail stands for electronic mail. It is most widely used feature on the 

internet. Sending and receiving messages electronically through the internet is 

called E-mail. We can exchange any message with the people around the world by 

using e-mail. It is very easy and quick means of communication available in the 

computer world. We can write an e-mail message in an mail program like Eudora, 

Outlook Express, Netscape Navigator etc. and several web base program like 

Yahoomail, Hotmail, Gmail and Zapakmail are also used to send and receive e-

mail. 

E-mail address: Each E-mail address is identified by a unique name is called E-

mail address. For example sarthak@yahoo.com, swrikrit@fewanet.com.np, etc. It 

has five parts they are as follows : 

 sarthak/swrikrit : User’s name 

 @ (At the rate) : A separator symbol 

 yahoo, fewanet : ISP address or domain name 

 .com or .edu or .net : commercial or educational groups 

 .np : Country code 

Advantages of using E-mail 

 It is cheapest and fastest means of communication compared to our 

conventional postal mail. 

 It is more reliable than postal mail. 

 E-mail can be accessed from any part of the world and at any time. 

 Information can be shared globally. 

 We can send photos, songs, video clips and other file with e-mail attachments. 

 A single mail can be sent to multiple people at a time. 
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E-fax: E-fax stands for electronic fax. It is very powerful desktop application that 

allows us to send and receive faxes directly on our computer. It is very similar to e-

mail. The E-fax first goes to the internet server then the internet server sends it to 

its destination whereas E-mail means first goes to the local file server. 

Different between E-mail and E-fax: 

E-mail E-fax
1. It is very cheap. 1. It takes more cost than E-mail. 
2. Message first goes to the local 

server. 
2. Message first goes to the internet 

server and then to its destination. 
3. Message is to be stored in the hard 

disk of the destination computer 
(server). 

3. Message directly goes to print in 
the printer of the destination 
computer. 

 

7.3. Protocol 

In information technology, a protocol is the special set of rules that end points in a 

telecommunication connection use when they communicate. Protocols specify 

interactions between the communicating entities. 

Bottom of Form 

Protocols exist at several levels in a telecommunication connection. For example, 

there are protocols for the data interchange at the hardware device level and 

protocols for data interchange at the application program level. In the standard 

model known as Open Systems Interconnection (OSI), there are one or more 

protocols at each layer in the telecommunication exchange that both ends of the 

exchange must recognize and observe. Protocols are often described in an industry 

or international standard. 

TCP/IP 

TCP (Transmission Control Protocol) is a standard that defines how to establish and 

maintain a network conversation via which application programs can exchange 

data. TCP works with the Internet Protocol (IP), which defines how computers 

send packets of data to each other. Together, TCP and IP are the basic rules defining 

the Internet. TCP is defined by the Internet Engineering Task Force (IETF) in the 

Request for Comment (RFC) standards document number 793. 
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HTTP (Hypertext Transfer Protocol): 

HTTP (Hypertext Transfer Protocol) is the set of rules for transferring files (text, 

graphic images, sound, video, and other multimedia files) on the World Wide Web. 

As soon as a Web user opens their Web browser, the user is indirectly making use 

of HTTP. HTTP is an application protocol that runs on top of the TCP/IP suite of 

protocols (the foundation protocols for the Internet). 

File Transfer Protocol (FTP): 

File Transfer Protocol (FTP) is a standard Internet protocol for transmitting files 

between computers on the Internet over TCP/IP connections. 

Terminal Network (Telnet): 

Telnet is a protocol used on the Internet or local area network to provide a 

bidirectional interactive text-oriented communication facility using a 

virtual terminal connection. User data is interspersed in-band with Telnet control 

information in an 8-bit byte oriented data connection over the Transmission 

Control Protocol (TCP) 

SMTP (Simple Mail Transfer Protocol): 

SMTP (Simple Mail Transfer Protocol) is a TCP/IP protocol used in sending and 

receiving e-mail. However, since it is limited in its ability to queue messages at the 

receiving end, it is usually used with one of two other protocols, POP3 or IMAP, 

that let the user save messages in a server mailbox and download them periodically 

from the server. 

POP(Post Office Protocol): 

POP is short for Post Office Protocol, a protocol used to retrieve e-mail from a 

mail server. Most e-mail applications (sometimes called an e-mail client) use the 

POP protocol, although some can use the newer IMAP (Internet Message Access 

Protocol). 

7.4. The Web 

The World Wide Web (WWW), also called the Web, is an information space 

where documents and other web resources are identified by Uniform Resource 
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Locators (URLs), interlinked by hypertext links, and accessible via the Internet. 

English scientist Tim Berners-Lee invented the World Wide Web in 1989. He wrote 

the first web browser in 1990 while employed at CERN in Switzerland. 

Advantages of www: 

 A link in a web document can be used to open other documents. 

 Web pages can contain pictures, buttons and even links to sound files in 

addition to text, thus allowing multimedia applications. 

 Sophisticated web document allows users to interact with applications 

through dialog boxes and forms. 

Web server 

Web server is a site on which the web pages are kept. It is a server computer that 

responds to requests from web browsers to relative resources. 

Browser 

Browser is client software that allows the users to display and interact with the web 

page. For example: Internet Explorer, Netscape Navigator, Mozilla Firefox or 

Opera etc. 

Web pages 

Webpage is a collection of information that is stored in website. The www consists 

of huge collection of documents with related website called webpage. Webpage 

provides vast collection of information of related websites. 

Web site 

Website is a location of the web pages created by any organizations, universities 

and government agencies to provide information regarding them like: 

http://www.bbc.co.uk/nepali,http://www.nepalnews.com etc. Each website has its 

own address that is also called internet address. 

The domain name system (DNS) 

The domain name system (DNS) is the way that internet domain names are located 

and translated into internet protocol (IP) addresses. The domain name system maps 
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the name people use to locate a website to the IP address that a computer uses to 

locate a website. For example, if someone types TechTarget.com into a web 

browser, a server behind the scenes will map that name to the IP address 

206.19.49.149. It is a name of specific internet area controlled by any organization, 

company or government. 

Home page 

The home page is the first hypertext document regarding the web address displayed 

when a user connects to any web server. 

Uniform resource locator (URL) 

A uniform resource locator (URL) is the address of a resource on the Internet. A 

URL indicates the location of a resource as well as the protocol used to access it. 

A URL contains the following information: 

 The protocol used to access the resource 

 The location of the server (whether by IP address or domain name) 

 The port number on the server (optional) 

 The location of the resource in the directory structure of the server 

 A fragment identifier (optional) 

Also known as a Universal Resource Locator (URL) or Web address. A URL is a 

type of uniform resource identifier (URI). In common practice, the term URI isn't 

used, or is used synonymously with URL, even though this is technically incorrect. 

ISP( Internet Service Provider): 

A company that provides individuals or companies access to the internet and the 

world wide web is called ISP. 

Firewall:  

Software or hardware that limits the certain kinds of access to a computer from the 

internal network or external network. 

7.5. Search Engine: 

Search engines are programs that search documents for specified keywords and 
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returns a list of the documents where the keywords were found. A search engine is 

really a general class of programs; however, the term is often used to specifically 

describe systems like Google, Bing and Yahoo! Search that enable users to search 

for documents on the World Wide Web. 

 

Web Search Engines 

Typically, Web search engines work by sending out a spider to fetch as many 

documents as possible. Another program, called an indexer, then reads these 

documents and creates an index based on the words contained in each document. 

Each search engine uses a proprietary algorithm to create its indices such that, 

ideally, only meaningful results are returned for each query. 

SUMMARY 

 The internet is worldwide collection of computer networks and gateways that 

use TCP/IP suite of protocols to communicate with one another using 

telephone lines modems or satellites. Internet is network of networks. 
 E-mail stands for electronic mail. It is most widely used feature on the 

internet. Sending and receiving messages electronically through the internet 

is called E-mail. 
 A protocol is the special set of rules that end points in a telecommunication 

connection use when they communicate. 
 TCP (Transmission Control Protocol) is a standard that defines how to 

establish and maintain a network conversation via which application 

programs can exchange data. 
 HTTP (Hypertext Transfer Protocol) is the set of rules for transferring files 

(text, graphic images, sound, video, and other multimedia files) on the World 

Wide Web. 
 File Transfer Protocol (FTP) is a standard Internet protocol for transmitting 
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files between computers on the Internet over TCP/IP connections. 

 Telnet is a protocol used on the Internet or local area network to provide a 

bidirectional interactive text-oriented communication facility using a 

virtual terminal connection. 
 SMTP (Simple Mail Transfer Protocol) is a TCP/IP protocol used in sending 

and receiving e-mail. 
 POP is short for Post Office Protocol, a protocol used to retrieve e-mail from 

a mail server. 
 The World Wide Web (WWW), also called the Web, is an information 

space where documents and other web resources are identified by Uniform 

Resource Locators (URLs), interlinked by hypertext links, and accessible via 

the Internet. 
 Web server is a site on which the web pages are kept. It is a server computer 

that responds to requests from web browsers to relative resources. 

 Browser is client software that allows the users to display and interact with 

the web page. For example: Internet Explorer, Netscape Navigator, Mozilla 

Firefox or Opera etc. 

 Webpage is a collection of information that is stored in website. 
 Website is a location of the web pages created by any organizations, 

universities and government agencies to provide information 
 The Domain Name System (DNS) is the way that internet domain names are 

located and translated into internet protocol (IP) addresses. 
 The home page is the first hypertext document regarding the web address 

displayed when a user connects to any web server. 
 A uniform resource locator (URL) is the address of a resource on the Internet. 
 A company that provides individuals or companies access to the internet and 

the world wide web is called ISP. 
 Search engines are programs that search documents for specified keywords 

and returns a list of the documents where the keywords were found. 
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Self Evaluation 

1. Write very short answer to the following question. 

a. What do you mean by Home Page? 

b. Define term web page and web site. 

c. What is web browser? 

d. Give two examples of web browser. 

e. Give two examples of search engine. 

f. What is called network of network? 

g. Define the term internet. 

h. What is meant by E-mail? 

i. What does URL mean? 

j. What is DNS? 

2. Write short answer to the following questions. 

a. Explain the use of internet. 

b. List the advantages of Internet. 

c. What are the requirements to connect the internet? 

d. Mention the advantages of E-mail. 

e. What is web browser? Name common web browser software. 

f. Define URL with its parts. 

g. What is search engine? List any four search engine names. 

h. What is ISP? Write two popular ISPs of our country. 

i. List services of internet. 

3. Write long answer to the following questions. 

a. What are the services provided by the internet? Explain briefly. 

b. What is protocol? Explain different protocols. 

c. Differentiate between e-mail and e-fax. 
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